REN ESAS Application Note

RZ/T2, RZ/N2
Getting Started with Flexible Software Package

Introduction

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing applications for the RZ/T2,
RZ/N2 microprocessor series.

Target Device

RZ/T series: RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H
RZ/N series: RZ/N2L, RZ/N2H

About the video contents

We provide videos about the development tools using the RZ/T and RZ/N FSP. Access the following links:
. How to install the development tools
e RZ/T RZ/N ESP Quick Start Guide - FSP Installation and Generating Your First Project for e2 studio
(English, Japanese, Chinese)

. RZ/T RZ/N FSP Quick Start Guide - FSP Installation & Generating Your First Project for EWARM & FSP
SC

(English, Japanese, Chinese)

. Instructions and usage of each tab in FSP Configuration
* RZ/T RZ/N FSP Tutorial - Pin Configuration Function
(English, Japanese, Chinese)
. RZ/T RZ/N FSP Tutorial for FSP Configuration (1/2) - Introduction of Tabs
(English, Japanese, Chinese)
e RZ/T RZ/N FSP Tutorial for FSP Configuration (2/2) - How to Use
(English, Japanese, Chinese)
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https://www.youtube.com/watch?v=er3haXLtHlk
https://www.youtube.com/watch?v=er3haXLtHlk
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https://www.youtube.com/watch?v=0DytdaCR_Q8
https://www.youtube.com/watch?v=0DytdaCR_Q8
https://www.youtube.com/watch?v=0DytdaCR_Q8
https://www.youtube.com/watch?v=LLqQt2WFSUo&pp=ygULcmVuZXNhcyByenQ%3D
https://www.bilibili.com/video/BV1gW4y197vQ/
https://www.youtube.com/watch?v=8yLx_rrUV5o
https://www.youtube.com/watch?v=8yLx_rrUV5o
https://www.youtube.com/watch?v=TeHLxEwjpWs
https://www.bilibili.com/video/BV1ru4y1K7gG/
https://www.youtube.com/watch?v=0m8LBdYTeb8
https://www.youtube.com/watch?v=0m8LBdYTeb8
https://www.youtube.com/watch?v=EbPR_BJ2y4s
https://www.bilibili.com/video/BV13z421h7Ea/
https://www.youtube.com/watch?v=fWsQS6IQmFA
https://www.youtube.com/watch?v=fWsQS6IQmFA
https://www.youtube.com/watch?v=fWsQS6IQmFA
https://www.youtube.com/watch?v=efTPGQajj7k
https://www.bilibili.com/video/BV19msLepELX/
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1. Introduction

1.1 Overview

This application note describes how to use the Renesas Flexible Software Package (FSP) running on the Cortex®-R52
and Cortex®-AS55 (hereinafter referred to as CR52 and CASS5) incorporated on RZ/T2 and RZ/N2.

1.2 Introduction to FSP
1.2.1 Purpose

The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide easy to use,
scalable, high quality software for embedded system design. The primary goal is to provide lightweight, efficient the
hardware abstraction layer (HAL) drivers and the board support package (BSP) that meet common use cases in
embedded systems.

1.2.2 e? studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RZ/T2, RZ/N2 series of
MPU devices. The €? studio IDE provides a familiar development cockpit from which the key steps of project creation,
module selection and configuration, code development, code generation, and debugging are all managed.

1.2.3 FSP Smart Configurator

The Renesas FSP Smart Configurator (FSP SC) is a desktop application designed to configure device hardware such as
clock set up and pin assignment as well as initialization of FSP software components when using a 3™-party IDE and
toolchain.

For creating RZ/T2, RZ/N2 project, the FSP SC can currently be used with

e  JAR Systems Embedded Workbench for Arm (IAR EWARM) with IAR toolchain for Arm

1.2.4 FSP Documentation

The related file “FSP Documentation” contains HTML documentations describing the features, APIs and usage notes
regarding the BSP and HAL drivers implemented as FSP modules and interfaces. After clicking the “index.html” in
“FSP Documentation” to open the introduction page on your html browser, the reference documents for utilizing each
FSP module and interface can be read from “API Reference” menu.

RO1AN6434EJ0113 Rev.1.13 Page 5 of 160
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1.3 Related Documentation Files

The related documentation files are shown in the following.

1.3.1 Evaluation Board User’s Manual
This Getting Started Guide refers to the following “Evaluation Board User’s Manual”.

e RZ/T series
»  RZ/T2M Group Renesas Starter Kit+ for RZ/T2M User’s Manual (RZ/T2M and RZ/T2ME)
—  Document No. R20UT4939
»  RZ/T2L Group Renesas Starter Kit+ for RZ/T2L User’s Manual
= Document No. R20UT5164
»  RZ/T2H Group RZ/T2H Evaluation Board User’s Manual
= Document No. R20UT5405
e  RZ/N series
»  RZ/N2L Group Renesas Starter Kit+ for RZ/N2L User’s Manual
—  Document No. R20UT4984
»  RZ/N2H Group RZ/N2H Evaluation Board User’s Manual
—  Document No. R20UT5522

These documents can be found on Renesas web site by inputting their Document No. into a search box.

e  URL: https://www.renesas.com/

Renesas xee

Figure 1: Search Box in Renesas Web Page

1.3.2 FSP Documentation

This Getting Started Guide refers to the following “FSP Documentation”. It contains notes on the use of the software
modules packaged with FSP.

These documents are available in Renesas Git repository in GitHub.

e RZ/T series
» RZ/T2 Flexible Software Package Documentation
. URL: https://github.com/renesas/rzt-fsp/releases
¢  File name: fsp_documentation vx.X.x.zip
e  RZ/N series
»  RZ/N2 Flexible Software Package Documentation
e URL: https://github.com/renesas/rzn-fsp/releases

* File name: fsp_documentation vx.x.x.zip

Note:
The “vx.x.x” is the FSP version number such as “v1.0.0”.
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1.4 Starting Development Introduction

FSP application project can be created by e? studio or FSP SC (for IAR EWARM), and this Getting Started includes
tutorial for both tools; the chapters you should read changes.

¢* studio users should read the following chapters:

e Chapter 2 ”Set up Evaluation Board”

Chapter 3 “e* studio Setup”

Chapter 4 “Tutorial: Your First RZ/T2, RZ/N2 MPU Project — Blinky”
Chapter 6 “FSP Configuration Users Guide”

FSP SC users (for IAR EWARM users) should read the following chapters:
e  Chapter 2 ’Set up Evaluation Board”

e  Chapter 5 “FSP Smart Configurator User Guide”

e  Chapter 6 “FSP Configuration Users Guide”

The summary of each chapter is shown below.
e  Chapter 2 ’Set up Evaluation Board”
»  Explains how to setup Evaluation Board to proceed the tutorials in Chapter 4 and 5.
e  Chapter 3 “e” studio Setup”
>  Explains the setup of €? studio for utilizing FSP.
e Chapter 4 “Tutorial: Your First RZ/T2, RZ/N2 MPU Project — Blinky”
>  Explains the tutorial with minimal steps to create, run, and debug a FSP project by using e studio.
e  Chapter 5 “FSP Smart Configurator User Guide”

»  Explains the tutorial with minimal steps to create an FSP project as IAR EWARM project by using the FSP
Smart Configurator and to run and debug the created IAR EWARM project.

e  Chapter 6 “FSP Configuration Users Guide”
»  Explains how to create and configure an FSP project in detail.

»  The explanation is described based on e? studio, but most of the explanations are applied to the FSP smart
configurator.
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Dec.23.24 RENESAS



RZ/T2, RZIN2 Getting Started with Flexible Software Package

2. Set up Evaluation Board

2.1 Obtaining an Evaluation Board

To develop applications with RZ/T2 FSP and RZ/N2 FSP, start with Evaluation Board and Renesas Starter Kit+
(RSK+).

The Evaluation Board and Renesas Starter Kit+ for RZ/T2 and RZ/N2 CPU Board are designed to seamlessly integrate
with the €? studio.

Ordering information, User’s Manuals, and other related documents for boards are available. Please contact Renesas to
get them.

2.2 System Configuration

Below is an example of a typical system configuration of evaluation board.

s Y /ﬁ
B — [-Jet { E P
| \ 4 . E' o j!-
or T b e~
J— or (e W L2
f . = 14T A B
B J-Link™ @ SRR LY TR
N / P 14 -
- or T
£ 3 e “-“ l:;?‘.‘.l_ .

micro-USB Type-B (for J-Link OB) ‘CI‘:’U Bo.a.réjA

HOST PC

3

USB Type-C (for power supply)

Figure 2: System Configuration Example — with Evaluation Board

For the details, please refer to the related document “1.3.1 Evaluation Board User’s Manual”.
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2.3 Supported Emulator

2.3.1 SEGGER J-Link
SEGGER J-Link can be used on Renesas e studio only for debugging on RZ/T2 and RZ/N2 devices.
Renesas €? studio supports the following emulators.

e J-Link EDU V11 and later

e J-Link BASE V11 and later

e J-Link PLUS V11 and later

e J-Link WiFi V1 and later

e J-Link ULTRA+ V5 and later

e J-Link PRO V5 and later

e J-Link OB-S124 V1.00

Renesas has tested debugging RZ/T2 and RZ/N2 devices with J-Link BASE V11 and J-Link OB-S124.
For the details on SEGGER J-Link, please see SEGGER website.

Debugging FSP Project was verified with the following software environment.

Table 1 Verified Operating Environment

Series Device FSP version e? studio version J-Link Software
version
RZ/T RZ/T2M, RZ/T2L, RZ/T2 FSP v2.2.0 2024-10 V7.98¢c
RZ/T2ME, RZ/T2H
RZ/N RZ/N2L, RZ/N2H RZ/N2 FSP v2.1.0 2024-10 V7.98¢c

Regarding how to update J-Link firmware, please confirm the procedure described in the following link into Renesas
Knowledge Base web site.

https://en-support.renesas.com/knowledgeBase/20736714

23.2 IAR I-Jet
IAR I-jet can be used on IAR EWARM only for debugging on RZ/T2 and RZ/N2 devices.
For the details on IAR I-jet, please see IAR Systems website.
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2.4 RZIT Series Board Setup
241 RSK+RZT2M

2.41.1 Boot Mode
The operation mode settings for the RSK+RZT2M board are as follows.

Note:
This section shows the settings for running on RAM without external flash memory. For settings to run in other
boot modes, please refer to the manual of the RSK boards listed in chapter 1.3.1. For the sample codes
available on Renesas web site, please refer to the documentation included with each code and implement the
appropriate board settings respectively.
RENESAS
Figure 3: Switch Position of Operation Mode Settings for RSK+RZT2M
Table 2 Operation Mode Switch Settings for RSK+RZT2M
Switch Setting Description
Sw4.1 ON 16-bit bus boot mode (NOR Flash)
SW4.2 OFF
Sw4.3 ON
SW4.4 ON JTAG Authentication by Hash is disabled.
SwW4.5 ON ATCM 0 wait
Valid for CPU operating frequency equal to or less than 400MHz.
RO1AN6434EJ0113 Rev.1.13 Page 10 of 160

Dec.23.24 RENESAS



https://www.renesas.com/rzt2m#design_development
https://www.renesas.com/rzt2m#design_development

RZ/T2, RZIN2 Getting Started with Flexible Software Package

2.41.2 Debugger Connection
If you use JTAG connection with I-Jet or J-Link,
1. Short the jumper pin (J9) for switching the debug connection so that RSK+RZT2M board can use the emulator
connected to JTAG connector (J20).
. Connect the emulator (J-Link or I-jet) to a free USB port on your computer.
3. Connect the IAR I-Jet to the RSK+RZT2M board ensuring that it is plugged in to the header “J20”.

B
. RENESAS

[ 5K RITM

Figure 4: Jumper Position of JTAG Connection for RSK+RZT2M

If you use J-Link OB on RSK+RZT2M board,

1. Open the jumper pin (J9) for switching the debug connection so that RSK+RZT2M can use J-Link OB on the
board.

2. Connect the micro-USB type-B to J-Link OB USB connector (J10), and then the LED4 is lighted.

B
. RENESAS

Figure S: J-Link OB Connection Settings for RSK+RZT2M
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2.4.1.3 Power Supply

Power is supplied using a USB cable (Type-C) or an AC / DC adapter.

e When using a USB cable (Type-C), connect it to the USB connector “CNS5” of the RSK+RZT2M board.

e When connecting the AC / DC adapter, connect it to the USB connector “CN6” of the RSK+RZT2M board.

Figure 6: How to Power Supply for RSK+RZT2M
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24.2 RSK+RZT2L

2.4.21 Boot Mode
The operation mode settings for the RSK+RZT2L board are as follows.

Note:
This section shows the settings for running on RAM without external flash memory. For settings to run in other
boot modes, please refer to the manual of the RSK boards listed in chapter 1.3.1. For the sample codes
available on Renesas web site, please refer to the documentation included with each code and implement the
appropriate board settings respectively.
Figure 7: Switch Position of Operation Mode Settings for RSK+RZT2L
Table 3 Operation Mode Switch Settings for RSK+RZT2L
Switch Setting Description
Sw4.1 ON xSPI0 boot mode (x1 boot serial flash)
Sw4.2 ON
SwW4.3 ON
Sw4.4 ON ATCM wait cycle = 0 wait
Sw4.5 ON JTAG mode = Normal mode
RO1AN6434EJ0113 Rev.1.13 Page 13 of 160
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2.4.2.2 Debugger Connection
If you use JTAG connection with I-Jet or J-Link,
1. Short the jumper pin (J9) for switching the debug connection so that RSK+RZT2L board can use the emulator
connected to JTAG connector (J20).
. Connect the emulator (J-Link or I-jet) to a free USB port on your computer.
3. Connect the IAR I-Jet to the RSK+RZT2L board ensuring that it is plugged in to the header “J20”.

Figure 8: Jumper Position of JTAG Connection for RSK+RZT2L

If you use J-Link OB on RSK+RZT2L board,
1. Open the jumper pin (J9) for switching the debug connection so that RSK+RZT2L can use J-Link OB on the board.
2. Connect the micro-USB type-B to J-Link OB USB connector (J10), and then the LED®6 is lighted.

Figure 9: J-Link OB Connection Settings for RSK+RZT2L
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2.4.2.3 Power Supply

Power is supplied using a USB cable (Type-C) or an AC / DC adapter.

e When using a USB cable (Type-C), connect it to the USB connector “CNS5” of the RSK+RZT2L board.

e When connecting the AC / DC adapter, connect it to the USB connector “CN6” of the RSK+RZT2L board.
e After connecting to the power (CN5 or CN6), turn on the POWER_SW slide switch to start power supply.

Figure 10: How to Power Supply for RSK+RZT2L

24.3 RSK+RZT2ME
For each setting, see 2.4.1 RSK+RZT2M.

RO1AN6434EJ0113 Rev.1.13 Page 15 of 160
Dec.23.24 RENESAS



RZ/T2, RZIN2

Getting Started with Flexible Software Package

2.4.4 RZ/T2H Evaluation Board
2.4.4.1 Boot Mode

The operation mode settings for the RZ/T2H evaluation board are as follows.

Note:
This section shows the settings for running on RAM without external flash memory. For settings to run in
other boot modes, please refer to the manual of the evaluation board listed in chapter 1.3.1. For the sample
codes available on Renesas web site, please refer to the documentation included with each code and
implement the appropriate board settings respectively.
Figure 11: Switch Position of Operation Mode Settings for RZ/T2H Evaluation Board
Table 4 Operation Mode Switch Settings for RZ/T2H Evaluation Board
Switch Setting Description
SW14.1 ON xSPI1 boot mode (x1 boot serial flash)
SwW14.2 OFF
SW14.3 ON
SwW14.4 ON CPUO ATCM 0 wait
SwW14.7 ON JTAG Authentication by Hash is disabled.
SW2.3 OFF This is necessary to light up LED3 (corresponding to CAS55 Corel blinky operation).
Note: This switch is not present on the provisional version of the board. Due to this
setting, P17 4, PO8_5, and PO8_6 cannot be used as SD1 control terminals.
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2.4.4.2 Debugger Connection
If you use JTAG connection with I-Jet or J-Link,

1)  Short the jumper block (CN62) for switching the debug connection so that RZ/T2H evaluation board can use the
emulator connected to JTAG connector (CN61).

2) Connect the emulator (J-Link or I-jet) to a free USB port on your computer.
3) Connect the emulator to the RZ/T2H evaluation board ensuring that it is plugged in to the header “CN61”.

Figure 12: Jumper Position of JTAG Connection for RZ/T2H Evaluation Board

If you use J-Link OB on RZ/T2H evaluation board,

1) Open the jumper block (CN62) for switching the debug connection so that RZ/T2H evaluation board can use J-
Link OB on the board.

2) Connect the micro-USB type-B to J-Link OB USB connector (CN14), and then the LED10 is lighted.

Figure 13: J-Link OB Connection Settings for RZ/T2H Evaluation Board
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2.4.4.3 Power Supply
Power is supplied using a USB cable (Type-C) or an AC / DC adapter.
e When using a USB cable (Type-C), connect it to the USB connector “CN46” of the RZ/T2H evaluation board.

e  When connecting the AC / DC adapter, connect it to the USB connector “CN47” of the RZ/T2H evaluation
board.
e  After connecting to the power (CN46 or CN47), turn on the POWER SW slide switch to start power supply.
Note:
Some Renesas boards, such as the Renesas Starter Kit, require a 12-V or 5-V power supply, the supply of this

board is 15-V /3 A. Be careful not to accidentally connect a 12-V or 5-V power supply. When supplying power
through CN47, use a stabilized power source that is capable of supplying at least 15-V /3 A.

Figure 14: How to Power Supply for RZ/T2H Evaluation Board

RO1AN6434EJ0113 Rev.1.13 Page 18 of 160
Dec.23.24 RENESAS




RZ/T2, RZIN2 Getting Started with Flexible Software Package

2.5 RZIN Series Board Setup

2.5.1 RSK+RZN2L

2.5.1.1 Boot Mode
The operation mode settings for the RSK+RZN2L board are as follows.

Note:
This section shows the settings for running on RAM without external flash memory. For settings to run in other
boot modes, please refer to the manual of the RSK boards listed in chapter 1.3.1. For the sample codes
available on Renesas web site, please refer to the documentation included with each code and implement the
appropriate board settings respectively.
Figure 15: Switch Position of Operation Mode Settings for RSK+RZN2L
Table 5 Operation Mode Switch Settings for RSK+RZN2L

Switch Setting Description

Sw4.1 ON 16-bit bus boot mode (NOR flash)

Sw4.2 OFF

SW4.3 ON

SW4.4 ON JTAG Authentication by Hash is disabled.
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2.5.1.2 Debugger Connection
If you use JTAG connection with I-Jet or J-Link,

1. Short the jumper pin (J9) for switching the debug connection so that RSK+RZN2L board can use the emulator
connected to JTAG connector (J20).

2. Connect the Emulator (J-Link or I-jet) to a free USB port on your computer.
3. Connect the IAR I-Jet to the RSK+RZN2L board ensuring that it is plugged in to the header “J20”.

The figure below is when a I-jet is used as Emulator.

=

834

Figure 16: Jumper Position of JTAG Connection for RSK+RZN2L

If you use J-Link OB on RSK+RZN2L board,
1. Open the jumper pin (J9) for switching the debug connection so that RSK+RZN2L can use J-Link OB on the board.
2. Connect the micro-USB type-B to J-Link OB USB connector (J10), and then the LED4 is lighted.

iifiun

Figure 17: J-Link OB Connection Settings for RSK+RZN2L
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2.5.1.3 Power Supply

Power is supplied using a USB cable (Type-C) or an AC / DC adapter.

e When using a USB cable (Type-C), connect it to the USB connector “CN5” of the RSK+RZN2L board.

e When connecting the AC / DC adapter, connect it to the USB connector “CN6” of the RSK+RZN2L board.

=

]

Figure 18: How to Power Supply for RSK+RZN2L
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2.5.2 RZ/N2H Evaluation Board

2.5.2.1 Boot Mode

The operation mode settings for the RZ/N2H evaluation board are as follows.

Note:

This section shows the settings for running on RAM without external flash memory. For settings to run in
other boot modes, please refer to the manual of the evaluation board listed in chapter 1.3.1. For the sample
codes available on Renesas web site, please refer to the documentation included with each code and

implement the appropriate board settings respectively.

Figure 19: Switch Position of Operation Mode Settings for RZ/N2H Evaluation Board

Table 6 Operation Mode Switch Settings for RZ/N2H Evaluation Board

Switch Setting Description
DSW3.1 ON xSPI1 boot mode (x1 boot serial flash)
DSW3.2 OFF
DSW3.3 ON
DSWwW3.4 ON CPUO ATCM 0 wait
DSW3.7 ON JTAG Authentication by Hash is disabled.
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2.5.2.2 Debugger Connection
If you use JTAG connection with I-Jet or J-Link,

1) Short the jumper block (JP40) for switching the debug connection so that RZ/N2H evaluation board can use the
emulator connected to JTAG connector (CN24).

2) Connect the emulator (J-Link or I-jet) to a free USB port on your computer.
3) Connect the emulator to the RZ/N2H evaluation board ensuring that it is plugged in to the header “CN24”.

Figure 20: Jumper Position of JTAG connection for RZ/N2H Evaluation Board

If you use J-Link OB on RZ/N2H evaluation board,

1. Open the jumper block (JP40) for switching the debug connection so that RZ/N2H evaluation board can use J-
Link OB on the board.

2. Connect the micro-USB type-B to J-Link OB USB connector (CN26), and then the LED12 is lighted.

Figure 21: J-Link OB Connection Settings for RZ/N2H Evaluation Board
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2.5.2.3 Power Supply

Power is supplied using a USB cable (Type-C) or an AC / DC adapter.

e When using a USB cable (Type-C), connect it to the USB connector “CN13” of the RZ/N2H evaluation board.
e When connecting the AC / DC adapter, connect it to the USB connector “J1” of the RZ/N2H evaluation board.
e After connecting to the power (J1 or CN13), turn on the POWER SW slide switch to start power supply.

Note:

Some Renesas boards, such as the Renesas Starter Kit, require a 12-V or 5-V power supply, the supply of this
board is 15-V /3 A. Be careful not to accidentally connect a 12-V or 5-V power supply. When supplying power
through J1, use a stabilized power source that is capable of supplying at least 15-V /3 A.

Figure 22: How to Power Supply for RZ/N2H Evaluation Board
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3. e?studio Setup
3.1 What is e? studio?

Renesas €’ studio is a development tool encompassing code development, build, and debug. €? studio is based on the
open-source Eclipse IDE and the associated C/C++ Development Tooling (CDT).

When developing for RZ/T2, RZ/N2 MPUs, e? studio hosts the Renesas Flexible Software Package (FSP). FSP provides
a wide range of time saving tools to simplify the selection, configuration, and management of modules and threads, to
easily implement complex applications.

3.2 e?studio Prerequisites
3.21 Windows PC Requirements
The following are the Windows PC requirements to use € studio:
For Windows 64-bit version
e  Windows® 11 (64-bit version)
e  Windows® 10 (64-bit version)
e  Windows® 8.1 (64-bit version)
e  Memory capacity: We recommend 8 GB or more. At least 4 GB.
e  Capacity of hard disk: At least 2 GB of free space.

e Display: Graphics resolution should be at least 1024 x 768, and the mode should display at least 65,536
colors.

e  Interface: USB 2.0
e  Microsoft Visual C++ 2010 SP1 runtime library *1
e  Microsoft Visual C++ 2015-2019 runtime library *1
*1. This software will be installed at the same time as the e? studio.

3.2.2 Installing e? studio, Platform Installer and FSP Package

Detailed installation instructions for the e? studio and the FSP are available on the Renesas website. Review the release
notes for €2 studio to ensure that the € studio version supports the selected FSP version. The starting version of the
installer includes all features of the RZ/T2, RZ/N2 MPUs.

3.2.3 Choosing a Toolchain

The GNU ARM Embedded Toolchain (version 12.2.1.arm-12-24 for CR52) and GNU ARM A-Profile (AArch64 bare-
metal) (version 10.3.1.20210621 for CA55) are required.

If the version of the toolchain has not been installed, please download the toolchain from ARM Developer website, and
install it.

3.2.4 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.
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4. Tutorial: Your First RZ/T2, RZ/IN2 MPU Project — Blinky

4.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of creating
a simple application using ¢ studio and running that application on an RZ/T2, RZ/N2 evaluation board. This chapter
guides you through creating projects for a single-core processing and a multiprocessing with RAM execution without
flash memory. In this chapter, the multiprocessing refers to a process in which CR52 CPUO core is activated first and
second core (CR52 CPU1 or CAS55 Core0) operates after CR52 CPUO core sets up for second core.

4.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded development
environment.

Blinky is the “Hello World” of microprocessors. If the LED blinks you know that:
e  The toolchain is setup correctly and builds a working executable image for your chip.
e  The debugger has installed with working drivers and is properly connected to the board.
e  The board is powered up and its jumper and switch settings are probably correct.

e  The microprocessor is alive, the clocks are running, and the memory is initialized.
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4.3 Create a New Project for Blinky

The creation and configuration of an RZ/T and RZ/N C/C++ FSP Project is the first step in the creation of an
application. The base RZ/T2 pack and RZ/N2 packs include a pre-written Blinky example application. In the case of
multiprocessing, two projects with different settings must be created. A project that starts first is called the primary
project and the secondary project that runs after releasing reset by the primary project is called the secondary project.

Note for multiprocessing projects:
The primary project and the secondary project should be created in the same workspace.

The secondary project should be created after the primary project is created in 4.3 section and built the primary
project in 4.4 section.

Follow these steps to create an RZ/T2, RZ/N2 MPU project:

1. Iné? studio, click File > New > Renesas C/C++ Project > Renesas RZ.

[} - e studio
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
| New Alt+Shift+N > Renesas C/C++ Project > Renesas Debug
Open File... ™ Project... Renesas RZ
() Open Projects from File System... [ Example.. ™ BSP_DONT
Recent Files > pez BSP_PLAC
[§ Other. Ctrl+N  Re3 BSP_DONT

_______ iane Fodam ha rep BI AC

Figure 23: New C/C++ Project

2. Select either one depending on your RZ/T2, RZ/N2 MPU.
. RZ/T series: All > Renesas RZ/T C/C++ FSP Project
. RZ/N series: All > Renesas RZ/N C/C++ FSP Project
3. Click Next.

ﬁ New C/C++ Project ] x

Templates for Renesas RZ Project

Renesas RZ/N C/C++ FSP Project A
CC++ FE==™ (reate an executable or static library C/C++ FSP
project for Renesas RZ/N.

Renesas RZ/T C/C++ FSP Project
TR, (reate an executable or static library C/C++ FSP
project for Renesas RZ/T.

Renesas RZ/V C/C++ FSP Project
FEZN Create an executable or static library C/C++ FSP
project for Renesas RZ/V.

Gy = 2 =
!\Z‘ < Back Next > Finish Cancel

Figure 24: Renesas RZ C/C++ FSP Project

(Continued on next page)
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4. Assign a name to this new project. An example of naming is shown below.

Table 7 ¢? studio Newly Created Project Settings (1)

Single-core | Multiprocessing

Multiprocessing

processing (CR52 CPUO, CR52 CPU1) (CR52 CPUO, CASS Core0)
Primary Secondary Primary Secondary
Project Blinky Blinky primary Blinky secondary | Blinky primary Blinky secondary
name
5. Click Next. The Project Configuration window shows your selection.
&) Renesas RZ/T C/C++ FSP Project [m] > 4

Renesas RZ/T C/C++ FSP Project

Project Name and Location

Project name

[Biinky

Use default location

¥Blinky

You can download more Renesas packs here

Cancel

Figure 25 : e studio Project Configuration Window (Part 1)

(Continued on next page)
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6. Select the board support package by selecting the name of your board from the drop-down list.

In this tutorial, please select either one depending on your device and board.
(Multicore device ONLY) Select the Core from the drop-down list.

8. Select toolchains and version, then click Next.

e [fthere is NOT the target toolchain, please download the version of the toolchain from ARM Developer
website and install it.

Table 8 ¢* studio Newly Created Project Settings (2)

|<'nﬂ\[ha'n Version> vl

Single-core Multiprocessing Multiprocessing
[PIROICERRALIY (CR52 CPUO, CR52 CPU1) (CR52 CPUO, CA5S Core0)
Primary Secondary Primary Secondary
Board RSK+RZXXX (RAM execution without flash memory)
or RZXXX Evaluation Board (RAM execution without flash memory)
Core CRS52 Oor CR52 0 or CR52 | CR52 1or CR52 | CR52 CPUO CASS5 Core0
CR52 CPUO | CPUO CPU1
Toolchains | GNU ARM Embedded and 12.2.1.arm-12-24 GNU ARM A-
Profile (AArch64
bare-metal) and
10.3.1.20210621
8 Renesas RZ/T C/C++ FSP Project =] X
Renesas RZ/T C/C++ FSP Project —
Device and Tools Selection
Device Selection
FSP Version: |<FSP Version> o] | Board Description
RZT2H Evaluation Board (RAM execution without flash memory)
Board: [RZT2H Evaluation Board (RAM execution with | | .
Core: [CRs2 CPUO | vI '::;o:’s e
language @C (OC++ Pins 729
| 6 ARM Embedded | J-Link ARM B

Figure 26 : e? studio Project Configuration Window (Part 2)

9. (The secondary project of multiprocessing ONLY) Select a bundle file of the primary project as Proceeding
Project. Built the primary project names in the same workspace appear as an option in the drop-down list.

(Continued on next page)
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Note:

Warnings occur if the FSP version or Board (boot mode) used is different between the primary project and the
secondary project. Use the same FSP version and Board (boot mode).

Warnings occur when cores of the primary project and the secondary project are different in multiprocessing,
because Toolchain and Toolchain version do not match. Ignore the warning and proceed to the next step.

€8 Renesas RZ/T C/C++ FSP Project

m] X
Renesas RZ/T C/C++ FSP Project —
Preceding Project or Smart Bundle Selection
@ Preceding Project: | Blinky_primary iy

Choase this option if you have access to the project source code of the preceding processor core or security context.
O Smart Bundle:

Preceding Project/Smart Bundle Details

FSP version <FSP Yersion>
Toolchain GNU ARM Embedded
Toolchain version <Taolchain Version>
Board <Board (hoot mode)=
Device R9A0IGO7T7M44GBG
Core CRs2_0
Zones CRs2_0
\"?-) < Back Einish Cancel

Figure 27 e’ studio Project Configuration Window (Part 3)

10. Select the Build artifact and RTOS.

€8 Renesas RZ/T (/C++ FSP Project
Renesas RZ/T C/C++ FSP Project

Build Artifact and RTOS Selection

Build Artifact Selection RTOS Selection

@® Executable |vo RTOS ]
® Project builds to an executable file

O Static Library
* Project builds to a static library file

@ = I

Figure 28 : e’ studio Project Configuration Window (Part 4)

RO1AN6434EJ0113 Rev.1.13

Page 30 of 160
Dec.23.24 RENESAS




RZ/T2, RZIN2 Getting Started with Flexible Software Package

11. Select the Blinky template for your board and click Finish.

8 Renesas RZ/T C/C+~ FSP Project [m] X

Renesas RZ/T C/C++ FSP Project —

Project Template Selection

Project Template Selection

® '| Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and the
C runtime environment.

[Renesas.RZT, <FSP Version> .pack]

o Bare Metal - Minimal
. Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

[Renesas.RZT. <FSP Version= pack]

Code Generation Settings
[#] Use Renesas Code Formatter

® TR o

Figure 29 : ¢? studio Project Configuration Window (Part 5)
Once the project has been created, the name of the project will show up in the Project Explorer window of e? studio.

Note for the primary project using CR52 CPUO:

If the primary project selects CR52 CPUO as Core and the secondary or later project uses a CA55 core, you
need to set "PLLO is released from standby state" and enable PLLO in the Clocks tab of FSP Configuration.

8 Feanfiguration.xm - e studic - o X
File Edit Mavigate Search Project Rene n Wing
B-g - - Qv Q g | Ejoce+ {8 FSP Configuration 45 Debug

= [ ] FSP Configuration X =8 |5
o

'] Clocks Configuration

Generate Project Content

ES Restore Defauits

B | penosrme T oo R rrererrr A
@ Pl e 1
a ELHIE R TRTi P | ‘slpLoSsCDisabled | []casscicikeoomHz
CLMAGﬂm}r\aI mosk v|  [MMREInTGz v |ocasscacikeoomHz v
MRR 1 | oasscacicsoomiz ~
Modulation rate: 0%
[+ PLL1 1000MHz CASSSCLK 500MHz ~
CLMA1 Enabled ~ | > CRS2COCLK S0OMHz ~ ~
CLMAT error not mask v |+ cRscicLK somHz
|| ercLxa 200mHz
I>{ ETCLYB 125MH2

< >
Summary |BSP | Clacks  Pins | Internspts| Event Links  Stacks| Components

Figure 30 : Enable PLLO in the Primary Project using CRS52 CPU0

(Continued on next page)

RO1AN6434EJ0113 Rev.1.13 Page 31 of 160
Dec.23.24 RENESAS




RZ/T2, RZIN2

Getting Started with Flexible Software Package

Now click the Generate Project Content button in the top right corner of the Project Configuration window to

generate your board specific files.

{6} [Blinky] FSP Configuration

Summary

Project Summary

=8

(]
Generate Project Content

~

RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: RIADIGOTTMALGBG
Core: CR52 CPUO
Toolchain: Gce as RZ
Toolchain Version: T
FSP Version:
Project Ty
Location:

Figure 31 : e’ studio Project Configuration Tab

Your new project is now created, configured, and ready to build.
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4.3.1 Details about the Blinky Configuration

The Generate Project Content button creates configuration header files, copies source files from templates, and
generally configures the project based on the state of the Project Configuration screen.

For example, if you check a box next to a module in the Components tab and click the Generate Project Content button,
all the files necessary for the inclusion of that module into the project will be copied or created. If that same check box
is then unchecked those files will be deleted.

4.3.2 Configuring the Blinky Clocks
By selecting the Blinky template, the clocks are configured by €? studio for the Blinky application.

The clock configuration tab (see 6.3.3 Configuring Clocks) shows the Blinky clock configuration. The Blinky clock
configuration is stored in the BSP clock configuration file.

4.3.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle some of LEDs are configured by €? studio for the Blinky
application.

The pin configuration tab shows the pin configuration for the Blinky application (see 6.3.4 Configuring Pins). The
Blinky pin configuration is stored in the BSP configuration file.

4.3.4 Configuring the Parameters for Blinky Components
The Blinky project automatically selects the following HAL components in the Components tab:

e 1 _ioport

To see the configuration parameters for any of the components, check the Properties tab in the HAL window for the
respective drivers (see 6.5 Adding and Configuring HAL Drivers).

4.3.5 Where is main()?

The main function is located in:
e < RZT2 FSP project >/rzt_gen/main.c.
e < RZN2 FSP project >/rzn_gen/main.c.

It is one of the files that are generated during the project creation stage and only contains a call to hal entry(). For more
information on generated files, see 6.5 Adding and Configuring HAL Drivers.

4.3.6 Blinky Example Code

The blinky application is stored in the hal _entry.c file. This file is generated by e? studio when you select the Blinky
Project template and is located in the project’s folder < project >/src/ folder.

The application performs the following steps:

. Get the LED information for the selected board by bsp_leds_t structure.
2. Initialize output level for LED pin to LOW using R_BSP_PinClear((bsp_io_region_t) leds.p_leds]i][1],
(bsp_io_port_pin_t) leds.p_leds][i][0]).
3. Use R _BSP_PinToggle ((bsp_io_region_t) leds.p_leds][i][1], (bsp_io_port_pin_t) leds.p_leds[i][0]) to set the
output level to the LED pin.
4. R_BSP_SoftwareDelay(delay, bsp delay units) waits for a certain period of time. Then run #3 again.
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4.4 Build the Blinky Project
Highlight the new project in the Project Explorer window by clicking on it and build it.

When multiprocessing, please refer to Section 4.4.2 Build for Multiprocessing.

441 Build

There are three ways to build a project:

1. Click on Project in the menu bar and select Build Project.
2. Click on the hammer icon.

3. Right-click on the project and select Build Project.

Q workspace - Blinky/configuration.xml - €” studio ) ) )
File Edit Mavigate Search enmw'rews Rum—Wirdow Help — a. Project > Build Project

5 Debug & Blinky Debug_Flat H-ERl ®1% ']n‘fo

b. Click hammer icon

i Project Explorer X 51 G W § = O |45 “[Biinky] FSP Configuraion 32 | ¢ Right click - Build project
....... T summary

Figure 32 : ¢’ studio Project Explorer Window

Once the build is complete a message is displayed in the build Console window that displays the final image file name
and section sizes in that image.

[&:;PinCcnnfl'lcts_ X TG BEE-EE B -8-=0O0

ICDT Build Console [Blinky]
‘arm-none-eabi-gcc -mcpuscortex-r52 -mthumb -mfloat-abi=hard -mfpu=neon-fp-armvd -fdiagnostics-parseable-fixits -0g -fmessage-length=t ~
‘arm-none-eabi-gcc -mcpu=cortex-r52 -mthumb -mfloat-abi=hard -mfpu=neon-fp-armv8 -fdiagnostics-parseable-fixits -0Og -fmessage-length=¢
‘arm-none-eabi-gcc -mcpuscortex-r52 -mthumb -mfloat-abi=hard -mfpu=neon-fp-armvé -fdiagnostics-parseable-fixits -0g -fmessage-length=t
‘arm-none-eabi-gce -mcpu=cortex-r52 -mthumb -mfloat-abi=hard -mfpu=neon-fp-armv8 -fdiagnostics-parseable-fixits -0g -fmessage-length=¢
'arm-none-eabi-gcc -mcpu=cortex-r52 -mthumb -mfloat-abi=hard -mfpu=neon-fp-armv8 -fdiagnostics-parseable-fixits -0g -fmessage-length=¢
‘arm-none-eabi-gcc -mcpuscortex-r52 -mthumb -mfloat-abi=hard -mfpu=neon-fp-armvd -fdiagnostics-parseable-fixits -0g -fmessage-length=t
arm-none-eabi-gce @"Blinky.elf.in™
arm-none-eabi-objcopy -0 srec "Blinky.elf" “Blinky.srec”
arm-none-eabi-size --format=berkeley "Blinky.elf"

text data bss dec hex filename

Gead @ G5568 68564 1ebd4 Blinky.elf

11:46:51 Build Finished. @ errors, @ warnings. (toock 12s5.789ms)

Figure 33 : €? studio Project Build Console

4.4.2 Build for Multiprocessing
Build the projects for multiprocessing with the following steps.
1. Create and build the primary project. (1st build of the primary project)
Refer to 4.3 Create a New Project for Blinky and 4.4.1 Build.
2. Create the secondary project and build it.
3. Build the primary project again. (2nd build of the primary project)
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4.5 Debug the Blinky Project

4.5.1 Debug Prerequisites

To debug the project on a board, you need the following:
e  The board to be connected to €* studio.

e  The debugger to be configured to talk to the board.

e  The application to be programmed to the microprocessor.

Applications run from the internal ram of your microprocessor. To run or debug the application, the application must
first be programmed to ram by JTAG debugger.

Evaluation board has a JTAG header and requires an external JTAG debugger to the header.

4.5.2 Debug Steps

When multiprocessing, please refer to Section 4.7 Debug and Run for Multiprocessing.

Note:

The main chapter of this documentation describes a RAM execution without flash memory project. When
debugging a project with flash boot mode, please also refer to Appendix. How to Debug FSP Project with
Flash Boot Mode.

To debug the Blinky application, follow these steps. If the step is preceded by (XXX), it is executed only if the
condition is met.

(RAM exec): The boot mode used in the project is RAM execution without flash memory.
(CR52): The core used in the project is CR52.
(CASS5): The core used in the project is CASS.

1. Configure the debugger for your project by clicking Run > Debugger Configurations ... or by selecting the drop-
down menu next to the bug icon and selecting Debugger Configurations ...

Run Window Help

Renesas Device Partition Manager
TraceX >
Tracealyzer »

Run Ctrl+F11
Debug F11

7o 0B

Run History >
O RunAs >
Run Configurations...
Debug History >
%5 DebugAs >
Debug Configurations...
Q. Extenal Tools >

Figure 34 : e studio Debugger Configurations Selection Option

%vr%v b, -

Debug As >
Debug Configurations...

Organize Favorites...

Figure 35 : ¢? studio Debug Icon
(Continued on next page)
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2. Select your debugger configuration in the window. If it is not visible, then it must be created by clicking the New

icon in the top left corner of the window. Once selected, the Debug Configuration window displays the Debug
configuration for your Blinky project.

¢ Debug Configurations o X
Create, manage, and run configurations ﬁ(
& ¢ X | E YV~ | Name: [Biinky Debug_Fiat |

] _*ﬁmbugger # Startup| 1 Source| [T] Common

Project:

c | C/C++ Application

[€] C/C++ Remote Application
EASE Script | Blinky || Browse..

[€] GDB Hardware Debugging
GDB OpenOCD Debugging

[€%] GDB Simulator Debugging (I

] Java Applet

[T] Java Application

C/C++ Application:

Debug/Blinky.elf

Variables... | | Search Project..| |  Browse..

Build (if required) before launching

@ Launch Group
T Remote Java Application Build Configuration: | Use Active ~
 [€7] Renesas GDB Hardware Deb =
P Snkey Deboc Fiat O Enable auto build O Disable auto build
% Renesas Simulator Debuggir ||| @ Use workspace settings Configure Workspace Settings...
< >
Filter matched 13 of 15 items

Figure 36 : ¢? studio Debugger Configurations Window with Blinky Project

3. Ifyou use RAM execution without flash memory boot mode, it needs following configuration.
>  Debugger > Connection Settings > Connection
> (RAM exec) Set No to Reset after download to avoid resetting MPU after program download

»  (CR52 CPUO) Set Yes to Set CPSR(5bit) after download to set the CPSR register value of CR52
general register before running the application.

Table 9 ¢* studio Newly Created Project Debug Settings (1)

Single-core Multiprocessing Multiprocessing
RIGCESSITS (CR52 CPUO, CR52 CPU1) (CR52 CPUO, CAS55 Core0)
Primary Secondary Primary Secondary

Reset after No (default)
download
Set Yes Yes No (default) Yes No (default)
CPSR(5bit)
after
download

(Continued on next page)
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@ Debug Configurations

Create, manage, and run configurations

g E@X| B Name: [Blinky Debug_Flat

[€] C/C++ Application

] C/C++ Remote Application

Debug hardware:

| Main [35 Debugger] & Startup| ' Source | (7] Common

: |J-Link ARM | Target Device: ROADTGO7SM24_CPL | ...

Core clock (MHz)
v TrustZone

< >

Filter matched 9 of 11 items

@

Set TrustZone secure/non-secure boundaries

Reyert Apply
e

Figure 37 : e studio Debugger Configurations Window with Blinky Project (CR52 CPU0)

4. (CA5S5) Check and modify the target device and GDB common settings of the CAS5S core project to connect to

debugging.
Table 10 e? studio Newly Created Project Debug Settings (2)
Single-core Multiprocessing Multiprocessing
RIGCESSITS (CR52 CPUO, CR52 CPU1) (CR52 CPUO, CASS Core0)
Primary Secondary Primary Secondary

Debugger > Target (default) (default) (default) (default) target device
Device
Debugger > GDB (default) (default) (default) (default) aarch64-elf-
settings > GDB > gdb
GDB Command

(Continued on next page)

RO1AN6434EJ0113 Rev.1.13

Dec.23.24

RENESAS

Page 37 of 160




RZ/T2, RZIN2

Getting Started with Flexible Software Package

€ Debug Configurstions

Create, manage, and run configurations

Hame: | Blinky_ca35_secondary Debug Fiat
| Main | 15 Debugger B Stertup) [1] Common| %, Source.

J-Link ARM VI cac|

608 Settings Conmection Seftings Debug Tool Settings

Filter matched 10 of 12 items

@

608 Connection Settings
® Host name or P address: | Iscalhost
Qc DB port number:
Connection timeout (s | 30 S
c08
608 Command: | asrchéd-sli-gab
CTster Vode

Y] s

Additional GDB Server Arguments

Debug Close:

Figure 38 : e? studio Debugger Configurations Window with Blinky Project (CA55)

5. Click Debug to begin debugging the application.

Q Progress Information

o
l |
k4

PR
Configuring GDB

Preparing launch delegate...

Cancel

Details »>

Figure 39: Start Debugging
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4.5.3 Details about the Debug Process

In debug mode, €? studio executes the following tasks:

1. Downloading the application image to the microprocessor and programming the image to the internal memory.
Setting a breakpoint at main().

Setting the stack pointer register to the stack.

Loading the program counter register with the address of the system_init().

vk v

Displaying the startup code where the program counter points to.

{0% [Blinky] FSP Configuration m = B
384 RFEIA  sp! \n" /* from s */ A

84 Return om system mode tack using RFE.
ti: "memory™);
¥
= BSP_TARGET_ARM BSP_ATTRIBUTE_STACKLESS void system_init (void)
{
__asm volatile (
set_hactlr: n
MOWW r@, X[hactlr_bit_1] \n" /* Set HACTLR bits(L) */
MOVT ro, #0 \n"

MCR pls, #4, r@, cl, co, #1 \n" /* Write r@ to HACTLR
::[hactlr_bit_1] "i" (HACTLR_BIT_L) : "memory");

__asm volatile (
"set_hcr: \n"
" MRC pls, #4, r1, cl1, cl1, #0@ \n"
ORR  r1, r1, %¥[hcr_hcd_dis] \n" /* bl
MCR pl5, #4, rl, c1, c1, #0 \n" /* Write Hyp Configuration Register *
::[her_hed_dis] "i" (HCR_HCD_DIS) : “"memory”);

__asm volatile (

"set_vbar: \n"

LDR r@, =vector_table \n"

MCR  pl5, #0, r@, cl2, c@, #8 \n" /* Write r@ to VBAR *,
111 "memory”);

Figure 40 : ¢’ studio Debugger Memory Window

4.6 Run the Blinky Project

While in Debug mode, click Run > Resume or click on the Play icon twice.

Figure 41 : e’ studio Debugger Play Icon

The following LEDs on the board should now be blinking.
e RZ/T series

» RSK+RZ/T2M: LEDO-1 (CPU0), LED2-3 (CPU1)

» RSK+RZ/T2L: LEDO0-6 (including LEDx_ESC xxx)

» RSK+RZ/T2ME: LEDO-1 (CPUO0), LED2-3 (CPU1)

»  RZ/T2H Evaluation Board: LEDO (CR52 CPU0), LED1 (CR52 CPU1), LED2 (CAS55 Core0)
e RZ/N series

» RSK+RZ/N2L: LEDO-3

»  RZ/N2H Evaluation Board: LED3 (CR52 CPUO), LED4 (CR52 CPU1), LEDS8 (CAS55 CPUO0)

(Continued on next page)
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To suspend program execution, click Run > Suspend or click on the Pause icon.

Figure 42 : ¢? studio Debugger Pause Icon

To exit Debug mode and disconnect from the debugger, click Run > Terminate or click on the Stop icon.

Figure 43 : e studio Debugger Stop Icon

4.7 Debug and Run for Multiprocessing

To debug the Blinky application, follow these steps:
1. Connect the debugger with the primary project using the procedure in 4.5.2 Debug Steps .

2. The primary project stays connected, connect the debugger with the secondary project using the procedure in 4.5.2
Debug Steps.

3.  When the following dialog box is shown, please click No to start debugging.

Launcher X
a8

l A Renesas GDB debug session is already active.

Do you want to terminate all currently active debug sessions before starting the new
session? (Note: Selecting No may result in unstable debug functionality)

[J Remember my decision

E Yes I [ No I Cancel

Figure 44 Warning Window of Starting Debug Session

4.  When Figure 45 is shown, please click Yes to proceed the launch.

a Proceed with launch? X

The device (R9A07GO75M24_CR52_1) set in the launch configuration does not match
A, the target device (R9A07GO75M24GBG) set in the project. The launch may not

function correctly.

Do you wish to proceed with the launch?

No

Figure 45 Warning Window of Device Name

(Continued on next page)
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5. Run the primary project with procedure 4.6 Run the Blinky Project to copy the binaries of the secondary and
subsequent projects to the internal RAM in the primary project. After the primary project reaches hal_entry in
main.c, other cores are executed. If the LEDs are blinking, proceed to the next step.

6. Run the secondary project with procedure 4.6 Run the Blinky Project.

7.  When exiting Debug mode and disconnecting from the debugger, terminate both projects, the primary and the
secondary.

e ] - Blinky_secondary/rzt_gen/main.c - &* studio

File Edit Source Refactor Navigate Search Project RenesasViews Run Wi
EXL T o> mme ek BiR e

45 Debug X B %|i» § = 0O

v [c7] Blinky_primary Debug_Flat [Renesas GDB Hardware Debugging]
v & Blinky_primary.elf [1] [cores: 0]
hread #1 1 (single core) [core: 0] (Running)
s [arm-none-eabi-gdb (12.1)
~ IRenesas GDB server (Host)
w [t Blinky_secondary Debug_Flat [Renesas GDB Hardware Debugging]
> Blinky_secondary.elf [1] [cores: 0]
E hread #1 1 (single core) [core: 0] (Running)
sl [arm-none-eabi-gdb (12.1)
| |Renesas GDB server (Host)

Figure 46 During Program Execution

& - Blinky_secondary/rzt_gen/main.c - & studio

File Edit Source Refactor Navigate Search Project RenesasViews Run Wi
‘@-Q- @|. i+ iR Q-

|6 Debug X B %|iv» § =0

<terminated, exit value: 0>arm-none-eabi-gdb (12.1)
<terminated, exit value: 0>Renesas GDB server (Host)

v <terminated > Blinky _secondary Debug_Flat [Renesas GDB Hardware Debugging)
<terminated, exit value: 0>arm-none-eabi-gdb (12.1)

u | <terminated, exit value: 0>Renesas GDB server (Host)

v 1 <terminated > Blinky_primary Debug_Flat [Renesas GDB Hardware Debugging

Figure 47 Terminated Program

4.8 Import the Project
The project created, built, and debugged in chapters 4.3 through 4.7 can be imported and run in other workspaces.

Note:
Apply the same version of FSP package used for the project to the other workspace.

(Continued on next page)
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To import the projects, follow these steps:

1. Click File > Import.

& new_workspace - ¢ studio

Edit Source Refactor Navigate Search Project RenesasViews Run Window

New Alt+Shift+N >

Open File... BES Y 8§ =8

(= Open Projects from File System...

Recent Files >

Close Editor & existing code

Ctrl+Shift+W

Save Ctrl+S

Ctrl+Shift+S

& Refresh Fs
Convert Line Delimiters To >

Print... Ctrl+P

[ Import..
Export...

Properties Alt+Enter

Switch Workspace >
Restart
Exit

Figure 48 ¢? studio Import

2. Click General > Existing Projects into Workspace.

& import u] X
Select
. . L N
reate new projects from an archive file or directory. g E

Select an import wizard:

[type filter text \
v (= General I ~
|~ .F ArchiveFile
[/ CMSIS Pack
Ié Existing Projects into Workspacel
() File System
Ta» GNUARM-NONE/RZ(DS-5) project conversion to GCC ARM Embedded
[ Preferences
() Projects from Folder or Archive
& Rename & Import Existing C/C++ Project into Workspace
Ta# Renesas CS+ Project for CA78KOR/CA78KO
& Renesas CS+ Project for CC-RX, CC-RL and CC-RH
T Renesas GitHub FreeRTOS (with loT libraries) Project
& Sample Projects on Renesas Website
B QC++

= Conel

7
@ B i ance

(Continued on next page)

Figure 49 e’ studio Select Import Type
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3. Select root directory or Select archive file where the project you would like to import into the other workspace
resides.

4.  Select projects to import in Projects. When using Select root directory, it is recommended to set Copy projects
into workspace in Options to avoid updating the same project from multiple workspaces.

Q Import a X
Import Projects —
Select a directory to search for existing Eclipse projects. L/‘“
I (® Select root directory: J De¥wsi s ~ [ Browse... I
(O Select archive file: Browse...
Projects:

Blinky_cpu0_primary (D:¥ws¥77;

P irrrarsss
Blinky_cpu_secondary (D:¥ws¥/7777

[ Blinky_nor_cpu0_primary [D:¥ws¥;}’;%
Blinky_nor_cpul_secondary (D:¥ws¥7/7/;

nky_cpu0_primary| Select All
inky_cpul_secol
Blinky_nor_cpu0) Deselect All

Refresh

< >

Options

[[] Search for nested projects

[] Close newly imported projects upon completion
[JHide projects that already exist in the workspace

Working sets
[J Add project to working sets New...

Figure 50 ¢’ studio Select Root Directory to Import Project

(Continued on next page)
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& Import O X
Import Projects i
Select a directory to search for existing Eclipse projects. / “;
(O Select root directory:
I (®) Select archive file: ‘ D:¥ws¥ 7 Blinky.zip v ||| Browse.. i
Projects:
Blinky_cpu0_primary (Blinky_cpu0_primary/) Select All
Blinky_cpu1_secondary (Blinky_cpu1_secondary/)
Blinky_nor_cpu0_primary (Blinky_nor_cpu0_primary/) Deselect All
Blinky_nor_cpu1_secondary (Blinky_nor_cpui_secondary/) Refresh
Options
ts into workspace
mported projects upon completion
[JHide projects that already exist in the workspace
Working sets
O Add project to working sets New...
Waork Sele

Figure 51 e? studio Select Archive File to Import Project

5. The projects have been imported into the other workspace.

Q new_workspace - & studio
File Edit Source Refactor Navigate Search P

| &~ &~ witp~Q

&5 Project Explorer X

=% Blinky_cpu0_primary

=% Blinky_cpul_secondary

=5 Blinky_nor_cpu0_primary
=S Blinky_nor_cpul_secondary

Figure 52 e? studio New Workspace

Note:
The imported project must be clicked the Generate Project Content button and built before debugging.
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5. FSP Smart Configurator User Guide

5.1 What is FSP Smart Configurator?

The Renesas FSP Smart Configurator (FSP SC) is a desktop application designed to configure device hardware such as
clock set up and pin assignment as well as initialization of FSP software components when using a 3™-party IDE and
toolchain.

For creating RZ/T2 and RZ/N2 project, the FSP SC can currently be used with
e TAR EWARM with IAR toolchain for Arm

Projects can be configured, and the project content generated in the same way as in €? studio. Please refer to 5.2
Configuring a Project section for more details.

5.2 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of creating
a simple application using FSP SC and 3™-party IDE and running that application on an RZ/T2, RZ/N2 MPU board.
This chapter guides you through creating projects for a single-core processing and a multiprocessing with RAM
execution without flash memory. In this chapter, the multiprocessing refers to a process in which CR52 CPUO core is
activated first and second core(CR52 CPU1 or CAS55 Core0) operates after CR52 CPUO core sets up for second core.

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded development
environment.

Blinky is the “Hello World” of microprocessors. If the LED blinks you know that:

e The toolchain is setup correctly and builds a working executable image for your chip.

e The debugger has installed with working drivers and is properly connected to the board.
e The board is powered up and its jumper and switch settings are probably correct.

e The microprocessor is alive, the clocks are running, and the memory is initialized.

RO1AN6434EJ0113 Rev.1.13 Page 45 of 160
Dec.23.24 RENESAS



RZ/T2, RZIN2 Getting Started with Flexible Software Package

5.3 Using Smart Configurator with IAR EWARM

IAR EWARM includes support for Renesas RZ/T2, RZ/N2 devices. These can be set up as bare metal designs within
IAR EWARM. However, most RZ/T2, RZ/N2 developers will want to integrate RZ/T2, RZ/N2 FSP drivers and
middleware into their designs. SC will facilitate this.

FSP SC generates a “Project Connection” file that can be loaded directly into AR EWARM to update project files.

5.3.1 Prerequisites
e TAR EWARM installed and licensed.
»  Please refer to IAR systems website regarding [AR EWARM.
e  FSP SC and FSP Pack installed.
»  Please refer to Renesas website regarding to FSP SC and FSP Pack.

Note for RZ/T2ME:

If you use the IAR EWARM 9.60.1 or 9.60.2 to debug RZ/T2ME FSP project, please apply the following
patch file.

e EWARM Patch for RZT2ME (EWARM Patch for RZT2ME rev1.0.zip)
. This patch file is available in http://www.renesas.com/rzt2me.

Regarding how to apply the patch, please read the readme file in patch file.

Note for RZ/T2H and RZ/N2H:
If you use the IAR EWARM to debug RZ/T2H and RZ/N2H FSP project, please apply the following patch file.
. EWARM Patch for RZT2H RZN2H (EWARM Patch for RZT2H RZN2H revl1.0.zip)
. This patch file is available in http://www.renesas.com/rzt2h and http://www.renesas.com/rzn2h.

Regarding how to apply the patch, please read the readme file in patch file.
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5.3.2 Create a New Project

The following steps are required to create a project using IAR EWARM, FSP SC and FSP. In the case of
multiprocessing, two projects with different settings must be created. A project that starts first is called the primary
project and the second project that runs after releasing reset by the primary project is called the secondary project.

Note for multiprocessing projects:
The primary project and the secondary project should be created in the same workspace.

The secondary project should be created after the primary project is created in 5.3.2 section and done 1% build
of the primary project in 5.3.3 section.

1. Start the FSP Smart Configurator.
e  FSP Smart Configurator is installed in the following path as default.

»  For RZ/T series, it is installed in C:\Renesas\rzt\sc vYYYY-MM_ fsp vX.X.X\eclipse\rasc.exe
»  For RZ/N series, it is installed in C:\Renesas\rzn\sc vYYYY-MM_fsp vX.X.X\eclipse\rasc.exe

2. Select the File > New > FSP Project...
e  This step may be unnecessary depending on old FSP SC version.

[EG FsP Smant Configurator
File | Window Help Run

>

FSP Project... ] = B % FsP Visualization

Property

[T Properties (£

| Prablems

Value

The active editor element does not use this view

A& Y § = O B Console

No consoles to display at this time.

(Continued on next page)

Figure 53 : FSP SC New Project
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3.  Enter a project folder and project name. An example of naming is shown below.

Table 11 FSP SC Newly Created Project Settings (1)

Single-core Multiprocessing Multiprocessing
[2ICSESSTIS (CR52 CPUO, CR52 CPU1) (CR52 CPUO, CASS Core0)
Primary Secondary Primary Secondary
Project Blinky Blinky primary Blinky secondary | Blinky primary Blinky secondary
name
@ New Renesas RZ/T Project o x
New Renesas RZ/T Project
Project Name and Location
Project name
[Blinky |
Location
| ¥Blinky| | | Browse...

[[] Create Directory for Project
Project will be created in " ¥Blinky"

You can download more Renesas packs here

ack Next > Finish Cancel

Figure 54 : FSP SC Project Settings

(Continued on next page)
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Select the FSP version.
5. Select the Board for your application.

e  You can select an existing RZ/T2, RZ/N2 MPU Evaluation Board or select Custom User Board for any of the
RZ/T2, RZ/N2 MPU devices with your own BSP definition.

e  Here, select either of following boards to create a FSP project for Evaluation board.
6. (Multicore device ONLY) Select the Core from the drop-down list.
7. Select IDE Project Type.

e  Asthe Toolchain, IAR Toolchain for ARM is preselected.
8. Click Next.

Table 12 FSP SC Newly Created Project Settings (2)

Single-core Multiprocessing Multiprocessing
[QIOEESSTIS (CR52 CPUO, CR52 CPU1) (CR52 CPUO, CASS5 Core0)
Primary Secondary Primary Secondary
Board RSK+RZXXX (RAM execution without flash memory)
or RZXXX Evaluation Board (RAM execution without flash memory)
Core CR52 Oor CR52 0or CR52 | CR52 1or CR52 | CR52 CPUO CAS5S Core0
CR52 CPUO | CPUO CPU1
IDE Project | IAR EWARM (FSP SC is older than 2024-04 version)
Type or AR EWARM [v9.40+] (FSP SC is 2024-04 version)
or JAR EWARM [v9.60+] (FSP SC is equal to or newer than 2024-10 version)

€ New Renesas RZ/T Project a X

New Renesas RZ/T Project

Device and Tools Selection

Device Selection

Board Description
RZT2H Evaluation Board (RAM execution without flash memory)

FSP Version: |<FSP Version> Wi

Board: ‘RZ‘IZH Evaluation Board (RAM execution wit v ‘

Device: RIAOSGOTTMAMGEG

| Core: CRs2 CPUO ~|  Device Details

language.  @C O+ TrustZone No
Pins 729
Processor Cortex-R52

DE Project Type

[1aR EWARM [va.20+] ]

Toclchains

[ AR Toolchain for ARM ‘

<Back Next > Finist Cancel

Figure 55 : Target Device and IDE Selections

(Continued on next page)
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9.  (The secondary project of multiprocessing ONLY) Select a bundle file of the primary project. Built the primary
project names in the same workspace appear as an option in the drop-down list.

Note:

Warnings occur if the FSP version or Board (boot mode) used is different between the primary project and the
secondary project. Use the FSP same version and Board (boot mode).

'3 New Renesas RZ/T Project

New Renesas RZ/T Project

Existing Smart Bundle Selection

Smart Bundle: |

¥Blinky_primary¥Debug¥Exe¥Blinky primary.cbd I EBmwse.‘I

Smart Bundle Details

Select a Smart Bundle (*.sbd) file describing the configuration of the preceding processor core.

FSP version
Toclchain
Toolchain version
Board

Device

Core

Zones

<FSP Version=
IAR Toolchain for ARM

<Board (boot mode)s
RIACSGOTTMA4GEG
CRs2_0
CRs2_0

(Continued on next page)

Figure 56 Bundle File Selection
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10. Select RTOS.

e  Here, select No RTOS for proceeding the following tutorial.

11. Click Next.

6 New Renesas RZ/T Project

New Renesas RZ/T Project
RTOS Selection

RTOS Selection
No RTOS

T

Cancel

(Continued on next page)

Figure 57 : RTOS Selection
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12. Select a project template from the list of available templates.
e By default, this screen shows the templates that are included in your current RZ/T MPU Pack.
e  Here, select Bare Metal — Blinky for proceeding the following tutorial.

»  If you want to develop your own application, select the basic template for your board, Bare Metal —
Minimal.

13. Click Finish.

G New Renesas RZ/T Project o X

New Renesas RZ/T Project

Project Template Selection

Project Template Selection

@® d " Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and
the C runtime environment.

[Renesas.RZT.  .pack]

o d " Bare Metal - Minimal
W Bare metal FSP project that includes BSR This project will initialize clocks, pins, stacks, and the C runtime environment.
[Renesas.RZT.  .pack]

Finish Cancel

Figure S8 : Template Selection

14. Configure the FSP configuration by referring to Chapter 6.3 “Configuring a Project”.

e  Here, skips this configuration step for proceeding the following tutorial.

(Continued on next page)
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Note for the primary project using CR52 CPU0:

If the primary project selects CR52 CPUO as Core and the secondary or later project uses a CA55 core, you
need to set "PLLO is released from standby state" and enable PLLO in the Clocks tab of FSP Configuration.

[ 7] ¥Blinky_primary - FSP Smart Configurator
File Window Kun Help
&} ~[Blinky_primary] FSP Configuration X =g

Clocks Configuration
9 Generate Project Content

PLLOis released from s v PLLO 1200MHz > CASSCOCLK 600MHz  ~
PLLO s standby state |
s relcased from standby stote | JEEAY +| “/PLLOSSC Disabled | | CASSCICLK600MHz  ~

CLMAQ error not mask MMF: 111.7kHz ~ [+ CASSC2(LK 600MHz

7 Restore Defaults

Main Clock: 25MHz 1 "

MRR: 1 ~ > CASSC3CLK 600MHz  ~

Modulation rate: 0%

P> PLL1 1000MHz CASSSCLK S00MHz
CLMA1 Enabled v }> CRS2COCLE S00MHz
CLMA1 error not mask ~ | CRS2CICLK S00MHz  ~
11 ETCLKA 200MHz
2] ETCLKB 125MHz
v
< >

Summary | BSP | Clocks | Pins | Interrupts | Event Links| Stacks| Compenents.

Figure 59 : Enable PLLO in the Primary Project using CRS52 CPU0

15. On completion of the FSP configuration, click Generate Project Content.

{8% [Blinky] FSP Configuration X - o

Summar o
y Generate Project Content

Project Summary
RENESAS

Board: RSK+RZT2M (RAM executicn without flash memory)

Device: R9A07G075M24GBG

FSP Version: <FSP Version>

Project Type: Flat

Location: C:/Users/ IBlinky 4|

Figure 60 : FSP Project Configuration and Generation

A new IAR EWARM project file will be generated in the project path.

(Continued on next page)
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16. Double click IAR EWARM Workspace file (.eww) to open IAR EWARM with workspace.

script
src
|| .api_xml
|| .secure_azone
j .secure_xml
Blinky.ewd
Blinky.ewp

Blinky.eww

Figure 61 : FSP Project Workspace

5.3.2.1 NOTE: Configure IAR EWARM Project [RZ/T2H and RZ/N2H]

1. Change the device tag name of buildinfo.ipcf in the project and save it.

Table 13 FSP SC Newly Created Project Debug Settings

Device Single-core Multiprocessing Multiprocessing
NS processing (CR52 CPUO, CR52 CPU1) (CR52 CPUO, CAS5S5 Core0)
Primary Secondary Primary Secondary
RZ/T2H RY9A09G077 | RO9A09G077M44 | ROA09GO77M44_ | ROA09G077M44 | ROA09GO77M44
M44 R52 0 | R52 0 R52 1 _R52 0 _ASS
RZ/N2H RY9A09G087 | ROA09GO87M44 | ROA09GO87M44_ | ROA09G087M44 | ROA09GO8TM44
M44 R52 0 | R52 0 R52 1 _R52 0 _ASS

> Blinky_primary - Master - IAR Embedded Workbench IDE - Arm 9.60.2
File Edit View Project Ijet Tools Window Help

NORS e LB LLD.C BN N N oo |
Workspace ¥ & X | buildinfo.ipcf x
|Dehug V‘

1 <?xml version="1.8" encoding="UTF-8" standalone="yes"?>
Files o 2 <iarProjectConnection version="1.8" name="Flex Software”>

S @ Blinky_primary - ... ¥ & <deyices
- — / 2
i Flex Software 4 I<name>R9ABQG@77M44 R52_@</ nawe>|

— = 5 </device>
el buildinfo.ipcf e AinkerFiles
T <override>true</override>
8 <path>$PROI_DIR$/script/fsp_ram_execution.icf</path>
9 </linkerfile>

Figure 62 : IAR EWARM Project File (CR52)

> Blinky_secondary - IAR Embedded Workbench IDE - Arm 9.60.2
File Edit View Project Ijet Tools Window Help

: o+ ¢ = 1
PR = Db LD e J Qo ez B RALE
Workspace ¥ & X | puildinfo.ipcf X
|Debug V|
r 1 <?xml version="1.8" encoding="UTF-8" standalone="yes"?>
Files & 2 <iarProjectConnection version="1.8" name="Flex Software">
B @ Blinky_secondar... v 3 <deyicey
|—El o Flex Software 4 I<name>R9ABQGQ77M44 AS55</name> |
— = 5 </device>
[ /
B buildinfo.ipcf z <linkerFiles
7 <override>true</override>
8 <path>3PROJ_DIRS/script/fsp_ram_execution.icf</path>
o </linkerFile>
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Figure 63 : IAR EWARM Project File (CASS)

2. Click on Project and then click on Option... to open project option window.
3. Seclect General Options category and Target tab.

4. Confirm that the name changed in step 1 appears in the device of Processor variant.

Options for node "Blinky_primary™

Category:

Static Analysis
Runtime Chedking
C/C++ Compiler Library Configuration Library Options 1
Assembler 32-bit
Output Converter
Custom Build
Linker (O Core Cortex-R52
Build Actions
(@ Device Renesas RGA0SGO77M44_R52_0 I o,
Debugger I
Simulator
CADI
CMSIS DAP
E2/E2Lite Execution mode
GDB Server
GHINK
Iget
JLink/)-Trace
T1 Stellaris
Nu-Link
PE micro

Library Options 2
64-bit Output
Processor variant

(O CMsIS-Pack None

Cancel

Figure 64 : Project Options — Device (CRS2 CPU0)

Optiens for node "Blinky_secondary”

Category:

General Options ~

Static Analysis
Runtime Checking
CJC++ Compiler Library Configuration
QOutput Converter
Custom Build
Linker (O Core Cortex-AS5
o hatens I@ Device Renesas RIAOSGOTTM44_ASS T
Debugger =
Simulator
CADI
CMSIS DAP
E2/E2Lite Execution mode
GDB Server
GHINK
Ijet
J4ink/)-Trace
TI Stellaris
Nu-Link

PE micro
v

Library Options 1 Library Options 2
&4-bit Output
Processor variant

O CMSIs-Pack None

32-bit
64-bit

Carce

Figure 65 : Project Options — Device (CASS)

(Continued on next page)
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Note:

After changing the FSP configuration and clicking “Generate Project Content” in FSP SC, the contents of
buildinfo.ipcf will be overwritten and the device name reverts to its pre-modified name. This will result in an
error message when the project is re-opened in IAR EWARM, but the setting of project options in step 4 is
maintained and do not need to be modified again in buildinfo.ipcf. Please build the project as is.

Build

Massages

#3 Unknown device name: 'ROAGIGE77MA4_CRS2_@'
#2% Unknown device name: "R9AGIGET7M44_CRS2_@°

Build Debug Log

5.

Figure 66 : Error Message after Configuration Change

Select Build Actions category and then Remove "Pre-compile" row

Options for node “Blinky_primary™

Category

General Options s

Static Analysis

Runtime Checking
C/C++ Compiler Build Actions Configuration
Assembler

Output Converter Sul aclons

Custom Build Command line Build order  Output file(s)
Uinker

omd /c "start "Renesas” /w omd /c "$P... Pre-compie SBUILD_FIL
omd /c "start "Renesas” /w omd /c ™$P... Postdink $SBUILD_FIL

J-Link/)-Trace

TI Stellaris

Nu-Link Now Edx
PE micro

ST-LUNK

Third-Party Driver

TI MSP-FET -

Remove

0K | Cancel

Figure 67 : Project Options — Build Actions
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5.3.3 Build the Project

When multiprocessing, please refer to Section 5.3.3.2 Build for Multiprocessing.

5.3.3.1 Build

*  Single-core processing
Click on Project -> Make from menu bar or Make button on tool bar to build.

*  Multiprocessing
Build both the primary and secondary projects.
Click on Project -> Rebuild All from menu bar.

File Edit View w ljet Tools Window Help

i 02 Q@ [& AddFies...

Workspace [e Add Group...
" 4 ile List...
D [*] import File List.
Add Project Connection...
Edit Configurations...

Files
E) @ Blinky - Debu
M Flex Softw % | Remove
D buildinfo.
] Output D Create New Project...
?® Add Existing Project...

£ Options... Alt-F7
Version Control System »
0 Make F7
B  compile Ctrl+F7
@ Rebuild All
& Clean
& Batch build... F8
(C-STAT Static Analysis »
| Binky € stop Build Ctri+Break
Figure 68 : Make Button
Build v o x
Messages File Line (&

50% Generating Secure Bundle100% Generating Secure Bundle

Total number of errors: 0
Total number of warnings: 0

Build succeeded v‘

Build Debug Log
Ready Errors 0, Warnings 0 Ln 149, Col 5 System CAP NUM OVR BEEE

Figure 69 : Build Message Console

Once the build is completed, the build message is displayed in the Build Console window that displays compilation
target files and the number of error/warnings.
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5.3.3.2 Build for Multiprocessing

For multiprocessing, note the build order and build settings. If the step is preceded by (XXX), it is executed only if the
condition is met.

(CR52): The core used in the project is CR52.
(CA5S5): The core used in the project is CASS.

1. Create and build the primary project. (1st build of the primary project)
Set the following before building:

. Click Project > Options....

> Blinky_primary - Master - IAR Embedded Workbench IDE - Arm 9.60.2
File Edit View ljet Tools Window Help

A B @ (e AddFies. Ol
Workspace [e Add Group...
[41 import File List..
Debug
4 Add Project Connection... E"1.8" encoding="UTF-8"
Files Edit Configurations... nection version="1.8" n
=L IBlinky_pri ;
|2 B Flex Sof] | Add CMakeLists.txt to Project [EIAPI0G IS TS 7R a0
o & buildinfo Configure Project les
Force Reconfiguration [ide>true</override>
$PROJ_DIR$/script/fsp_r
Add CMake Connector PEle>
flons>
X Remove L "$PROJ_DIR$/xcl/rasc_
fions>
Q) create New Project... Lraoptions>
(’ Add Existing Project... tf "$PROJ_DIR$/xcl/rasc_
ctraOptions>
| # options.. AitsF7 [tryPoint>
1>system_init</symbol>
Version Control System » EntryPoint>
Evars>

Figure 70 IAR EWARM Project Options

il. Click Debugger > Setup and uncheck “Run to".

Options for node "

Category:

Factory Settings
General Options A

Static Analysis
R'c‘;::‘iccﬂ? Download | Images | Multicore | Authentication | Extra Options | Plugins
Assembler
Output Converter Driver
Custom Build I-jet -
Linker
Buid Actions Setup macros

[0 Use macro file(s)
Simulator
CADI
CMSIS DAP
E2fE2 Lite
GDB Server
GHING
et [ Querride default
JHink/J-Trace STOOLKIT_DIR$¥config¥debugger¥Renesa:
T Stellaris =

Nu-link
PE micro

mair

Device description file

o

Figure 71 TAR EWARM Project Options for the Primary Project (Run to)
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ii. (CA5S5) Click I-jet > Interface, select From file in Probe config and select core in CPU of Probe
Configuration file.

Options for node X
|

Category: Factory Settings
General Options ~

Static Analyss

Runtime Cheding

e seu [meroce s

Assembler Probe config Probe configuration file

Output Converter O Auto [ Qvenide default

Custom Build = S confiald

= o o e

Debugger

Smator Interface Explicit probe configuration

capt O[1AG

CMsIS DAP -

E2E2Lite @ swo

GDB Server TA

m Interface speed

¥ -race =

71 Stellaris Auto detect v
Nutink
PEmao

v
oK Cancel

Figure 72 TAR EWARM Project Options for the Primary Project (I-jet Interface)

iv. (CASS5) Select General Options > 64-bit and select LP64 of Data model.

Options for node "

Category:

General Options A
Static Analysis
Runtime Checking ;

CJC++ Compler Library Configuration

Library Options 1 Library Options 2

Qutput Converter Data model

Custom Buid

Linker (O ILP32 (32-bit int, long, pointer)

Buid Actions

@ 1LP64 (32-bit int, 64-bit long, pointer)

Debugger
Simulator
CADI
CMSIS DAP
E2/E2 Lite
GDB Server
Tjet
I-Link/J-Trace

TI Stellaris

Nu-Link

PE miao

STLINK

v
L -

Cancel

Figure 73 : Project Options — Data Model

V. Proceed to 5.3.3.1 Build.

(Continued on next page)
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2. Create the secondary project. Change the project options setting and build it.

. Click Project > Options....
il. Click Debugger > Setup and uncheck “Run to".
iii.

Click Debugger > Extra Options and add "--macro_param cpul enable=1" to Command line options:
(one per line).

Options for node "Blinky_secondary”

Category

Factory Settings
General Options ~
Static Analysis
Runtime Chedking -
Clc++ Compler Setup Download Images Multicore Aumenncamnplugms
Assembler 5 oy
Output Converter [Aise command line options
Custom Build
Linker
Buld Acions --drv reset to cpu start
[Fmecre poram por.eralie=t ]
Simulatar
CADI
CMSIS DAP
E2/E2 Lite
GDS Server
GHINK

Command line options: (one per line)

Let
Jink/)-Trace
I Stelaris
Nu-ink

PE micro

oK Cancel

Figure 74 TAR EWARM Project Options for the Secondary Project (Debugger Extra Options)

iv. Click I-jet > Setup and select Software as Reset.

Options for node "Blinky_secondary”

Categary:

Factory Settings
General Options ~
Static Analysis
Runtime Checking
Sett i
C/c++ Compler Interface  Trace  Breakpoints
Assembler
Output Converter I Software VI
Custom Build
Linker
Build Actions
Debugger
Simulator
CADI Target power
CMSIS DAP
ZEJ:;IE (® Leave on after debugging
rver
GHINK (O Switch off after debugging
Ijet
Hink{3 Trace [ Log communication
T1 Stellaris

Reset

Override timing

Emulater

Always prompt for probe
[ From the probe lewm

Serial not

Nu-Link $PROJ_DIRS¥
PE micro

Cancel

Figure 75 TAR EWARM Project Options for the Secondary Project (Reset)

(Continued on next page)
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v. (CASS) Click I-jet > Interface, select from file in Probe config and select core in CPU of Probe
Configuration file.

vi. (CAS55) Select General Options > 64-bit and select LP64 of Data model.

Vil. Proceed to 5.3.3.1 Build.
viil. Close the secondary project.

3. Build the primary project. (2nd build of the primary project)

No setting is required, proceed to 5.3.3.1 Build.

5.3.4 Download & Debug the Project

When multiprocessing, please refer to Section.5.3.5 Debug for Multiprocessing

Note:

The main chapter of this documentation describes a RAM execution without flash memory project. When
debugging a project with flash boot mode, please also refer to Appendix. How to Debug FSP Project with
Flash Boot Mode.

Click on Project -> Download and debug from menu bar or Download and Debug button on tool bar to download

and debug.

File Edit View

Files

e
s
0]

|Project | Ijet Tools Window Help

Add Files...

Add Group...

Import File List...

Add Project Connection...
Edit Configurations...

E @ Blinky - Debu
B Flex Softw
D buitdinfo.

L@ s output

X | Remove

) Create New Project...
™® Add Existing Project...

&

Options...
Version Control System

Make
Compile
Rebuild All
Clean

Batch build...

C-STAT Static Analysis

Stop Build

Ctrl+Break

D d and Debug

Messages
r_ioport.c
system.c
Linking

Total number
Total number

<

vector_data.c

Ctri<D

Build Debug Log

Debug without Downloading
Attach to Running Target
Make & Restart Debugger
Restart Debugger

Download
SFR Setup

CMSIS-Pack Manager
Open Device Description File
Save List of Registers...

Ctrl+R
Ctrl+Shift+R

»

Errors 0, Warnings 0

Ln 250, Col 29

System CAP NUM tEF =

Figure 76 : Download and Debug Button

(Continued on next page)
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Once the download is completed and the debug is started, the program breaks at the beginning of main in main.c.

File Edit View Project Debug Disassembly Ijet Tools Window Help
DoR@ = XKD DC 24 Q252 B >[N A0 6c0 030 B:om.: P
Workspace v 2 X | maine x + | Disassembly v o x
Debug « |main) fo| Goto:]
1 /* generated main source file - do not edit %/ ==
Files o 2 swinclude "hal_data.h” Disassembly
B @ Biinky - Debug v ||®38 int main(void) { ?2DataTabled_S
B Flex Software 4 hal_entry(); Ox6ec: ©x0004'0000 o
D builginfo.ipef : ) PR 85 ??DataTabled_6
W output 5 ex6fo: oxses’lale D
??DataTabled_7
ox6f4: @x8128'1a00 D
??DataTabled_§
ox6f8: @x0000'0874 D
??DataTabled_9
ex6fc: @x0e0e’ 0360 o
??DataTabled_1
©x700: 0x0004' 0004 D
__dar_init_vfp
ex7e4: exeell'efse M
©ox708: @xe3se'esfe ]
©x708c: Oxeedl'efse L]
©x710: @xe3ad’' 001 L]
©x714: @xeed7'@f9s L
_dar_init_vfp
Bx718: @xe3a20'0440 M
©x71c: @xeeeB'@ale v
©0x720: @xe3ad’'0780 L]
©x724: @xeeel'@ale Vi
©0x728: Oxel2f'ffle B
int main(void) {
main:
. exrciexbsse P
hal_entry();
Sy % e Ov7Ims OvF7EF BvEfoa )n h

Figure 77 : Starting Debug

Click on Debug->Go from menu bar or Go button on tool bar to run this program.

File Edit View Project | Debu Disassembly |-jet Tools Window Help
DO M@ = X Go ' 1L Q > 52 B ORNP A= 6cOinF el -0
Workspace O Breal w | Disassembly
Doty  Reset fo| coto:
nerated main source file - do not edit */
Files o R Detivaohn ude “hal_data.h"™ & Disassembly =l
B @ Blinky - Debug N Fi int main(void) { ??DataTabled_5
|- 4 Flex Software Hep Over o hal_entry(); Oxbec: 0x0004'0000 D
— Dlbuildinfo.ipct 7 stepinto Fi1 ) oetnn 0 22DataTabled_6
L= i output r*  Step Out ShiftF11 ex6fe: 9*‘:3“'15191 D
. ?2DataTabled_7
| Mot Statement ex6f4: @x8128'1a080 D
*]  Runto Cursor ??DataTable4_8
B Avtosico.. ex6f3: 0x0000'8574 D
??DataTabled 9
= Set Next Statement ox6fc: Ox0000'0860 D
22DataTabled_1
ks Elteption " 0x700: 0x0004'0004 D
iar_init_vfp
» —dar_init_vfp
oo ex704: oxeell'efse M
Refresh ©@x708: @xe380'esfe o
Loggi N ox78c: @xeedl'efse M
- I - ©ex710: exe3ad'eeel M
Bx714: Bxeed7'@f9s M
__dar_init_vfp
0x718: @xe3a0'0440 M
@x71c: @xeee8'@ald Vi
| ©x720: @xe3a@’'0780 M
©x724: @xeeel'@Gal® v
©x728: @xel2f'ffle B
int main(void)
main:
hal_entry();
- oav7dar OvFIFF avifaa A Y
Blinky < > ||| ¢ >

Figure 78 : Go Button
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The blinky application is stored in the hal_entry.c file. This file is generated by FSP SC when you select the Blinky
Project template and is located in the project’s src/ folder. In IAR EWARM workspace view, the hal_entry.c is

registered Flex Software > Program Entry.

The application performs the following steps:

1. Get the LED information for the selected board by bsp_leds_t structure.
2. Initialize output level for LED pin to LOW using R_BSP_PinClear((bsp_io_region_t) leds.p_leds]i][1],

(bsp_io_port_pin_t) leds.p_leds][i][0]).

3. Use R_BSP_PinToggle ((bsp_io_region_t) leds.p_leds][i][1], (bsp_io_port pin_t) leds.p_leds[i][0]) to set the

output level to the LED pin.

4. R_BSP_SoftwareDelay(delay, bsp_delay_units) waits for a certain period of time. Then run #3 again.

On debugging on IAR EWARM, the break point can be set by click the left space next to line number.

[Eile | Edit View Projet Debug Disassembly ljet Tools Window Help

DDR@ = XE0 2C 24 Q> K< 0 >N DOE6GcO IO i B
Workspace ¥ B X | mainc  hal_entry.c X w  Disassembly v o Xx
Debug . |hal_entry[)::bsp_delay_units 0| Goto:
22 ~ N
Files ] 23 void R_BSP_WarmStart(bsp_warm_start_event_t event); Disassembly
E @ Blinky - Debug < 24 @x654: @x6813 U
|2 8 Fiex Software 25  extern bsp_leds_t g_bsp_leds; Ox656: 0x4018 A
| Bl Build Configuration §$ [ /39sssssssnsnsssnsssasssssnsssssssssssssssssssssssssssssssssnsssnsnssssssss ex658: Oxfa5e @xd02s O
| |- W components 28 ‘ » @brief BLinky example opplication SticL Bxpalel =
| @ o Generated Data 29 . S ELRR A T T
| Lad 22R_BSP_PinAcc
| La @hal T l ©ox6Se: ©xee@d exifle M
t— Dbuicinfo.iper 33 [void hal_entry (void) ex662: 0x4770 8
M Output 33 gf¢ Sy oid
35 /* Define the units to be used with the softwore delay function */ s =
E 36 ‘ const bsp_delay_units_t
37 hal_entry:
38 /* Set the blLink frequency (must be <= bsp_delay_units =/ 0x664: @xbs7c P
39 const uint32_t freq_in_hz = 2; i
a0
a1 | /* Calculate the delay in terms of bsp_delay_units */ o
:; : const uint32_t delay = bsp_delay_units / freq_in_hz; Ox66a: Ox2002
44 /* LED type structure */ UAMEIZX aeslay, = 0sp
45 : bsp_leds_t leds = g_bsp_leds; x6éc: @xfbb4 Oxfsfe U
|| - vwe4eemee oo Il is_t leds = g_bsp_led
47 | /* If this board has no LEDS then trap here */ ox670: @x4821 L
48 | if (@ == leds.led_count) ex672: exe9de ex23ee L
49 ¢ . @x676: @xedcd @x2300 S
50 | while (1) et oy
Ba T { P — - o @x67a: exfebd @x6eee L
53 } N ox67e: @x2800 a
54 ¥ ex680: @xd100 B
| 55 | hile (1 .
ce | 2%hal w 1.
[Biky < = a1 entry 1

Figure 79 : hal_entry.c and Setting Breakpoint
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By using the break point and the Debug menu or Debug tool bar, you can check the behavior of the Blinky application
step by step.

File Edit View Project | Debug | Disassembly ljet Tools Window Help
DO R@ & % e s 2K Q25BN AO=60colnar i 0  lm
Workspace Break ftry.c x ~  Disassembly v QX
M Reset sp_delay_units | Goto:
Debug
© stop Debugging (o D bi A
Files d R_BSP_WarmStart(bsp_warm_start_event_t event); isassembly
E @ Blinky - Debug N @x654: @x6813 u
= F1 :
|6 B Fiex Software Step Over 0 fern bsp_leds_t g_bsp_leds; OxE56: 0x4018 A
| H@ i suild configuratf ¥ | Stepnto L 0x658: @xf45@ @x4025 O
I }-@ i components | P stepout shiftsF11 labrief BLinky example application _ oxtSc: ex6o10 s
|-@ i Generated Data | 43 ext statement —SEINENAT ! Vo) NBAWE 5 Ss
=1 . BLinks oLl Leds ot a rate of 1 second using the software deLay function 22R_BSP_PinAcc
I Program Entry
|  Le e *1 | Runto cursor Ox6Se: @xeedd Ox1f16 M
L N sssssssssssssnssssananns sssssssssssssssssssssssssssnssns
[= Bousanto ipet e @ hal_entry (void) ox662: B8x4778 8
B Output S Set Next Statement void hal_ent oid
/* Define the units to be used with the software delay function */ <
C++ Exceptions »|| const bsp_delay_units_t helientry:
Memory »| 7* Set the blink frequency (must be <= bsp_delay_units */ x664: .ai‘hsk P
const uint32_t freq_in_hz = 2; st bsp_delay units_t
Refresh ®
T /* Calculate the delay in terms of bsp_delay_units */
99ing const uint32_t delay = bsp_delay_units / freq_in_hz;
43 t dela ")
4a /* LED type structure */ e Ly
as bsp_leds_t leds = g_bsp_leds; xfbbd oxfsfe
46 leds = g_bsp_led
47 /* If this boord has no LEDs then trap here */ ex678: ex4821 u
48 | if (8 == leds.led_count) @x672: @xe9de Ox2300 L
49 & € 0x676: @xedcd @x2300 S
sai while (1) e e e oy
51 leds.led
52 3 // There are no LEDs on this board @x67a: @xfsbd 0x6000 L
=3 " ex67e: @x2800 a
54 ¥ 0x680: @xd100 B
55 shile (1 G
ze. | e — 33hal antrw 1-
Biinky < > vl +

Figure 80 : Debug Menu

When clinking Go button, the following LEDs on the board should now be blinking.
e RZ/T series

» RSK+RZ/T2M: LEDO-1 (CPUO), LED2-3 (CPU1)

» RSK+RZ/T2L: LEDO-6 (including LEDx ESC xxx)

» RSK+RZ/T2ME: LEDO-1 (CPU0), LED2-3 (CPU1)

»  RZ/T2H Evaluation Board: LEDO (CR52 CPU0), LED1 (CR52 CPU1), LED2 (CA55 Core0)
e RZ/N series

» RSK+RZ/N2L: LEDO0-3
»  RZ/N2H Evaluation Board: LED3 (CR52 CPUO), LED4 (CR52 CPU1), LED8 (CA55 CPUO0)

To suspend program execution, click Debug > Break or click on the Pause icon.

Figure 81 IAR EWARM Debugger Pause Icon

(Continued on next page)
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To exit Debug and disconnect from the debugger, click Debug > Stop Debugging or click on the Stop icon.

O

Figure 82 IAR EWARM Debugger Stop Icon

5.3.5 Debug for Multiprocessing
To debug the Blinky application of multiprocessing, follow these steps:
1. Open the primary project and close the secondary project on TAR EWARM.
2. Set the following in the primary project before debugging:
i. Click Project > Options....
ii.  Click Debugger > Multicore and check the setting value of Symmetric multicore and set the following
contents in Asymmetric multicore.
. Symmetric multicore
»  Number of cores: 1
e  Asymmetric multicore
»  Simple

< Partner workspace: $PROJ_DIRS\..\[the secondary project name]\[the secondary project
namel.eww

<~ Partner project: [the secondary project name]
<> Partner configuration: Debug

Options for node "Blinky_primary" X
BB Facton Setings
General Options ~
Static Analysis
Runtime Checking =

Multicore i i
Clc++ Compler Setup  Download Irnages Authentication Extra Options Plugins
Aosembler Symmetric multicore
Output Converter
Custom Buid Number of cores: E
Linker A . 6
Build Actions symmetric multicore
T O Disabled
Simulator -
— @ simple
CMSIS DAP Partner workspace: $PROJ_DIR$¥. ¥Blinky_secondary¥Blinky.
E2F2Lite Partner project: Blinky_secondary
GDB Server
GHINK Partner configuration: | Debug
Lyet [J Attach pariner to running target Partner cores: |1
J-Link/1-Trace
TI Stellaris [J Override partner debugger location
Nu-Link
PE mico
PR ~ O Adyanced
oK Cancel

Figure 83 TAR EWARM Project Options for the Primary Project (Multicore)
1il. Click OK and close Options window.

(Continued on next page)
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3. Download of the primary project with procedure 5.3.4 Download & Debug the Project as shown in Figure 76.

The secondary project is automatically launched. Once the download is completed and the debug is started, the
program breaks at the beginning of system_init in startup_core.c.

5. Run the program of primary project as shown in Figure 78 to copy the binaries of the secondary and subsequent
projects to the internal RAM in the primary project. After the primary project reaches hal_entry in main.c, another
core is executed. If the LEDs are blinking, proceed to the next step.

The primary project in operation, run the program of secondary project.

7. When exiting Debug and disconnect from the debugger, if debugging is stopped in one of the projects, either the
primary or the secondary, the other will automatically stop as well.

When changing the project and debugging it again, refer No. 13 in the Appendix. How to Create and Debug FSP
Projects for Multiprocessing in All Cases for AR EWARM.

5.4 Re-configuring Project with FSP SC

For proceeding the tutorial with Blinky project, the FSP configuration steps of the Blinky project was skipped in this
chapter. The FSP SC can be launched from IAR EWARM or command prompt, and the FSP project configuration can
be re-configured by FSP SC.

There are two ways to launch FSP Smart Configurator with an exciting project.

5.4.1 Launch FSP Smart Configurator from IAR EWARM

1. Select “Tools -> Configure Tools...”
2. Select “New” and fill in the fields as follows:

e  Menu Text FSP Smart Configurator
e  Command $RASC EXE PATHS
e  Argument --compiler IAR configuration.xml

e Initial Directory $PROJ DIRS

Configure Tools

Cancel

Mew

Delete

Menu Text

‘FSF‘ Smart Canfigurator |

LCommand:
[SRASC_EXE_PATHS || Browss.

Argument;

‘--compi\er |1&F configuration. xml |

Initial Directory
‘$PF\ 0J_DIR$ |

] Redirect to Output Window
[ Prompt for Cammand Line

Tool Available:

Always ~

Figure 84 : Settings to Launch FSP SC from IAR EWARM
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5.4.2 Launch from the Command Prompt

1. Open command prompt window.

2.  Move to the folder where the created project is located.
3. Execute the following command.

o  {FSP Smart Configurator installation folder} \ eclipse \ rasc.exe —compiler IAR configuration.xml

5.5 Note when debugging in different workspaces

The project created, built, and debugged in chapters 5.3.2 through 5.3.5 can be run in other workspaces. When
debugging in the other workspace, please note the following two points:

e Apply the same version of FSP package used for the project to the FSP SC.
o The project must be clicked the Generate Project Content button and built before debugging.
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6. FSP Configuration Users Guide

6.1 What is a Project?

In €? studio, all FSP applications are organized in RZ/T2, RZ/N2 MPU projects. Setting up an RZ/T2, RZ/N2 MPU
project involves:

1. Create a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects already, after you launch
¢? studio and select a workspace, all projects previously saved in the selected workspace are loaded and displayed in the
Project Explorer window. Each project has an associated configuration file named configuration.xml, which is located
in the project’s root directory.

57 Project Explorer X = 8

i
X5

» == Blinky [Debug]
i Includes
B

2 rzt_gen

8 src

(= Debug

(= rzt_cfg

(= script

\X] Blinky Debug_Flat.launch
], configuration.xml

= rzt_cfg.txt

Figure 85 : e’ studio Project Configuration File

Double-click on the configuration.xml file to open the RZ/T2, RZ/N2 MPU Project Editor. To edit the project
configuration, make sure that the FSP Configuration perspective is selected in the upper right-hand corner of the ¢?
studio window. Once selected, you can use the editor to view or modify the configuration settings associated with this
project.

[ | @ c/c++ [i& Fsp Configuration

Figure 86 : e? studio FSP Configuration Perspective

(Continued on next page)
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Note:

Whenever the RZ/T2, RZ/N2 project configuration (that is, the configuration.xml file) is saved after
configuring the project, a verbose RZ/T2, RZ/N2 Project Report file (rzt cfg.txt, or rzn_cfg.txt) with all the
project settings is generated. The format allows differences to be easily viewed using a text comparison tool.

The generated file is located in the project root directory.

{5 Project Explorer X = {5} *[Blinky] FSP Configuration [ mtcigt X
e T 3§ 1 [Fsp configuration
¥ (& Blinky [Debug] 3 R9AG7GO7SM24GEE
[l Includes 4 part_number: RIAGTGO7SM24GBG
Bm 5 atcm_size_bytes: 524288
8 rztgen 6 btem_size_bytes: 65536
2 src 7 system_ram_size_bytes: 2097152
Debs 8 package_style: BGA
(& Debug package_pins: 328
& mztcfy 10 Cortex-R52 CPU core: CPUD
& script 11 Semaphore: Enabled
%) Blinky Debug_Flatlaunch 12

13 RZT2M Memory Config

o] g i
configuration xm) Master HPU: MPUG : DMAC Unite:
Master MPU: MPU@ : DMAC Unit@:
16 Master MPU: MPU® : DMAC Unit@:
17 Master MPU: MPU@ : DMAC Unite:

Board "RSK+RZT2M (RAM execution without flash memory)”

Enable or disable read contrel for Region @: Disabled
Enable or disable write control for Region @: Disabled
Region @ Start: @x80020080

Region @ End: exeeeoecee

Figure 87 : RZ/T2, RZ/N2 Project Report

The RZ/T2, RZ/N2 Project Editor has several tabs. The configuration steps and options for individual tabs are discussed

in the following sections.

Note:

The tabs available in the RZ/T2, RZ/N2 Project Editor depend on the e? studio version and the layout may vary

slightly, however the functionality should be easy to follow.

45¢ [Blinky] FSP Configuration X

Summary

Project Summary

Board: :
Device: I
Toolchain: !
Toolchain Version: :
FSP Version: 1
Project Type: :
Location: I

A
z
8.
[1°]
[a]
2
=
3
3
5
2
=
3
3
Q
=
o
=1
v

software s

Simple application that blinks an LED. No RTOS included
Board Support Package Common Files

Memeory Config Checking

110 Port

<Board>

Arm CMSIS Version 5 - Core

Board support package for <Device>

Board support package for RZT2M

Board support package for RZT2M - FSP Data

o|2[9)

ISumrnary BSP | Clocks | Pins | Interrupts | Event Links| Stacks Componen(sl

=]
Generate Project Content.

~
RENESAS

1
1
1
1
1
<Components version information> :
1
1
1
1
1

Figure 88 : RZ/T2, RZ/N2 Project Editor Tabs
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6.2 Create a Project
6.2.1 Creating a New Project

For RZ/T2, RZ/N2 MPU applications, generate a new project using the following steps:

1.  Click on File > New > Renesas C/C++ Project > Renesas RZ.

[} - ¢ studio

File Edit Source Refacter Navigate Search Project RenesasViews Run Window Help

| New

Alt+Shift+N > Renesas C/C++ Project >

Open File...
=2 Open Projects from File System...
Recent Files

Plamn Cdiban

™ Project...

Renesas Debug
Renesas RZ

I Example...

[ Other.. Ctrl+N

o2
pe3

BSP_DONT
BSP_PLAC

BSP_DONT
Rreo D1 Ar

Figure 89 : New RZ/T2, RZ/N2 MPU Project

2. Then click on the Renesas RZ/N C/C++ FSP Project or Renesas RZ/T C/C++ FSP Project template for the

type of project you are creating.

8 New C/C++ Project a
Templates for Renesas RZ Project
Renesas RZ/N C/C++ FSP Project
CC++ EEIN (reate an executable or static library (/C++ FSP
project for Renesas RZ/N.
Renesas RZ/T C/C++ FSP Project
FEZ==n (reate an executable or static library &/C++ FSP
project for Renesas RZ/T.
Renesas RZ/V C/C++ FSP Project
EEZ|n. (reate an executable or static library (/C++ FSP
project for Renesas RZ/V.
<
‘(?;‘ < Back Finish Cancel

Figure 90 : New Project Templates

(Continued on next page)
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3. Select a project name and location.
4.  Click Next.

& Renesas RZ/T C/C++ FSP Project [m] X

Renesas RZ/T C/C++ FSP Project —

Project Name and Location

Project name

|Blinky

Use default location

You can download more Renesas packs here

'?) < Back Finist Cancel

Figure 91 : RZ/T2, RZ/N2 MPU Project Generator (Part 1)

6.2.2 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.
2. Select the Board and Device for your application.

Note:

You can select an existing RZ/T2, RZ/N2 MPU Evaluation Kit (Such as RSK) or can select Custom User
Board for any of the RZ/T2, RZ/N2 MPU devices with your own BSP definition.

When you use the RZ/T2, RZ/N2 MPU Evaluation Kit,
e  First, please set the Board to the Evaluation Kit and the boot mode which you use.

e In this case, please don’t change the Device which is automatically set to the device which RSK board
uses.

When you use Custom User Board,
e  First, please set the Device to your device on your board.

e Second, please set the Board to Custom User Board with the boot mode which you use.
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Select the Core. You could select if you selected multicore device for Device.
Select the Toolchains.

Select the Toolchain version.

Select the Debugger. The J-Link Arm Debugger is preselected.
Click Next.

N kW

& Renesas RZ/T C/C++ FSP Project o b
Renesas RZ/T C/C++ FSP Project —
Device and Tools Selection
Device Selection
9 Verson: [T Voo ] | Eoertvscrwtion
RZT2H Evaluation Board (RAM execution without flash memory)
Board:  [RZT2H Evaluation Board (RAM execution witl | | ... |
Device: RIA0SGOTTMA4GEG .
—— Device Details
o R0 ]
TrustZone No
Language: @C OC++ Pins 729
Processor Conex-Rsz
Toolchains Debugger
GNU ARM Embedded )-Link ARM 4
GCC ARM A-Profile (AArch&4 bare-m netal)
=Toolchaln Varsions Manage Toolchains,
@ <Back Finish Gancel

Figure 92 : RZ/T2, RZ/N2 MPU Project Generator (Part 2)

If CR52 CPUO is not selected for the secondary project of multiprocessing in procedure 3, you need to select the
preceding project. To select the preceding project when creating the secondary project for multiprocessing, it is
required to prepare CR52 CPUO as the primary project before the secondary project creation.

@ Renesss RZ/T C/C++ FSP Project [a] x

Renesas RZ/T C/C-++ FSP Project
Preceding Project or Smart Bundle Selection

@ Preceding Project: | Blinky_primary

Choose this option if you have access to the project source code of the preceding processor core or security context

O Smart Bundle:

Preceding Project/Smart Bunde Details

ROAQIGIT7MH4GEG
Core CRS2.0
Zones CRs2.0

Figure 93 RZ/T2, RZ/N2 MPU Project Generator (Part 3)
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6.2.3 Selecting a Project Template
In the next window, select the build artifact and RTOS.

& Renesas RZ/T C/C+ + FSP Project

Renesas RZ/T C/C++ FSP Project
Build Artifact and RTOS Selection

Build Artifact Selection

@ Executable
® Project builds to an executable file

(O Static Library
* Project builds to a static library file

@ < Back

RTOS Selection
No RTOS

Einish

Cancel

Figure 94 : RZ/T2, RZ/N2 MPU Project Generator (Part 4)

In the next window, select a project template from the list of available templates. By default, this screen shows the
templates that are included in your current RZ/T2, RZ/N2 MPU Pack. Once you have selected the appropriate template,

click Finish.

Note:

If you want to develop your own application, select the basic template for your board, Bare Metal — Minimal.

@B Renesas RZ/T C/C++ FSP Project

Renesas RZ/T C/C++ FSP Project
Project Template Selection

Project Template Selection

Cl " Bare Metal - Blinky

the C runtime environment.
[RenesasRZT.  .pack]

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and

o d " Bare Metal - Minimal

[RenesasRZT.  .pack]

Code Generation Settings
[ Use Renesas Code Formatter

Bare metal FSP project that includes BSP This project will initialize clocks, pins, stacks, and the C runtime environm

ent.

Figure 95 : RZ/T2, RZ/N2 MPU Project Generator (Part S)
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When the project is created, e? studio displays a summary of the current project configuration in the RZ/T2, RZ/N2
MPU Project Editor.

¢ [Blinky] FSP Configuration X = g

Summar
y Generate Project Content

Project Summary A
_______________________ RENESAS
Board: : 1
Device: 1 :
Toolchain: ! N
Toolchain Version: : <Project summary information> !
FSP Version: 1 :
Project Type: : 1
Location: 1 1

Selected software components

Simple application that blinks an LED. No RTOS included 1 !
Board Support Package Common Files 1 :
Memory Config Checking : 1
1/0 Port | !
<Board> I <Components version information> :
Arm CMSIS Version 5 - Core H ]
Board support package for <Device> 1 :
Board support package for RZT2M : 1
Board support package for RZT2M - FSP Data 1 !

Q=0

ISumma[z BSP| Clocks| Pins | Interrupts | Event Links| Stacks Campmnen!sl

Figure 96 : RZ/T2, RZ/N2 MPU Project Editor and Available Editor Tabs

On the bottom of the RZ/T2, RZ/N2 MPU Project Editor view, you can find the tabs for configuring multiple aspects of
your project:

With the Summary tab, you can see all they key characteristics of the project: board, device, toolchain, and
more.

With the BSP tab, you can change board specific parameters from the initial project selection.

With the Clocks tab, you can configure the MPU clock settings for your project.

With the Pins tab, you can configure the electrical characteristics and functions of each port pin.

With the Interrupts tab, you can add new user events/interrupts.

With the Event Links tab, you can configure events used by the Event Link Controller.

With the Stacks tab, you can add and configure FSP modules. For each module selected in this tab, the
Properties window provides access to the configuration parameters, interrupt selections.

The Components tab provides an overview of the selected modules. Although you can also add drivers for
specific FSP releases and application sample code here, this tab is normally only used for reference.

6.2.4 Duplication of Resources

In the case of creating a project with a core other than CR52 CPUO on a multicore device, duplicate resources will be
grayed out or hidden in each tab of Configuration. For more details, see Configuration section of Flexible Software
Package Documentation (RZT, RZN) API Reference > BSP > MCU Board Support Package page.
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6.3 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the RZ/T2, RZ/N2
Configuration editor window. Importantly, the initial configuration of the MPU after reset and before any user code is
executed is set by the configuration settings in the BSP tab. When you select a project template during project creation,
e? studio configures default values that are appropriate for the associated board. You can change those default values as
needed. The following sections detail the process of configuring each of the project elements for each of the associated
tabs.

6.3.1 Summary Tab

{5¢ [Blinky] FSP Configuration X = 0

Summar:
Yy Generate Project Content

Project Summary A
________________________ RENESAS

Board: \ 1
Device: 1 !
Toolchain: I :
Toolchain Version: : <Project summary information> !
FSP Version: 1 :
Project Type: : 1
Location: I !

Solected softy

Simple application that blinks an LED. No RTOS included 1
Board Support Package Commeon Files 1
Memory Config Checking :
1/0 Port |
<Board> 1 <Components version information>
Arm CMSIS Version 5 - Core :
Board support package for <Device> 1
Board support package for RZT2M :
Board support package for RZT2M - FSP Data 1

OO

BSP Clocks| Pins| Interrupts| Event Links| Stacks | Components

Figure 97 : Configuration Summary Tab

The Summary tab, seen in the above figure, identifies all the key elements and components of a project. It shows the
target board, the device, toolchain and FSP version. Additionally, it provides a list of all the selected software
components and modules used by the project. This is a more convenient summary view when compared to the
Components tab.

RO1AN6434EJ0113 Rev.1.13 Page 75 of 160
Dec.23.24 RENESAS



RZ/T2, RZIN2

Getting Started with Flexible Software Package

6.3.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in the lower left of

the Project Configurations view as shown below.

Note:

If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.

5% [Blinky] FSP Configuration X

Board Support Package Configuration

Device Selection

FSP version: | <FSP Version>

Board: RSK+RZT2M (RAM execution without flash memory)
Device: R9A07GO75M24GBG

Core: CRs2.0

RTOS: No RTOS

Summary Clocks| Pins| Interrupts| Event Links| Stacks | Components
1 Properties X |[8 Problems| @ Smart Browser
RSK+RZT2M (RAM execution without flash memory)

Property

v R9A07GO75M24GBG
part_number
atcm_size_bytes
btcm_size_bytes
system_ram_size_bytes
package_style
package_pins
Cortex-R52 CPU core
Semaphore

Settings

o| ] [

Value

R9A0O7GO75SM24GBG
524268

65536

2097152

BGA

320

CPUO

Enabled

Generate Project Content

A
I3 Restore Defaults

Board Details

Renesas Starter Kit+ for RZ/T2M CPU Board (RAM execution
without flash memory)

Figure 98 : Configuration BSP Tab

The Properties view shows the configurable options available for the BSP. These can be changed as required. The BSP
is the FSP layer above the MPU hardware. 2 studio checks the entry fields to flag invalid entries. For example, only

valid numeric values can be entered for the stack size.
When you click the Generate Project Content button, the BSP configuration contents are written to:

o rzt_cfg/fsp_cfg/bsp/bsp cfg.h, or
e rzn_cfg/fsp _cfg/bsp/bsp cfg.h
This file is created if it does not already exist.

Warning:

Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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6.3.3 Configuring Clocks

The Clocks tab presents a graphical view of the MPU’s clock tree, allowing the various clock dividers and sources to be

modified.

ky] FSP G

Clocks Configuration

Main Clock: 2sMHz PLLO 2400MHz

L CLMAQ Enabled

CLMA3 Enabled

PLL1 is initial state i

!

PLL1 1000MHz —> CLMA1 Enabled

Ethemet Clock src: PLL v

ETHn_REFCLK 25MHz

LOCO Enabled ~ —> LOCO 240kHz —> CLMAZ Enabled
CLMAO CMPL 1
CLMA1CMPL 1
CLMA2 CMPL 1

CLMA3 CMPL 1

Pins | Interrupts | Event Links | Stacks | Components

Summary asp-

~ —> CLMAQ error not mask ~
~ E Alternative clock: LOC
CLMA3 error not mask

~ —= CLMA1 error mask ~

CLMAO CMPH 1.023k
CLMA1 CMPH 1.023k
CLMA2 CMPH 1.023k

CLMA3 CMPH 1.023k

ICLK 200MHz

[> PCLKCAN 40MHz 5

[> XSPI_CLKO 125MHz

[> XSPI_CLK1125MHz  ~

[ TCLK 100MHz

[ SCIOASYNCCLK: 96MH

[ SCITASYNCCLK: 96MH

[ SCI2ASYNCCLK: 96MH

(= SCI3ASYNCCLK: 96MH ~

Generate Project Content

E3 Restore Defaults

—>( PCLKGPTL 400MHz

> PCLKH 200MHz

> PCLKM 100MHz

> PCLKL 50MHz

[ PCLKADC 25MHz

[ CPUOCLK Mul x1 v
CPUOCLK 200MHz
[ CPUICLK Mul x1 v

CPU1CLK 200MHz

[ SCIMASYNCCLK: 96MH ~

[ SCISASYNCCLK: 96MH ~

[> SPIOASYNCCLK: 96MH v

[> SPIASYNCCLK: 96MH ~

[> SPI2ASYNCCLK: 96MH v

> SPI3ASYNCCLK: 96MH ~

> CKIO Div /4 v

CKIO 50MHz

Figure 99 : Configuration Clocks Tab

When you click the Generate Project Content button, the clock configuration contents are written to:

e 1zt gen/bsp clock cfg.h, or
e rzn gen/bsp clock cfg.h
This file will be created if it does not already exist.

Warning:

Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.

R0O1AN6434EJ0113 Rev.1.13
Dec.23.24

RENESAS

Page 77 of 160




RZ/T2, RZIN2 Getting Started with Flexible Software Package

6.3.4 Configuring Pins

The Pins tab provides flexible configuration of the MPU’s pins. As many pins are able to provide multiple functions,
they can be configured on a peripheral basis. For example, selecting a serial channel via the SCI peripheral offers
multiple options for the location of the receive and transmit pins for that module and channel. Once a pin is configured,
it is shown as green in the Package view.

Note:

If the Package view window is not open in €’ studio, select Window > Show View > Pin Configurator >
Package from the top menu bar to open it.

The Pins tab simplifies the configuration of large packages with highly multiplexed pins by highlighting errors and
presenting the options for each pin or for each peripheral. If you selected a project template for a specific board such as
RSK+RZT2M, some peripherals connected on the board are preselected.

{5¢ *[Blinky] FSP Configuration X S

Pin Configuration
g = Generate Project Content

Select Pin Configuration [} Export to CSV file %] Configure Pin Driver Warnings

[RsK=RZTM v] Manage ¢ Generate data: | g_bsp.pin_cfg

Pin Selection i= & = 1%  Pin Configuration #¥ Cycle Pin Group

[Type fler text | [ name Value Lock  Link
Pin Group Selection Mixed
Operation Mode Asynchronous mode

v Ports ~

v ¥ Peripherals e
v Connectivity:CANFD MNP i

Connectivity:ETHER_ESC CTsos v P162 o]
Connectivity:ETHER_ETH CTS_RTS0# None
v Connectivity:ETHER_ETHSW DEo None !
v Connectivity:ETHER_GMAC Jobo v P166 I P
Connectivity:1IC = one
v ¥ Connectivity:SCl
+ S0

scih

sCl2
v SCI3

SCl4

scis
Connectivity:SPI
Connectivity:USB_HS
Connectivity:XSPI
v DebugTAG/SWD
v Debug:TRACE
Delta sigmalF:DSMIF
EncoderlF-ENCIF
ExBus:BSC
InterruptiRQ Usage: In initial register value, when CCRO.TE bit is 0, and the terminal function is TXDn, the terminal outputs high impedance.
System:CGC
v System:SYSTEM

TRGADC v

Summary | BSP | Clocks[[Fins | Interrupts | Event Links | Stacks| Components

P

<

TXDo ¥ P165 . (=3

L s

Module name:  SCI0

<

Figure 100: Pin Configuration

(Continued on next page)
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The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another peripheral or I/O
function the pin will be shown as red in the package view and also with white cross in a red square in the Pin

Selection pane and Pin Configuration pane in the main Pins tab. The Pin Conflicts view provides a list of conflicts, so
conflicts can be quickly identified and fixed.

In the example shown below, port P162 is already used by the GPIO, and the attempt to connect this port to the Serial
Communications Interface (SCI) results in a dangling connection error. To fix this error, select another port from the
pin drop-down list or disable the GPIO in the Pin Selection pane on the left side of the tab.

Pin Confi ti
in Configuration Generate Project Content

Select Pin Configuration [y Export to CSVfile [F] Configure Pin Driver Warnings:

[RsK+RZT2M

Generate data: | g_bsp_pin_cfg

Pin Selection = [# [ l% Pin Configuration ~1 Cycle Pin Group

Name Value Lock  Link

Pin Group Selection Mixed
Operation Mode Asynchronous mode
v Input/Qutput
CTS02 @ P2 Al
CTS_RTSO0# None
DEO None

il RXDO ¥ P16._6 -l | = |

v P20 TXDO v P165 a =
v P21
v P22
v P23
v P24
¥ Other Pins
v @ Peripherals
¥ Connectivity:CANFD
Connectivity:ETHER_ESC
v Connectivity:ETHER_ETH
v Connectivity:ETHER_ETHSW
¥ Connectivity:ETHER_GMAC
v Connectivity:llC
v @ Connectivity:SCl
@ sco
scn
SC12 e

Pin Number

Summary | BSP [lockslnte.ruprs'svem Links| Stacks| Components

Module name:  5Clo
Usage: In initial register value, when CCRO.TE bit is 0, and the terminal function is TXDn, the terminal outputs high impedance.

Figure 101: Conflict Checker in Pin Configuration

(Continued on next page)

RO1AN6434EJ0113 Rev.1.13 Page 79 of 160
Dec.23.24 RENESAS




RZ/T2, RZIN2 Getting Started with Flexible Software Package

The pin configurator also shows a package view and the selected electrical or functional characteristics of each pin.

5 FSP Visualization X = 8
m /‘- /. »
T T IIIIITILI Y
® v[ 1+
290 9 00NVPPINY S -
- m-r LR R B, * g*.- . -
i) e 28 THE | I
- Lk | - bl ) (] (el (bw e r - LTS
ST e &% I T Y
GO0 88 S T o el
- e wn) i vl wa) (e [ Om
B 60 SSSaod Ho I

e - wa] s (s (] e (e b
R @RI aEeTEasls Y= Al
% & % S —
@@ e b R R PP R® T
Sl P Y Y - T-1-T1-1-T =
A YT 1o L 2 e I T ="
» Legend

Figure 102: Pin Configurator Package View

When you click the Generate Project Content button, the pin configuration contents are written to:
e rzt gen\bsp pin cfg.h, or
e rzn gen\bsp pin_cfg.h

This file will be created if it does not already exist.

Warning:
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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6.4 Configuring Interrupts from the Stacks Tab

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt priority. Select the driver
in the Stacks pane to view and edit its properties.

% *(Blinky) FSP Configuration 3 | [2) rzt cfg.txt =a
Stacks Configuration Generate Project Content
Threads. £ N % =] HAL/Common Stacks &) New Stack > = Extend Stack > %] Remove

v g HAL/Common
&8 g_ioport /0 Port (r_ioport) 4% g_ioport /0 Port @ Memory config check +4~ g_timer0 Timer,
B na. " N ) (r_ioport) ‘Compare Match W
4 Memory config check (r_cmtw)
@ g_timerd Timer, Compare Match W (r_cmtw) ® ® o g
Obiects

Summary | BSP | Clocks |Pins [ Interrupts | Event Link Components

\,'__ Problems | @ Smart Browser A E Y ¥ EY & &Y # § =0

g_timer0 Timer, Compare Match W (r_cmtw)

Settings  Property Value A
v Commen
Parameter Checking Default (BSP)
Multiplex Interrupt Disabled
v Medule g_timer0 Timer, Compare Match W (r_cmtw)
General
Output
Input
~ Interrupts
Callback NULL
Compare Match Interrupt Priority Priority 11
Input Capture O Interrupt Priority Disabled
Input Capture 1 Interrupt Priority Disabled
Output Compare 0 Interrupt Priority Disabled
Qutput Compare 1 Interrupt Priority Disabled
v Pins,
CMTWo_TICO <unavailable>
CMTWo_TIC1 <unavailable> v
< >

Figure 103 : Configuring Interrupts in the Stacks Tab

6.4.1 Creating Interrupts from the Interrupts Tab
On the Interrupts tab, the interrupt of the driver selected in the Stacks tab is registered.

8% *[Blinky] FSP Configuration X | [ rzt_cfg.txt =] =)
Interrupts Configuration
pts 9 Geirerate Piuguct Gontint
User Events &) New User Event > 3
Event ISR
Allocations
Interrupt Event ISR
B CMTWo_CMWI (CMTW0 Compare match) cmitw_cmint_ist |

Summary | BSP | Clocks PinsEventhks Stacks| Components

Figure 104 : Configuring Interrupt in Interrupt Tab

And the user can add a peripheral interrupt created by the user’s own. This can be done by adding a new event via the
New User Event button.
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6.4.2 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by peripheral to make
it easy to find and verify them.

{54 *[Blinky] FSP Configuration X | [Z) rzt_cfg.txt St =

Event Links Configuration Generate Project Content

User Events Proced User Evrts Consumed
Event Peripheral Function Evel
| ADCo_ADI (ADCO A/D scan end interrupt) -+ Single port 0 ADCO_ADI (ADCO A/D scan end interrupt) |

Allocations

Peripheral Function

Input port group 1 (Port 16)

Input port group 2 (Port 18)
I Single port 0 ADCO_ADI (ADCO A/D scan end interrupt) I

Single port 1 No allocation
Single port 2 No allocation v

Summary | BSP | Clocks | Pins Imermp‘s Stacks | Components

Figure 105 : Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can be defined by
clicking the relevant New User Event button. Once a consumer is linked to a producer the link will appear in the
Allocations section at the bottom.

Note:
When selecting an ELC event to receive for a module (or when manually defining an event link), only the
events that are made available by the modules configured in the project will be shown.
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6.5 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your application using
the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to HAL/Common Stacks.
2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.
3. Select a driver from the menu New Stack > Driver.

{8 ~[Blinky) FSP Configuration = O ||G Outline X ¢=n
Stacks Configuration 0 There s no active editor that provides an outline.
Generate Project Content
Threzds £ HAL/Common Stacks Ie New Stack >}
= Analog >
~ m! HAL/Commen Connectivity 3
L . " - nnectivity
@ g_ioport /O Port (r_ioj ¥ g_ioport /O Port & Memory config check § ot X
48 Memory q (r_iopart) MI '
: onitoring
@ gt ) T .
® © Networking

it
g g

Port Output Enable 3 for MTUS (r_poes)
Port Output Enable for GPT (r_poeg)
Realtime Clock ir_rtc)

WM (
M

hase)
Objects Unit 3 (r_mtu3)
Timer, Compare Match Timer (r_cmt)

Timer, Compare Match W (r_cmtw)

Time, General PWH (r_gpt]

Xk

Summary | BSP | Clocks |Pins [ Interrupts | Event Links | Stacks| Components

Figure 106 : ¢? studio Project Configurator — Adding Drivers

4.  Select the driver module in the HAL/Common Modules pane and configure the driver properties in the
Properties view.

e? studio adds the following files when you click the Generate Project Content button:

e The selected driver module and its files to the rzt/fsp or rzn/fsp directory
e The main() function and configuration structures and header files for your application as shown in the table

below.
Table 14 Generate Contents on Smart Configurator
File Contents Overwritten by Generate
Project Content?
rzt_gen/main.c or Contains main() calling generated Yes
rzn_gen/main.c and user code. When called, the BSP
B already has Initialized the MPU.
rzt_gen/hal_data.c or Configuration structures for HAL Yes
rzn_gen/had data.c Driver only modules.
rzt_gen/hal data.h or Header file for HAL driver only Yes
rzn_gen/hal data.h modules.
src/hal_entry.c User entry point for HAL Driver No
only code. Add your code here.

The configuration header files for all included modules are created or overwritten in this folder:
o 1zt cfg/fsp cfgor
e rzn _cfg/fsp cfg
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6.6 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or excluded. Modules
common to all RZ MPU projects are preselected. All modules that are necessary for the modules selected in the Stacks
tab are included automatically. You can include or exclude additional modules by ticking the box next to the required

component.

¢ *[Blinky) FSP Configuration X

Ci Confi

=] rzt_cfg.txt

P 9
S

Component
v o Arm
v @ CMSIS
v @ CMSISs
V] Core
3, AWS
w o3, Renesas
v @ BSP
v @ all
[¥] Memory
~ @ Board
[ rzt2l_rsk
rzt2l_rsk
rzt2l_rsk
rzt2m_custom
rzt2m_custom
rzt2m_custom
rzt2m_custom
rzt2m_custom

D000 000G6

rzt2m_custom
rzt2m_rsk
rzt2m_rsk
rzt2m_rsk
@ rzt2l

rztzm
[¥] device
[¥] device

] device

[=]

I

1 dasiica. 2.0.0. 0.
Summary |BSP | Clocks | Pins | Interrupts | Event Links Sta:ks

Version

5.7.0+renesas.2.fsp.2u.

200
200
200
200

200
2.00
2,00
200
200

200
200
200

Group by: | Vendor ~ | Filter: |All

Description

Arm CMSIS Version 5 - Core

Memory Config Checking

RSK+RZT2L Board Support Files (xSPI0 x1 boot mode)
RSK+RZT2L Board Support Files (xSPI1x1 boot mode)

RSK+RZT2L Board Support Files (RAM execution without flash memory)

RZT Custom Board Support Files (xSPI0 x 1 boot mode)
RZT Custom Board Support Files (xSPI0 x8 boot mode)
RZT Custom Board Support Files (xSPI1 x1 boot mode)
RZT Custom Board Support Files (16-bit bus NOR flash boot mode)
RZT Custom Board Support Files (32-bit bus NOR flash boot mode)

RZT Custom Board Support Files (RAM execution without flash memory)
RSK+RZT2M Board Support Files (RAM execution without flash memory)

RSK+RZT2M Board Support Files (xSPI0 x1 boot mode)
RSK+RZT2M Board Support Files (16-bit bus NOR flash boot mode)

Board support package for ROA07GO7SM24GBG
Board support package for RZT2M
Board support package for ROAO7GO75SM28GBG

POANIANTEAISGRA

e cimnord mackana for

(V]

B

Generate Project Content

Variant

x5pi0_x1_boot
xspil_x1_boot
ram_execution
xspi0_x1_boot
xspi0_x8 boot
xspil_x1_boot
16bit_nor_boot
32bit_nor_boot
ram_execution
ram_execution
xspi0_x1_boot
16bit_nor_boot

RIAQOTGO75SM24GBG

RIAQ7GO75M28GEG

PNANIGATEAIGERE

Figure 107 : Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected component into the following

folders:

e rzt/fsp/inc/api

e  rzt/fsp/inc/instances
o rzt/fsp/src/bsp

e rzt/fsp/src/<Driver Name>

e rzn/fsp/inc/api
e  rzn/fsp/inc/instances
e rzn/fsp/src/bsp

e  rzn/fsp/src/<Driver Name>

e? studio also creates configuration files in the following folder with configuration options set in the Stacks tab.

o 1zt cfg/fsp cfg
e r1zn_cfg/fsp cfg
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Appendix. Known Issues

This chapter describes the known issues regarding the current version of FSP and related platform software.

Most of the issues may require users to follow some manual operations to resolve the issues or to avoid the problems
caused by the issues. Please follow the operations in the description of the issues if you use the features related to the
issues. The grayed-out items have been resolved.

The known issues are categorized into two main groups, FSP Configuration and FSP Modules.
o  FSP Configuration
¢? studio and FSP SC have various configuration features worked on GUI with FSP.

Regarding the overview of each configuration feature (GUI tab) provided as a part of FSP configuration in e?
studio and FSP SC, please see the chapter 6. “FSP Configuration Users Guide”.

o  FSP Modules
The FSP provides HAL drivers and BSP configured by FSP Configuration on €? studio and FSP SC.
Regarding their features, usage notes and API references, please see the related file “FSP Documentation”.

Table 15 List of Known Issues

No. | Title Target Device Category
T2M | T2L | T2ME | T2H | N2L | N2H
1 “r_gmac” may be showed as “r_ether” v v FSP
incorrectly. Configuration,
Stacks
2 “Edge” can be selected as Transfer End v v v FSP
Interrupt Detect Type in “r _dmac”, but it Configuration,
cannot be used. Stacks
3 When the “Device” or “Board” selection in v/ v v v v v FSP
BSP tab is changed, the BSP properties are Configuration,
sometimes configured to incorrect BSP
configuration.
4 (FSP SC ONLY) Device name is not output v v FSP
correctly depending on the selected device. Configuration,
BSP
5 Errors occur when changing board settings. v v FSP
Configuration,
BSP
6 Pin configuration error occurs in MPX-IO v v v FSP
16bit operating mode of “r_bsc”. Configuration,
Pins
7 Build error when using definition name of v v v FSP
input/output external pins for module. Configuration,
Pins
8 “R_SCI UART BaudCalculate()” of v v v FSP Modules,
“r_sci_uart” module properly works ONLY SCI UART
when its clock source is SCInASYNCCLK
and its frequency is 96MHz.
9 “R_SPI_CalculateBitrate()” of “r_spi” v v v FSP Modules,
module properly works ONLY when its SPI
clock source is SPINASYNCCLK and its
frequency is 96MHz.
10 | A warning occurs when building “r gmac” v v FSP Modules,
module with the gcc compiler. Ethernet
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No. | Title Target Device Category
T2M | T2L | T2ME | T2H | N2L | N2H

11 | In FSP Documentation, there is v v FSP Modules,
incorrect description in. “API Ethernet PHY
Reference > Modules > Ethernet
PHY” page.

12 | The interrupt number cannot be v FSP Modules,
successfully acquired by the FreeRTOS
R_FSP_CurrentlrqGet() when
multiple interrupt occurs.

13 | Block Media Custom Implementation v v v v FSP
can be selected as Memory Configuration,
Implementation for Stacks
“rm_freertos plus_fat” module, but it
cannot be used.

14 | The second argument of “r_mtu3” v/ v v v v v FSP Modules,
APIs do not match with common API. MTU3

15 | In multiprocessing, a configuration v v FSP
error occurs when “r_gpt” module is Configuration,
used for both projects for CPUO and Stacks
CPUL.

16 | Project build error occur when 32-bit v FSP
bus NOR flash and xSPI0 x8 boot Configuration,
modes are selected on RZT Custom BSP
User Board.

17 | The secondary project for v FSP
multiprocessing cannot be created Configuration,
when xSPI1 x1 boot modes are BSP
selected on RZT Custom User Board.

18 | An incorrect value is set to a pin v FSP Modules,
select value for MTUO- POE3
B/MTU6/MTU7 as MTU3 output pin.

19 | Build error when using v FSP Modules,
DSMIFn_ERR as an additional trigger POE3
for “r_poe3” module.

20 | Control setting values for MTU3 v v v FSP
output pins in Stacks tab of FSP Configuration,
Configuration are set to the incorrect Stacks
pin.

21 | A bug that prevented the setup of v FSP
PLL1. Configuration,

Clocks

22 | A section cannot be copied v FSP Modules,
successfully when its size is not a BSP
multiple of the alignment size.

23 | Initial values of data placed in some v FSP Modules,
sections were overwritten with 0. BSP

24 | Some sections were not initialized in v FSP Modules,
the flash boot project. BSP
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No. | Title Target Device Category
T2M | T2L | T2ME | T2H | N2L | N2H

25 | DSMIF 0/1 error 1 trigger macros are v FSP Modules,
not defined. POEG

26 | DSMIF 0/1 error 1 status macros are v FSP Modules,
not defined. POEG

27 | Missing constraint for DSMIF error v v v v v v FSP Modules,
trigger in channel 1 and channel 2. POEG

28 | FreeRTOS+FAT format process is not v v v v v v FSP Modules,
executed correctly. FreeRTOS+F

AT

29 | Caution when specifying program v v Others, Linker
placement in linker scripts. script

30 | In the secondary project for v v FSP
multiprocessing, no error occurs when Configuration,
there is a conflict in a resource used Stacks
with the preceding project.

31 | Errors occur when setting ELC in v v FSP
r_gpt module. Configuration,

Stacks

32 | CR52 CPUI1 of RZ/T2H and RZ/N2H v v Others, Linker
is implemented to start programs from script
System SRAM instead of CPU1
ATCM.

33 | No Error Occurs when entering out- v v FSP
of-range values for window Configuration,
parameters inr_pcie ep andr_pcie rc Stacks
module configurations.

34 | Address space of DDR and PCIE v v Others,
cannot be used in the secondary (or Address space
later) projects with flash boot mode.

35 | r_gmac_b module cannot use zero- v v FSP Modules,
copy mode. GMAC

36 | r_adc module does not support the v v FSP Modules,
calibration function. ADC

37 | The USB driver for CASS5 project v v FSP Modules,
does not work. USB

38 | No error returns when entering the v v FSP Modules,
virtual addresses that cannot be xSPI_OSPI,
translated to physical addresses as xSPI_QSPI,
arguments. DMAC

39 | The CASS project with noncache v v FSP Modules,
sections aborts when debugging with BSP
flash boot mode on IAR EWARM.

40 | When changing the duty setting in v v v v v v FSP Modules,
r_gpt module, there is a possibility the GPT
duty may unintentionally become
100%.
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No. | Title Target Device Category
T2M | T2L | T2ME | T2H | N2L | N2H

41 | CPU registers save and restore v v FSP Modules,
process cannot be performed correctly BSP,
in FIQ Handler for CA55 projects. FreeRTOS

42 | MTU3 callback does not occur as v v FSP Modules,
expectation. MTU3

43 | An undefined error of r_gpt module v v FSP Modules,
occurs when building a project. GPT
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No.1 Resolved
Title “r_gmac” may be showed as “r_ether” incorrectly.
Target RZ/T2M, RZ/N2L
Category FSP Configuration, Stacks
Description In Stacks tab, “r_gmac” may be showed as “r_ether” incorrectly.
Workaround | Please read the “r ether” as “r gmac”.
No.2 Resolved
Title “Edge” can be selected as Transfer End Interrupt Detect Type in “r_dmac”, but it cannot be
used.
Target RZ/T2M, RZ/T2L, RZ/N2L
Category FSP Configuration, Stacks
Description “Edge” of interrupt detect type is not available due to a change in hardware specifications.
Workaround | Please don’t set Edge to Transfer End Interrupt Detect Type
No. 3
Title When the “Device” or “Board” selection in BSP tab is changed, the BSP properties are
sometimes configured to incorrect configuration.
Target RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H, RZ/N2L, RZ/N2H
Category FSP Configuration, BSP
Description When the “Device” or “Board” selection in BSP tab is changed, the BSP properties are sometimes
configured for incorrect configuration. Once this issue occurs, the project cannot be fixed to correct
configuration.
Workaround | If changing the “Device” or “Board”, please reselect “FSP Version” from the drop-down list.

If you want to change only the boot mode on the same board, please refer to

Appendix. How to Change Boot Mode of FSP Project

(Continued on next page)
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No.4 Resolved

Please reselect device name from the device list in [AR EWARM project options.
Options > General Options > Target > Processor variant > Device

Title (FSP SC ONLY) Device name is not output correctly depending on the selected device.

Target RZ/T2M, RZ/T2ME

Category FSP Configuration, BSP

Description If you create a project by selecting a single core device (ROA07G075MO1xxx,
RIA07G075M05xxx), the device setting will be “None” when you open the project in IAR
EWARM.

Workaround

Options for node "Blinky" %

Category:

et oers— 8

Static Analysis
Runtime Checking

C/C++Congler Library Confiquration Library Options 1 Library Options 2
Assenbler 22-bit 64-bit Output

Output Converter
Custom Buid i —
Build Actions QO Core ARM7TDM
Linker I =
@® Devic None E ]
Debugger (® Device .
il O CMSIS-Pack c
CADI
CMSIS DAP

Processor variant

GDB Server Execution mode
Ijet
Jink/)-Trace

T1 Stellaris
Nu-Link

PE micro

ST-LINK
Third-Party Driver

0K Cancel

(Continued on next page)
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No.5 Deleted due to one of the issues with Known Issues No. 3

Title

Errors occur when changing board settings.

Target

RZ/T2L, RZ/N2L

Category

FSP Configuration, BSP

Description

Errors occur when changing board settings from RSK+RZN2L (RAM execution without flash
memory) to RZN2L Custom User Board (RAM execution without flash memory) and from
RSK+RZN2L (RAM execution without flash memory) to RZN2L Custom User Board (xSPI0 x1
boot mode).

1. Changed from RSK+RZN2L (RAM execution without flash memory) to RZN2L Custom User
Board (RAM execution without flash memory)

In this case, the build is successful. But the following screen is displayed after the build.

[T Properties |/ Problems | @ Smart Browser | B Console < | [ Memory Usage
CDT Build Console [rzn2|_minimal]
Building file: ../rzn/fsp/src/r_loport/r_ioport.c

Building file: ../rzn/fsp/src/bsp/meu/rzn2lfbsp_cache.c
Building file: ../rzn_gen/pin data.c

../rzn_gen/vector_data.c

../rzn/fsp/src/r_ioport/r_ioport.c
../rzn/fsp/src/bsp/meufrzn2l/bsp_cache.c

../rzn_gen/pin_data.c

Building file: ../rzn/fsp/src/bsp/mcu/rzn2l/bsp_loader_param.c
Building file: ../rzn/fsp/src/bsp/mcu/all/bsp_clocks.c
../rzn/fsp/src/bsp/mcufrzn2l/bsp_loader_param.c

Building file: ../rzn/fsp/src/bsp/mcu/all/bsp_common.c ) Problem Occurred - o X
../rzn/fsp/src/bsp/mcu/all/bsp_clocks.c

Building file: ../rzn/fsp/src/bsp/mcu/all/bsp_delay.c = 0 )
. ‘/rzm’%sp/sr(/bsp/m(u/aﬁl/bsp_(gmmun.( P .Q\ R BT o G I D Tl
../rzn/Fsp/src/bsp/meu/all/bsp_delay.c Z:

Building file: ../rzn/fsp/src/bsp/meu/all/bsp_io.c

Building file: ../rzn/fsp/src/bsp/mcufall/bsp_irg.c
../rzn/fsp/src/bsp/meu/all/bsp_io.c oK
Building file: ../rzn/fsp/src/bsp/mcufall/bsp_register_protection.c

../rzn/fsp/src/bsp/meufall/bsp_irg.c
Building file: ../rzn/fsp/src/bsp/mcu/all/bsp_reset.c Errors occurred during the build.
../rzn/fsp/src/bsp/mcusall/bsp_register_protection.c Errors running builder 'COT Builder' on project

Errars accurred during the build.

../rzn/fsp/sre/bsp/meu/all/bsp_reset.c 'rzn2|_minimal'
Building file: ../rzn/fsp/src/bsp/mecu/all/bsp sbri.c Resource frznd]_minimal/Debug/rzn/board/rzn2l_rsk
Building file: ../rzn/fsp/src/bsp/cmsis/Device/RENESAS/Source/startup.c does not exist.
../rzn/fsp/src/bsp/mcu/all/bsp_sbrk.c Resource '/rzn2l_minimal/Debug/rzn/board/rzn2l_rsk’
Building file: ../rzn/fsp/src/bsp/cmsis/Device/RENESAS/Source/system.c does not exist,
../rzn/fsp/sre/bsp/cmsis/Device /RENESAS/Source/startup.c Resource /rzn2l_minimal/Debug/rzn/board/rzn2|_rsk’
../rzn/fsp/src/bsp/emsis/Device/RENESAS/Source/system. ¢ does not exist.
Building target: rzn2l_minimal.elf Resource /rzn2l_minimal/Debug/rzn/board/rzn2l_rsk’
arm-none-eabi-objcopy -0 srec "rzn2l_minimal.elf" "rzn2l_minimal.srec” does not exist.
arm-none-eabi-size --format=berkeley "rzn2l_minimal.elf"”
text  data bss dec hex filename
49560 @ 15672 20032  4e4@ rzn2l_minimal.elf

13:18:17 Build Finished. @ errors, @ warnings. (took 7s.316ms)

2. Changed from RSK+RZN2L (RAM execution without flash memory) to RZN2L Custom User
Board (xSPI0 x1 boot mode)

bsp_mcu_device pn_cfg.h is not generated and builds error occurs.

[T Properties [ Problems X | @ Smart Browser| B Console

6 errors, 12 warnings, 227 others (Filter matched 124 of 251 items)

Description - Resource Path Location Trpe

~ @ Errors (6 items)
@ fatal error: bsp_mecu_device_pn_cfg.h: No such file or directory bsp_meu_family_cfg.h frzn2_minimalfrzn... line4 C/Cs+ Probl...
@ make: *** [1zn_gen/subdir.mlc42: rzn_gen/common_data.o] Error 1 rzn2l_minimal C/C+ Probl...
@ make: ™ [1zn_gen/subdir.mk42: rzn_gen/hal_data.o] Error 1 rzn2l_minimal C/Ce Probl...
@ make: *** [1zn_gen/subdir.mlc42: rzn_gen/main.o] Error 1 rzn2l_minimal C/Ce+ Probl...
@ make: ™ [src/subdir.mk26: sre/hal_entry.o] Error 1 rzn2l_minimal €/C++ Probl...
@ make: *** Waiting for unfinished jobs.... rzn2l_minimal C/Ces Probl...

Workaround

Please create a new project to change the board setting to RZN2L Custom User Board.

(Continued on next page)
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No. 6

Resolved

Title

Pin configuration error occurs in MPX-IO 16bit operating mode of “r_bsc”.

Target

RZ/T2M, RZ/T2L, RZ/N2L

Category

FSP Configuration, Pins

Description

Pin assignment is an optional specification in MPX-IO 16bit operation mode of “r bsc”, but an

error will occur if Input/Output A1-A13 is not set.

Pin Configuration

Select Pin Configuration

[Rsk+RZN2L

v | Manage configurations...

Pin Selection

= % =% Ppin Configuration

o

Generate Project Content

Lt Export to CSV file | Configure Pin Driver Warnings

Generate data: .g_bsp_pin_cfg ]

! Cycle Pin Group

|bsc

X | |Name

v Ports
v ¢ Other Pins
* BSCANP
v @ Peripherals
~ @ ExBus:BSC
@ BSC

Pin Group Selection
Operation Mode
v Input/Output
AD
Al
A2
A3
Ad

<

Value Lock Link

Mixed
@ MPX-10 16bit

None

@ * None
@ * None
v P0S_1
@ * None

~

Module name: BSC

Pin Function|Pin Number

Summary |BSP Clocks | @ Pins| Interrupts| Event Links | Stacks| Components

Workaround

Please set “Custom” to “Operation Mode” of “r_bsc” in Pins tab when you use MPX-IO 16bit

operation mode of “r_bsc”.

(Continued on next page)
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No.7 Resolved

Title

Build error when using definition name of input/output external pins for module.

Target

RZ/T2M, RZ/T2L, RZ/N2L

Category

FSP Configuration, Pins

Description

After code generation, the definition of input/output external pins for the module is generated in
fsp_cfg/bsp/bsp pin_cfg.h, but the defined values are not defined in FSP. When using the defined
name in a user application, a build error occurs.

Lh] bsp_pin_cfg.h X | Le| hal_entry.c Lh| bsp_io.h

T e

5 P o
49 #define ETH@_TXCLK (IOPORT_PORT_@9_PIN_7)

#define ETH® TXEN (IOPORT PORT 10 PIN 8
#define ETH@_RXD1 (IOPORT_PORT_10_PIN_2)
#define ETH@_RXD2 (IOPORT_PORT_18_PIN_3)

[0 bsp_pin_cfg.h [g hal_entry.c X | [h] bsp_io.h

uint16 t tmp = ETHO, RXDO;

1= Properties | .. Problems 2 Console X | 4’ Search X v UE H @H

CDT Build Console [rzt2m_ether_test)

../src/hal_entry.c: In function 'hal_entry':

D:\ws\rz\t2128\rzt2m_ether_test\rzt_cfg\fsp_cfg\bsp/bsp_pin_cfg.h:51:20: JuxcTatum el el gz el e D (TS SRVIRT: T TR | (
51 | #define ETHO_RXD@ (IOPORT_PORT_1@_PIN_1)

N NN PN NN

Workaround

Please add definition to read IOPORT PORT mm PIN nas BSP 10 PORT mm PIN nin
hal_entry. Do NOT edit file fsp_cfg/bsp/bsp pin_cfg.h because its contents will be overwritten.

An example of a setting:
When using ETHO RXDO (IOPORT PORT 10 PIN 1), add definition of #define
IOPORT PORT 10 PIN 1 (BSP_IO PORT 10 PIN 1)in hal entry.c.

h bsp_pin_cfg.h £] hal_entrgc 3 | W bsp inkh

+
ginclude “hal_data.h™

2 LE S LT OPORT PORT 18 PIN 1 (BSP IO PORT 12 PIN 1

void B_B5P WarmStart(bsp warm_start_ewvent_t event) B5P _PLACE IN_SECTION(™.warm_start™);

No.8 Resolved

Issue “R_SCI_UART _BaudCalculate()” of “r_sci_uart” module properly works ONLY when its
clock source is SCInASYNCCLK and its frequency is 96MHz.

Target RZ/T2M, RZ/T2L, RZ/N2L

Category FSP Modules, Serial Communication Interface (SCI) UART

Description The “R_SCI_UART BaudCalculate()” of “r_sci_uart” module works ONLY when its clock source
is “SCInASYNCCLK?” and its frequency is “96MHz”; therefore, when the module uses “PCLKM”
as its clock source or the frequency is not 96MHz, the API function will be not work properly.

Workaround | The clock source and frequency are limited in Clocks and Stacks tab; therefore, you can NOT use

the PCLKM clock and can NOT change the clock frequency.

(Continued on next page)
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No.9 Resolved

Issue “R_SPI_CalculateBitrate()” of “r_spi” module properly works ONLY when its clock source
is SPInASYNCCLK and its frequency is 96MHz.

Target RZ/T2M, RZ/T2L, RZ/N2L

Category FSP Modules, Serial Peripheral Interface

Description The “R_SPI_BaudCalculate()” of “r_spi” module works ONLY when its clock source is
“SPInASYNCCLK?” and its frequency is “96MHz”; therefore, when the module uses “PCLKM” as
its clock source or the frequency is not 9%6MHz, the API function will be not work properly.

Workaround | The clock source and frequency are limited in Clocks and Stacks tab; therefore, you can NOT use
the PCLKM clock and can NOT change the clock frequency.

No. 10 Resolved

Issue A warning occurs when building “r_gmac” module with the gcc compiler.

Target RZ/T2M, RZ/T2L

Category FSP Modules, Ethernet

Description The following warning occurs when building “r_gmac” module with the gcc compiler.
..frzt/fsp/src/r_gmac/r_gmac.c:2173:14: warning: the comparison will always evaluate as 'false' for
the pointer operand in 'pp_phy_instance + (sizetype)(port * 12)' must not be NULL [-Waddress]
2173 | if (NULL == pp_phy_instance[port])

| A
Workaround | Please ignore this warning.
No. 11 Resolved

Issue In FSP Documentation, there is incorrect description in. “API Reference > Modules >
Ethernet PHY” page.

Target RZ/T2M, RZ/N2L

Category FSP Modules, Ethernet PHY

Description In the “API Reference > Modules > Ethernet PHY” page in FSP Documentation, the default
column description of “Select PHY's to use” configuration is incorrect.

Workaround | When reading the incorrect description, please replace the reading of it with follows.

[Error]

»  config.driver.ether phy.phy Isi.default,config.driver.ether phy.phy Isi.0,config.driver.ether
phy.phy Isi.1,config.driver.ether phy.phy Isi.2,config.driver.ether phy.phy Isi.3,config.drive
r.ether phy.phy Isi.

[Correction]

»  All check boxes are enabled.

(Continued on next page)
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No. 12 Resolved

Target File: port.c
void vApplicationIRQHandler (uint32_t ulICCIAR)

#if @
/* Re-enable interrupts. */
__asm(“cpsie i”);

#endif

bsp_common_interrupt_handler(ulICCIAR);

Target File: bsp_irq.c

void bsp_common_interrupt_handler (uint32_t id)

{

uintl6_t gic_intid;

/* Get interruot ID (GIC INTID). */
gic_intid = (uint16_t) (id & BSP_PRV_ID_MASK);

#if VECTOR_DATA_IRQ_COUNT > @
if (BSP_CORTEX_VECTOR_TABLE_ENTRIES <= gic_intid)

{
/* Remain the interrupt number */
g_current_interrupt_num[g_current_interrupt_pointer++] =
(uint16_t) (gic_intid-- BSP_CORTEX_VECTOR_TABLE_ENTRIES);
__asm volatile (“dmb”);
#if 1
/* Enable nested interrupt. */
__asm volatile (“cpsie i”);
__asm volatile (“isb”);
#endif
/* Branch to an interrupt handler. */
g_vector_table[(gic_intid-- BSP_CORTEX_VECTOR_TABLE_ENTRIES)]();
}
else
#endif
{
/* Remain the interrupt number */
g_current_interrupt_num[g_current_interrupt_pointer++] = gic_intid;
__asm volatile (“dmb”);
#if 1
/* Enable nested interrupt. */
__asm volatile (”cpsie i”);
__asm volatile (“isb”);
#endif
/* Branch to an interrupt handler. */
g_sgi_ppi_vector_table[gic_intid]();
}
#if 1

/* Disable nested interrupt. */
__asm volatile (”cpsid i”);
__asm volatile (”isb”);

#endif

g_current_interrupt_pointer--;

Issue The interrupt number cannot be successfully acquired by the R_FSP_CurrentlrqGet()
when multiple interrupt occurs.

Target RZ/N2L

Category FSP Modules, FreeRTOS

Description The interrupt number cannot be successfully acquired by the R FSP_CurrentlrqGet() when using
multiple interrupt handlers with different priority levels in FreeRTOS.

Workaround | Please modify the followings for the countermeasure against nested interrupts.
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No. 13 Resolved

Issue Block Media Custom Implementation can be selected as Memory Implementation for
“rm_freertos_plus_fat” module, but it cannot be used.
Target RZ/T2M, RZ/T2L, RZ/T2ME, RZ/N2L
Category FSP Configuration, Stacks
Description In Stacks tab of Configuration, Block Media Custom Implementation can be selected as Memory
Implementation for “rm_freertos plus_fat” module, but it is unsupported and causes build errors.
FreeRTOS+FAT Stacks % | New Sta¢
47 FreeRTOS+FAT
@
(@ FreeRTOS+FAT Port for
RZT (rm_freertos_plus_fat)
@
. Add Mem;ry
Implementation
[Required]
New 5> @ Block Media Custom Implementation (rm_block_media_user)
4 Block Media USB {rm_block_media_usb)
Workaround | Please select Block Media USB as Memory Implementation for “rm_freertos plus_fat” module.
No. 14
Issue The second argument of “r_mtu3” APIs do not match with common API.
Target RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H, RZ/N2L, RZ/N2H
Category FSP Modules, MTU3
Description The second argument of these three APIs "R_MTU3 PeriodSet()", "R_MTU3_InfoGet()", and
"R_MTU3_StatusGet()" of the "r_mtu3" module, do not match with the API in “r_timer api.h”
header file
Workaround | You cannot call these API by using function pointer

g_timer@.p_api->periodSet()
g_timer@.p_api-> InfoGet()
g_timer@.p_api-> StatusGet()

Please use API by calling them directly

R_MTU3_PeriodSet()
R_MTU3_InfoGet()
R_MTU3_StatusGet()

For reference how to use these APIs, please refer to MTU3 Examples in FSP documentation.

(Continued on next page)
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No. 15

Issue In multiprocessing, a configuration error occurs when “r_gpt” module is used for both
projects for CPUO and CPUI.

Target RZ/T2M, RZ/T2ME

Category FSP Configuration, Stacks

Description When using “r_gpt” module in Stacks tab of both projects for CPUO and CPU1, a configuration
error occurs. “r_gpt” module can only be used with either CPUO or CPU1 in multiprocessing,
regardless of the Unit or Channel number used.

Workaround | Please use “r_gpt” module ONLY with either CPUO or CPU1 in multiprocessing.

No. 16 Resolved

Issue Project build error occur when 32-bit bus NOR flash and xSPI0 x8 boot modes are selected
on RZT Custom User Board.

Target RZ/T2M

Category FSP Configuration, BSP

Description When the following boards (boot mode) are selected, the required definitions are not generated and
a build error occurs.
e RZT Custom User Board (32-bit bus NOR flash boot mode)
e  RZT Custom User Board (xSPIO x8 boot mode)

Workaround | Please don’t select 32-bit bus NOR flash and xSPI0 x8 boot modes on RZT Custom User Board.

No. 17 Resolved

Issue The secondary project for multiprocessing cannot be created when xSPI1 x1 boot modes are
selected on RZT Custom User Board.

Target RZ/T2M

Category FSP Configuration, BSP

Description When the following boards (boot mode) are selected for the primary project of multiprocessing, a
variable required for multiprocessing is not defined and the secondary project cannot be created.
e  RZT Custom User Board (xSPI1 x1 boot mode)

Workaround | Please don’t select xSPI1 x1 boot modes on RZT Custom User Board when multiprocessing.

(Continued on next page)
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No. 18 Resolved

Issue An incorrect value is set to a pin select value for MTU0-B/MTU6/MTU?7 as MTU3 output pin.

Target RZ/T2L

Category FSP Modules, POE3

Description Pin select value of MTU3 output pins used in FSP do not match with User’s Manual: Hardware.
Therefore, what you want to set up is not correctly described in the generated file of FSP
Configuration.

Workaround | When using “r_poe3” and MTUO-B/MTU6/MTU7 as MTU3 output pin, please follow these four

steps:
1. Add “Port Output Enable 3 for MTU3 (r_poe3)” on Stacks tab of FSP Configuration.
2. Click Generate Project Content button and “r_poe3” code is generated.
3. Disable code generating function.
After this setting, the code cannot be generated.
[For €2 studio Smart Configurator]
Use the following settings to suppress the code generating operation.
If this setting is missed, code generating operation is automatically executed at clean build, and
the changes made in step 4 revert to the original.
a. Uncheck “Project Properties > Builders > DDSC Builder”
| @ properties for o x|

type filter text R 84

Builders
Resource

Builders Configure the builders for the project:

C/C++ Build mDDSC Builder o
C/C++ General [¥] @ COT Builder

[ % Import.
MCU [] fstb Scanner Configuration Builder

Project Natures [ & DDSC Bundle Builder

Project References
Renesas QE
Run/Debug Settings
Task Tags

Validation
Down

? Apply and Close Cancel

b. When unchecking it, the following message appears: click OK.

. & Confirm Disable Builder %

This is an advanced operation. Disabling a project builder can have many side-effects. Continue?

Cancel

[For FSP SC (AR EWARM)]
No need setting since code generation is not executed automatically.
4. Modify definitions in rzt gen/hal data.c
Change the value of [module name] pwm pin_setting[] or [module
name] complementary pwm_setting[1].pin_setting[ X](X=0,1,2) according to the MTU3 output
pins used. The tables below show the replacements required for each MTU3 output pins.

File to be modified: rzt gen/hal data.c
/* Setting structure for pwm pin. */
static const poe3_pwm_pin_setting t g poe30_pwm_pin_setting[] =

{

{ .pwm_pin_select = POE3_PIN_SELECT_©, .hiz_output_enable = false },

{ .pwm_pin_select = POE3_PIN_SELECT_©, .hiz_output_enable = false },

{ .pwm_pin_select = POE3_PIN_SELECT_©, .hiz_output_enable = false },

{ .pwm_pin_select = POE3_PIN_SELECT_O, .hiz_output_enable = false }, };

/* Setting structure for complementary pwm pin. */
static const poe3_complementary_pwm_setting t g_poe3@_complementary_pwm_setting[] =

{
{ .pin_setting[@] =
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1

POE3_PIN_SELECT_o,

POE3_PIN_SELECT_@,
POE3_PIN_SELECT_@,

.negative_pwm_pin_active_level

evel = POE3_ACTIVE_LEVEL_SETTING_NONE,
= POE3_ACTIVE_LEVEL_SETTING_NONE,

Location (Struct [module name]
pwm pin_setting[])

Replace with

the second pwm_pin_select

.pwm_pin_select =
POE3 PIN SELECT 1

the second pwm_pin_select

.pwm_pin_select =
POE3 PIN SELECT 2

the second pwm_pin_select

.pwm_pin_select =
POE3 PIN SELECT 3

Location (Struct [module

name] complementary pwm_setting[])

Replace with

the second pin_setting[0]

.positive_pwm_pin_select
= POE3_PIN SELECT 1,

the second pin_setting[0]

.positive_pwm_pin_select
= POE3_PIN SELECT 2,

the second pin_setting[0]

.negative_pwm_pin_select
= POE3_PIN SELECT 1,

the second pin_setting[0]

.negative_pwm_pin_select
= POE3_PIN_SELECT 2,

the second pin_setting[1]

.positive_pwm_pin_select
= POE3_PIN SELECT 1,

the second pin_setting[1]

.positive_pwm_pin_select
= POE3_PIN_SELECT 2,

the second pin_setting[ 1]

.negative_pwm_pin_select
= POE3 PIN SELECT 1,

the second pin_setting[ 1]

.negative_pwm_pin_select
= POE3_PIN SELECT 2,

the second pin_setting[2]

.positive_pwm_pin_select
= POE3_PIN SELECT 1,

the second pin_setting[2]

.positive_pwm_pin_select
= POE3_PIN SELECT 2,

the second pin_setting[2]

.negative_pwm_pin_select
= POE3_PIN SELECT 1,

the second pin_setting[2]

.negative_pwm_pin_select
= POE3_PIN_SELECT 2,

{ .positive_pwm_pin_select
lpin_setting[x] S
.positive_pwm_pin_select
.negative_pwm_pin_select
.positive_pwm_pin_active_.
.hiz_output_enable = false },

For MTUO-B

MTU3 Port

output pin

mtiocOb P14 4

mtiocOb P24 0

mtiocOb P13 3

For MTU6/MTU7

MTU3 Port

output pin

mtioc6b P21 2

mtioc6b P08 5

mtioc6d P21 4

mtioc6d P08 7

mtioc7a P21 5

mtioc7a P09 0

mtioc7c P21 7

mtioc7c P09 2

mtioc7b P21 6

mtioc7b P09 1

mtioc7d P22 0

mtioc7d P09 3

first.

Note: There are two pin_setting[X] 's with the same number(X); modify the second one, not the

(Continued on next page)
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No. 19 Resolved

Issue Build error when using DSMIFn_ERR as an additional trigger for “r_poe3” module.
Target RZ/T2L
Category FSP Modules, POE3

Description When using DSMIFn_ERR as an additional trigger in FSP Configuration, after code generation,
values of DSMIFn_ERR additional trigger for the module are generated in rzt_gen/hal data.c. But
the defined values are not defined in FSP, so a build error occurs.

Property of r_poe3 stack

g_poe30 Port Output Enable 3 for MTU3 (r_poe3)

Settings  Property Value
Default (BSP,
Disabled
Output
v MTUO Pin Control
MTUQ-A (MTIOCOA)
MTUO-B (MTIOCOB)
MTUO-C (MTIOCOC)
MTUO-D (MTIOC0D)
 Additional MTUO pin control request condition (Always enable POES# Input)
POE o
POE: o
POE o
POE jm]
DSMIFO Error @
DSMIF1 Error [
MTU3 and MTUA Fin Contral
MTU6 and MTU? Pin Control
Build error log
[ Properties 1l Problems | @ Smart Browser | & Console X R 4GB PR &l mBE-m-=0
CDT Build Console [rzt21]
../rzt_gen/hal_data.c:78:48: error: 'R_POE3_POECRS_DEGADDMT@ZE_Pos’ undeclared here (not in a function); did you mean 'R_POE3_POECRS_D@E@ADDMTOZE_Pos'? A
Building file: ../rzt_gen/hal_data.c
78 | .mtud_contrel_channel_mask = ((1U << R_POE3_POECRS_DE@ADDMT@ZE_Pos) | (1U << R_POE3_POECR5_DE1ADDMT@ZE_Pos) | au),

o o o
R_POE3_POECRS_DOEGADDMTGZE_Pos
fix-it:"../rzt_gen/hal_data.c”:{78:48-70:69}:"R_POE3_POECRS_D@E@ADDMTBZE_Pos"
../rzt_gen/hal data.c:7@:8@: error: 'R_POE3 POECRS DELADDMT@ZE Pos' undeclared here (not in a function); did you mean 'R_POE3 POECRS_D@ELADDMT@ZE Pos'?
78 |  .mtud_control_channel_mask = ((1U << R_POE3_POECRS_DEBADDMTAZE Pos) | (1U << R_POE3_POECRS_DELADDMTOZE Pos) | @U),
1 s
R_POE3_POECRS_DOE1ADDMTGZE_Pos
fix-it:"../rzt_gen/hal_data.c”:{78:80-76:189}:"R_POE3 POECRS_DGELADDMTOZE_Pos"

Workaround | When using “r_poe3” and DSMIFn_ERR(n=0,1) as an additional trigger, please follow these four
steps:
1-3. Refer to the workaround of No. 18.
4. Modify definitions in rzt_gen/hal data.c
When using DSMIF 0 ERROR, DSMIF 1 ERROR for MTUO additional trigger, modify:
e R POE3 POECR5 DEOADDMTOZE Posto R POE3 POECRS DOEOADDMTOZE Pos
e R POE3 POECR5 DEIADDMTOZE Posto R POE3 POECRS DOEIADDMTOZE Pos

When using DSMIF 0 ERROR, DSMIF 1 ERROR for MTU3/4 additional trigger, modify:
e R POE3 POECR4 DEOADDMT34ZE Pos

to R POE3 POECR4 DOEOADDMT34ZE Pos
e R POE3 POECR4 DEIADDMT34ZE Pos to

R POE3 POECR4 DOE1IADDMT34ZE Pos

When using DSMIF 0 ERROR, DSMIF 1 ERROR for MTUG6/7 additional trigger, modify:
e R POE3 POECR4 DEOADDMT67ZE Pos to

R POE3 POECR4 DOEOADDMT67ZE Pos
* R POE3 POECR4 DEIADDMT67ZE Pos to

R POE3 POECR4 DOE1IADDMT67ZE Pos

(Continued on next page)
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No. 20 Resolved

Issue Control setting values for MTU3 output pins in Stacks tab of FSP Configuration are set to the
incorrect pin.
Target RZ/T2M, RZ/T2L, RZ/T2ME
Category FSP Configuration, Stacks
Description Settings for MTU4-B(MTIOC4B) and MTU4-D(MTIOC4D) in the Stacks tab property would be
treated as settings for MTU4-A(MTIOC4A) and MTU4-C(MTIOCA4C) in the generated file by
Smart Configurator. All MTU3 output pins for MTU4 and MTU?7, are the same as above.
Module [module name] Port Output Enable 3 for MTU3 (r_poe3) of Stacks property
Second Category Third Category Used for
MTU3 and MTU4 Pin MTU4-B(MTIOC4B) and MTU4- MTU4-AMTIOC4A) and MTU4-
Control D(MTIOC4D) C(MTIOCA4C)
MTU3 and MTU4 Pin MTU4-A(MTIOC4A) and MTU4- MTU4-B(MTIOC4B) and MTU4-
Control C(MTIOCA4C) D(MTIOC4D)
MTU6 and MTU7 Pin MTU7-B(MTIOC7B) and MTU7- MTU7-AMTIOC7A) and MTU7-
Control D(MTIOC7D) C(MTIOCT7C)
MTUG6 and MTU7 Pin MTU7-A(MTIOC7A) and MTU7- MTU7-B(MTIOC7B) and MTU7-
Control C(MTIOC7C) D(MTIOC7D)
Workaround | In configuration of MTU4 and MTU?7, please replace B/D and A/C.
v MTU3 and MTU4 Pin Control
MTU3-B (MTIOC3B) and MTU3-D (MTIOC3D)
[MIU4 B (MTIOC4B) and MTU4-D (MTIOC4D) ] Use this field to configure for MTU4-A and MTU4-C
[MTLM A [MTIOCAA) and MTU4-C (MTIOCAT) ] Use this field to configure for MTU4-B and MTU4-D
Additional MTU3/4 pin control request condition (Always enable POEO# Input)
v MTU6 and MTU7 Pin Control
MTUG-B (MTIOC6B) and MTUG-D (MTIOC6D)
[MIUJ-B (MTIOCT7B) and MTU7-D (MTIOCTD) ] Use this field to configure for MTU7-A and MTU7-C
[MIUF-A [MTIOCTA) and MTU7-C (MTIOC7C) ] Use this field to configure for MTU7-B and MTU7-D
Additional MTU6/7 pin control request condition (Always enable POE4# Input)

No. 21 Resolved

Issue A bug that prevented the setup of PLL1.
Target RZ/N2L

Category FSP Configuration, Clocks

Description The PLL1 state setting in Clocks tab is invalid.
Workaround | Please don’t use PLL1 state setting.

(Continued on next page)
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No. 22 Resolved

Issue

A section may not be copied correctly when it is not aligned and the section size is not a
multiple of the alignment width.

Target

RZ/N2L

Category

FSP Modules, BSP

Description

Depending on a combination of section size and placement address, when the section is copied,
some data from the following section may also be copied with it.

A case that cannot be copied correctly:
The address of .data noncache section is 0x30190005 and its size is 0x23 bytes. (Alignment size
is 4 bytes.)

.data_noncache
0x30190005 0x23 ./src/hal_entry.o

Workaround

All section sizes must be aligned by 4 bytes and the data size should be a multiple of the number of
bytes in the alignment. Section sizes can be found in the following files:

U gce: [project name]/Debug/[project name].map
c iccarm: [project name]/Debug/List/[project name].map

No. 23 Resolved

Issue Initial values of data placed in some sections were overwritten with 0.
Target RZ/N2L
Category FSP Modules, BSP
Description When selecting XXXXX (RAM execution without flash memory) as “Board” in BSP tab of FSP
Configuration, variables placed in the following sections are always cleared to zero.
. .dmac_link _mode
J .shared noncache buffer
C .noncache buffer
Workaround | Do NOT place data with initial values in the above sections.

(Continued on next page)
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No. 24 Resolved

Issue Some sections were not initialized in the flash boot project.
Target RZ/N2L
Category FSP Modules, BSP
Description When selecting a flash boot mode as “Board” in BSP tab of FSP Configuration, variables placed in
the following sections are NOT initialized.
Boards for flash boot mode
e XXXXX (xSPIO x1 boot mode)
e XXXXX (16-bit bus NOR flash boot mode)
c RZN2L Custom User Board (xSPIO x8 boot mode)
. RZN2L Custom User Board (xSPI1 x1 boot mode)
Sections
. .dmac_link mode
. .shared noncache buffer
J .noncache buffer
Workaround | Please initialize the variables placed in the above sections in the user application.
No. 25
Issue DSMIF 0/1 error 1 trigger macros are not defined.
Target RZ/T2L
Category FSP Modules, POEG
Description In “bsp_override.h” of rzt21 device, enum e_poeg_trigger, the definition for DSMIFO0 error 1 and
DSMIF1 error 1 are missing.
When setting as below, build errors will occur.
Property of r_poeg stack
v Module g_poeg0 Port Output Enable for GPT (r_poeg)
v General
v Trigger
GTETRG Pin =
GPT Output Level o
Oscillation Stop o
DSMIFO error o
DSMIF1 error iul
DSMIFO error 1 )
DSMIF1 error 1
Name g.poeg0
Channel 0
Group A
Generated code by configurator
const puegicfgit g:po;;ﬂ;:;g_: i
{ .trigger = (poeg_trigger_t) (POEG_TRIGGER DERR®E_1 | POEG_TRIGGER_DERRIE 1 | POEG_TRIGGER_SOFTWARE), .polarity =
POEG_GTETRG_POLARITY_ACTIVE_HIGH,
Build error log
make -r --output-sync -j8 all
../rzt_gen/hal_data.c:7:36: error: 'POEG_TRIGGER_DERROE_1' undeclared here (not in a function); did you mean 'POEG_TRIGGER_DERRGE'?
Building file: ../rzt_gen/hal data.c
7 POEG_TRIGGER_PIN | POEG_TRIGGER_DERROE_1 | POEG_TRIGGER_DERR1E_1 | POEG_TRIGGER_SOF TWARE),
| mmmmmmmmmmmmmmmmmmmmm
| POEG_TRIGGER_DERRGE
fix-it:"../rzt_gen/hal_data.c":{7:36-7:57}:"POEG_TRIGGER_DERROE"
../rzt_gen/hal_data.c:7:60: error: 'POEG_TRIGGER_DERR1E_1' undeclared here (not in a function); did you mean 'POEG_TRIGGER_DERRIE'?
7| POEG_TRIGGER_PIN | POEG_TRIGGER_DERR@E_1 | POEG_TRIGGER_DERR1E_1 | POEG_TRIGGER_SOFTWARE),
| ol
| POEG_TRIGGER_DERR1E
fix-it:"../rzt_gen/hal_data.c":{7:60-7:81}: "POEG_TRIGGER_DERRIE"
make: *** [rzt_gen/subdir.mk:42: rzt_gen/hal_data.o] Error 1
make: **% N.\laiting for unfinished jobs....
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Workaround

Add definition for DSMIFO error 1 and DSMIF1 error 1 trigger in enum e_poeg_trigger.
Location: rzt/fsp/src/bsp/mcu/rzt21/bsp_override.h, enum e poeg_trigger

Add content:

POEG_TRIGGER_DERROE_1
POEG_TRIGGER_DERR1E_1

1U << 18,
1U << 19,

///< Permit output disabled by DSMIF@ error 1 detection
///< Permit output disabled by DSMIF1l error 1 detection

No. 26

Issue

DSMIF 0/1 error 1 status macros are not defined.

Target

RZ/T2L

Category

FSP Modules, POEG

Description

In “bsp_override.h” of rzt21 device, enum e poeg_state, the definition for DSMIFO error 1 state
and DSMIF1 error 1 state are missing.

When using R POEG_ StatusGet,

If POEG module is in state GPT output disabled due to DSMIFO error 1, the p_status will be
0x100000 instead of POEG_STATE_DSMIF0 1 DISABLE REQUEST.

If POEG module is in state GPT output disabled due to DSMIF1 error 1, the p_status will be
0x200000 instead of POEG_STATE DSMIF1 1 DISABLE REQUEST.

Workaround

When the POEG module is in the 'GPT output disabled' state due to a DSMIFO error 1, assume that
p_status = 0x100000 corresponds to POEG _STATE DSMIF0 1 DISABLE REQUEST.

When the POEG module is in the 'GPT output disabled' state due to a DSMIF1 error 1, assume that
p_status = 0x200000 corresponds to POEG_STATE DSMIF1 1 DISABLE REQUEST.

No. 27

Issue

Missing constraint for DSMIF error trigger in channel 1 and channel 2.

Target

RZ/T2M, RZ/T2ME, RZ/T2L, RZ/T2H, RZ/N2L, RZ/N2H

Category

FSP Modules, POEG

Description

POEG channel 1 and channel 2 do not support DSMIF error trigger in all RZT devices. But
currently there are no constraints to prevent configuring DSMIF error trigger for channel 1 and
channel 2.

g_poeg0 Port Output Enable for GPT (r_poeg)

Settings Property Value

% Module g_poeg0 Port Output Enable for GPT (r_poeg)
APl Info
¥ General
v Trigger

GTETRG Pin
GPT Output Level
Oscillation Stop
DSMIFQ error
DSMIF1 error
DSMIFQ error 1
DSMIF1 error 1

Name

Channel

oeg0

Group
Input
Interrupts
+ Pins

GTETRGA <unavailable>

Workaround

Use the DSMIF error trigger for channel 0 only.

(Continued on next page)
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No. 28
Issue FreeRTOS+FAT format process is not executed correctly.
Target RZ/T2M, RZ/T2ME, RZ/T2L, RZ/T2H, RZ/N2L, RZ/N2H
Category FSP Modules, FreeRTOS+FAT
Description Executing the FF_Format function causes a USB AHB bus error and the FreeRTOS+FAT format
function processing is not executed correctly.
Workaround | Please add g format flag before and after calling the FF_Format function in your application code.
extern uint8_t g_format_flag;
g_format_flag = 1;
err = FF_Format(&disk, @, pdFALSE, pdFALSE)
g_format_flag = 0;
€] basic_example.c
38 #define RM_BLOCK_MEDIA_TEST_BLOCK_SIZE (5120)
39 #define RM_FREERTOS_PLUS_FAT_INFO_GET_PARTITION_SIZE_SECTORS (ex20000)
a0 #define RM_FREERTOS_PLUS_FAT_TEST_FILES_TO_CREATE (10)
a1 #define RM_FREERTOS_PLUS_FAT_TEST_FILENAME_BUF_BYTES (64)
a2 FF_FILE * pxSourceFile[RM_FREERTOS_PLUS_FAT_TEST_FILES_TO_CREATE * 2] USB_BUFFER_PLACE_IN_SECTION; //Add te
43 char filename[RM_FREERTOS_PLUS_FAT_TEST_FILENAME_BUF_BYTES] USB_BUFFER_PLACE_IN_SECTION; Add test
a4 char g_file[] USB_BUFFER_PLACE_IN_SECTION =
45 “Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et
46 rm_freertos_plus_fat_device_t device USB_BUFFER_PLACE_IN_SECTION;
47 FF_PartitionParameters_t partition_params USB_BUFFER_PLACE_IN_SECTION;
48 void rm_block_media_test_remove_media (void);
49 void rm block media test insert_media (void);
|
1 * Partition and format the disk to a known size. *
partition_params.ulSectorCount = device.sector_count /
(RM_BLOCK_MEDIA_TEST_BLOCK_SIZE / device.sector_size_bytes);
partition_params.ulHiddenSectors = 1;
partition_params.ullnterSpace = 9;
memset(partition_params.xSizes, 8, sizeof(partition_params.xSizes));
partition_params.xSizes[@] = (BaseType_t) RM_FREERTOS_PLUS_FAT_INFO_GET_PARTITION_SIZE_SECTORS;
partition_params.xPrimaryCount = 1;
partition_params.eSizeType = eSizeIsSectors;
err = FF_Partition(&disk, &partition_params);
g _format_flag = 1;
err = FF_Format(&disk, @, pdFALSE, pdFALSE);
[e_format_flag = @;
No. 29
Issue Caution when specifying program placement in linker scripts
Target RZ/T2H, RZ/N2H
Category Others, Linker script
Description The reserved area in the device address space cannot be used for a program placement, but no error
occurs when placed there by a linker script.
For example, CAS55 core has reserved areas ATCM and BTCM, however the linker script is ready
to place them there, and no error occurs when the following description exists.
.text TEXT_ADDRESS : AT (TEXT_ADDRESS)
{
...... abbreviation......
} > ATCM
Workaround | Do not specify that any program is to be placed at the reserved area in a linker script.

(Continued on next page)
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No. 30
Issue In the secondary project for multiprocessing, no error occurs when there is a conflict in a
resource used with the preceding project.
Target RZ/T2H, RZ/N2H
Category FSP Configuration, Stacks
Description As noted in 6.2.4 Duplication of Resources, Smart Configurator has the feature to inform about
resource duplication. However, it does not show an error when the secondary project for
multiprocessing uses the same channel/unit of ADC, MTU3, GPT, and TSU_B as preceding
projects.
Workaround | Please don’t use the same channel/unit of ADC, MTU3, GPT, and TSU_B between the preceding
project and the secondary project of RZ/T2H.
No. 31
Issue Errors occur when setting ELC in r_gpt module.
Target RZ/T2H, RZ/N2H
Category FSP Configuration, Stacks
Description When setting ELC event trigger source in the stack of r_gpt module, errors will occur and cannot
generate the value.
Error! Objects cannot be created from editing field codes.
Workaround | To use the ELC trigger source for r_gpt module in code without configuring it in the FSP
Configurator, follow these steps.
1. Addther_elc stack in the Stacks tab of FSP Configuration and include the r_elc header in your
application.
2. Call the following functions to initially set up the r_elc module.
1. R_ELC Open();
ii. R_ELC_Enable();
3. Usethe R_ELC_LinkSet(); function to configure the event triggers.
Example:
R_ELC_Open(&g_gpt_test_elc_ctrl, &g_elc_cfg);
R_ELC_Enable(&g_gpt_test_elc_ctrl);
R_ELC_LinkSet(&g_gpt_test_elc_ctrl, ELC_PERIPHERAL_GPT@®_A, ELC_EVENT_INTCPU®);
No. 32
Issue CRS2 CPU1 of RZ/T2H and RZ/N2H is implemented to run program from System SRAM
instead of CPU1 ATCM.
Target RZ/T2H(CRS52), RZ/N2H(CRS52)
Category Others, Linker script
Description CR52 CPUI of RZ/T2H has CPU1 ATCM and CPU1 BTCM as hardware, and when reset is
released, the program runs from CPU1 ATCM. On the other hand, this FSP is implemented to run
from System SRAM for RZ/T2H CR52 CPUI1 like the program for RZ/T2M, and does not use
CPU1 ATCM or CPU1 BTCM of RZ/T2H as the start of the program.
Workaround | Please consider using this implementation that uses System SRAM.
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No. 33
Issue No Error Occurs when entering out-of-range values for window parameters in r_pcie_ep and
r_pcie_rc module configurations.
Target RZ/T2H, RZ/N2H
Category FSP Configuration, Stacks
Description There is a problem with the r_pcie_ep and r_pcie_rc module configuration screens where entering
unsupported values does not generate an error and the code can be generated with unusable values.
The configuration items for which the validity judgment of input value does not work are as
follows.
Configuration item r_pcie ep I _pcie rc
AXI Window Base v v
AXI Window Mask v v
AXI Window Destination v v
PCle Window Base v v
PCle Window Mask v v
PCle Window Destination v v
MSI Receive Window Address - v
MSI Receive Window Mask - 4
Workaround | Please enter the values so that they meet the input value conditions for each item.

AXI Window Base and PCle Window Base

- “greater than or equal to 0” and address is 4Kbyte aligned”

AXI Window Mask and PCle Window Mask

- “greater than or equal to 07, ‘the lower 12 bits are 1°, and “the 63rd bit is 0”
AXI Window Destination and PCle Window Destination

- “greater than or equal to 0” and address is 4Kbyte aligned”

MSI Receive Window Mask

- “greater than or equal to 0” and "the lower 2 bits are 1”

MSI Receive Window Address

- Align according to “MSI Receive Window Mask”.

(Continued on next page)
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No. 34
Issue DDR and PCIE(0/1 memory cannot be used in secondary (or later) projects with flash boot
mode.
Target RZ/T2H, RZ/N2H
Category Others, Address space
Description If you use DDR or PCIEO/1 memory in a secondary (or later) project with flash boot mode, the
binary file will be huge size. Therefore multicore operation is not possible.
Workaround | Secondary (or later) projects with flash boot mode do not use DDR or PCIE0/1 memory.
No. 35
Issue r_gmac_b module cannot use zero-copy mode.
Target RZ/T2H, RZ/N2H
Category FSP Modules, GMAC
Description r_gmac_b module cannot use zero-copy mode.
The "Zero-copy mode" setting in the r_gmac_b configuration cannot be changed from the default
"Disable."
Workaround | Please use the standard buffers provided by the r_gmac_b module for transmit and receive buffers.
No. 36
Issue r_adc module does not support the calibration function.
Target RZ/T2H, RZ/N2H
Category FSP Modules, ADC
Description The 12-bit A/D converter needs to be calibrated before A/D conversion after reset is released.
However, since the FSP does not support the calibration function, the accuracy shown in the
electrical characteristics chapter of device user’s manual cannot be guaranteed.
Workaround | This will be implemented in the next version of FSP.

As a temporary measure, the calibration process must be implemented in the user application
before the R_ADC_Open function is executed.

The following is an example of implementation. (In the case of ADC Unit2)
#define ADC_ADCALCTL_SET_CAL 1U

/* Release module stop for ADC12 */
R_BSP_RegisterProtectDisable(BSP_REG_PROTECT_LPC_RESET);
R_BSP_MODULE_START(FSP_IP_ADC12, 2);
R_BSP_RegisterProtectEnable(BSP_REG_PROTECT_LPC_RESET);

R_BSP_SoftwareDelay(1, BSP_DELAY_UNITS_MICROSECONDS);
/* Write ADCCALCTL.CAL bit to 1 to start calibration. */
R_ADC122->ADCALCTL_b.CAL = ADC_ADCALCTL_SET_CAL;

/* Poll ADCCALCTL.CAL_RDY bit until it is changed to 1. */
FSP_HARDWARE_REGISTER_WAIT(R_ADC122->ADCALCTL_b.CAL_RDY, 1U);
/* Confirm ADCCALCTL.CAL_ERR bit is 0.*/
FSP_HARDWARE_REGISTER_WAIT(R_ADC122->ADCALCTL_b.CAL_ERR, 0U);
/* Write ADCCALCTL.CAL bit to @ */

R_ADC122->ADCALCTL_b.CAL = @U;

/* Initializing the ADC module */
R_ADC_Open(&g_adcO_ctrl,&g_adco_cfg );
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No. 37

Issue

The USB driver for CASS project does not work.

Target

RZ/T2H(CASS), RZ/N2H(CASS)

Category

FSP Modules, USB

Description

The R_BSP_MmuPatoVA function executed from USB driver (r_usb_hmsc, r usb_hcdc,
r_usb_hhid modules) in a CAS5S5 project fails to perform the expected address translation, resulting
in a USB transfer failure.

Workaround

Please modify \rzt\fsp\src\r_usb_basic\src\driver\r usb_mmu pa_to_va.c as follows.

1. Modify ther usb pa to va function.

uint64_t r_usb_pa_to_va (uint64_t paddr)
{
uinté4_t vaddr = 0;

#if defined(BSP_CFG_CORE_CA55)

/* Converts a physical address to a virtual address. */
if (FSP_SUCCESS != R_BSP_MmuPatoVa(paddr, &vaddr, BSP_MMU_CONVERSION_NON_CACHE))

/* On error, returns the physical address without conversion. */
vaddr = paddr;

#else /* #if defined(BSP_CFG_CORE_CA55) */
vaddr = paddr;
#endif /* #if defined(BSP_CFG_CORE_CA55) */

return vaddr;

} /* End of function r_usb_pa_to_va() */

2. Modify the r_usb_va to pa function.
uint64_t r_usb_va_to_pa (uint64_t vaddr)

uint64_t paddr = 0;
#if defined(BSP_CFG_CORE_CAS55)

/* Converts a virtual address to a physical address. */

if (FSP_SUCCESS != R_BSP_MmuVatoPa(vaddr, &paddr))

{
/* On error, returns the virtual address without conversion. */
paddr = vaddr;

¥

#else /* #if defined(BSP_CFG_CORE_CA55) */
paddr = vaddr;

#endif /* #if defined(BSP_CFG_CORE_CA55) */

return paddr;
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No. 38
Issue No error returns when entering the virtual addresses that cannot be translated to physical
addresses as arguments.
Target RZ/T2H(CAS5S), RZ/N2H(CAS55)
Category FSP Modules, xSPI_OSPI, xSPI_QSPI, DMAC
Description In a CASS project, there is a problem with the "r_xspi_gspi", "r_xspi_ospi", and "r_dmac" modules
that no error returns when entering virtual addresses that cause translation error in MMU as
arguments.
The following functions have the problem.
-R_XSPI QSPI Write()
-R_XSPI OSPI Write()
-R_ DMAC Open()
-R_ DMAC_Reconfigure()
-R_ DMAC Reload()
-R_ DMAC _LinkDescriptorSet()
Workaround | Do not enter the virtual addresses that cannot be translated to physical addresses as arguments.
RO1ANG6434EJ0113 Rev.1.13 Page 110 of 160
Dec.23.24 RENESAS




RZ/T2, RZIN2

Getting Started with Flexible Software Package

No. 39

Issue The CASS project with noncache sections aborts when debugging with flash boot mode on
IAR EWARM

Target RZ/T2H(CAS5S), RZ/N2H(CAS55)

Category FSP Modules, BSP

Description When performing debugging of a flash boot CA55 project with noncache sections on IAR
EWARM, executing the CA55 project will abort. This is due to cache initialization.

Workaround | Follow the steps below

1. Add" set ICTALLU(0);" and" ISB();" to bsp_memory protect setting in
XXX/fsp/src/bsp/cmsis/Device/RENESAS/Source/ca/system_core.c. (XXX= rzt, rzn)

void bsp_memory_protect_setting (void)
{
bsp_mmu_configure();
R_BSP_CacheInvalidateAll();

R_BSP_CacheEnableMemoryProtect();
R_BSP_CacheEnableInst();
R_BSP_CacheEnableData();

__set_ICIALLU(®);
__ISB();

2. Move" set ICIALLU(0);" in R_BSP_CachelnvalidateAll in
XXX/fsp/src/bsp/mcu/all/bsp _cache.c (XXX= rzt, rzn) to just before " asm volatile("ISB
SY");" at the end.

5 uintptr_t ccsidr_associativity value; 5 uintptr_t cosidr_associativity value;
B uintptr_t cosidr_associativity_msh; B uintptr_t cosidr_associativity_msh;
I uintptr_t cesidr_numsets; I uintptr_t cesidr_numsets;
uintptr_t cceidr_numsets_total; uintptr_t ccsidr_numsets_total;
vintptr_t deisws uintptr_t deisw;
_asn volatile ("DSB SY7); _asn volatile ("DSB §Y");
g __set ICIALLU(D);
E; _asm volatile ("DMB SY7); é _asn volatile ("DMB §Y");
/% Reads the maxinum level of cache implemented */ B /% Reads the maximum level of cache implemented %/
clidr = _eet CLIDR(): 7 clidr = __eet CLIDR():
clidr_loc = Telidr >> BSP_PRY_CLIDR_LOG_OFFSET) & BSP_PRY_CLIDR_LOC_HASK: clidr_loc = Telidr >> BSP_PRY_CLIDR_LOG_OFFSET) & BSP_PRY_CLIDR_LOC_HASK:
/% 1f the cache does not exist, do not process */ /% If the cache does not exist, do not process */
B if (0 !=clidr_loc if (0 !=clidr_loc)
5 j H ;
li ] 4 1
7 else g else
! /% Do Nothing %/ 7 /% Do Nothing +/
t t
_asn volatile ("DSB §Y); _asw volatile ("DSB §Y*);
2 __set _ICIALLUCD);
é _asn volatile ("ISB SY7); E _asn volatile ("ISB SY7);
B else 1 else
i 8
8 /% Do Nothing %/ 8 /4 Do Nothing +/
18 il 120
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No. 40
Issue When changing the duty setting in r_gpt module, there is a possibility the duty may
unintentionally become 100%.
Target RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H, RZ/N2L, RZ/N2H
Category FSP Modules, GPT

Description When changing the PWM period with "R_GPT_PeriodSet()" and the duty with
"R_GPT_DutyCycleSet()" while the GPT is running, the duty may unintentionally become 100%
depending on the both setting values. The reason is that when "gpt calculate duty cycle()" in
"R_GPT_DutyCycleSet()" performs a comparison calculation of the duty and period, the old period
value of GTPR register is mistakenly referenced instead of the current period value of GTPBR
(buffer) register.

Workaround | Please correct the reading of the period in the "gpt calculate duty cycle()" to GTPBR instead of
GTPR in XXX/fsp/src/r_gpt/r_gpt.c. (XXX=rzt, rzn)

static void gpt_calculate_duty_cycle (gpt_instance_ctrl_t * const p_instance_ctrl,
uint32_t const duty_cycle_counts,
gpt_prv_duty_registers_t * p_duty_reg)

/* Determine the current period. The actual period is one cycle longer than the register value for
saw waves
* and twice the register value for triangle waves. Reference section 19.2.21 "General PWM Timer
Cycle Setting
* Register (GTPR)". The setting passed to the configuration is expected to be half the desired
duty cycle for
* triangle waves. */
uint32_t current_period = p_instance_ctrl->p_reg->GTPR;
#if GPT_PRV_EXTRA_FEATURES_ENABLED == GPT_CFG_OUTPUT_SUPPORT_ENABLE
if (p_instance_ctrl->p_cfg->mode < TIMER_MODE_TRIANGLE_WAVE_SYMMETRIC_PWM)

#endif
No. 41
Issue CPU registers save and restore process cannot be performed correctly in FIQ_Handler for
CASS projects.
Target RZ/T2H(CASS), RZ/N2H(CASS)
Category FSP Modules, BSP, FreeRTOS
Description Some of CPU registers are not saved and restored in FIQ Handler. Therefore, the value of registers

may be partially corrupted before or after the FIQ interrupt occurs.

Workaround | ° When NOT using FreeRTOS
Please modify XXX/fsp/src/bsp/cmsis/Device/RENESAS/Source/ca/startup_core.c (XXX=
rzt, rzn) as follows.

__WEAK void FIQ_Handler (void)

{
__asm volatile (
"STP x30, XZR, [SP, #-0x10]! \n"
"STP x28, x29, [SP, #-0x10]! \n"
"STP x26, x27, [SP, #-0x10]! \n"
"STP x24, x25, [SP, #-0x10]! \n"
"STP x22, x23, [SP, #-0x10]! \n"
"STP x20, x21, [SP, #-0x10]! \n"
"STP x18, x19, [SP, #-0x10]! \n"
"STP x16, x17, [SP, #-0x10]! \n"
"STP  x14, x15, [SP, #-0x10]! \n"
"STP x12, x13, [SP, #-0x10]! \n"
"STP x10, x11, [SP, #-0x10]! \n"
"STP x8, x9, [SP, #-0x10]! \n"
"STP x6, X7, [SP, #-0x10]! \n"
"STP x4, X5, [SP, #-0x10]! \n"
"STP  x2, x3, [SP, #-0x10]! \n"
"STP x@, x1, [SP, #-0x10]! \n"

#if _ FPU_USED
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"MRS x@, FPCR
"MRS x1, FPSR
"STP x@0, x1,
"STP 30, g31
"STP 28, q29
"STP q26, q27
"STP q24, g25
"STP 22, g23
"STP  g20, q21
"STP ql18, q19
"STP ql6, q17
"STP ql4, qi15
"STP ql12, qgi13
"STP ql10, gl1
"STP g8, q9,
"STP g6, q7,
"STP g4, 95,
"STP g2, g3,
"STP g0, 91,

#endif

#if __ _FPU_USED
"LDP @@, 91,
"LDP g2, g3,
"LDP g4, g5,
"LDP g6, q7,
"LDP g8, q9,
"LDP q1@, qll
"LDP qg12, q13
"LDP ql4, qi15
"LDP ql6, q17
"LDP ql18, q19
"LDP 20, g21
"LDP 22, g23
"LDP q24, q25
"LDP q26, q27
"LDP 28, q29
"LDP 30, g31
"LDP x@, x1,
"MSR FPCR, x©0
"MSR FPSR, x1

#endif

"LDP x@, x1,
"LDP x2, x3,
"LDP x4, x5,
"LDP x6, x7,
"LDP x8, x9,
"LDP x10, x11
"LDP x12, x13
"LDP x14, x15
"LDP x16, x17
"LDP x18, x19
"LDP x20, x21
"LDP x22, x23
"LDP x24, x25
"LDP x26, x27
"LDP x28, x29
"LDP x30, XZR

"ERET
¢ "memory");

[SP, #-0x10]!

, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!
, [SP, #-0x20]!

[SP, #-0x20]!
[SP, #-0x20]!
[SP, #-0x20]!
[SP, #-0x20]!
[SP, #-0x20]!

[sp], #0x20
[sp], #0x20
[sp], #0x20
[sp], #ox20
[sp], #ox2e

, [sp]l, #0x20
, [sp], #0x20
> [sp]l, #06x20
> [spl, #06x20
, [sp], #0x20
, [sp], #0ox2e
, [sp], #0ox2e
, [sp]l, #0x20
, [sp]l, #0x20
> [sp]l, #06x20
, [sp], #0x20

[sp], #ox10

[sp], #ox10
[sp], #ox10
[sp], #ox10
[sp], #ox10
[sp], #oxle

, [sp], #0oxle
, [sp], #0ox1e
, [sp], #ox1e
, [sp], #ox1e
, [sp], #ox1e
, [sp], #0oxle
, [sp], #0ox1e
> [sp]l, #0x1e
> [sp]l, #0x1e
, [sp], #ox1e
, [sp], #ox1e

. When using FreeRTOS
Please modify XXX/fsp/src/rm_freertos_port/ca/port.c (XXX=rzt, rzn) as follows.
BSP_ATTRIBUTE_STACKLESS void FIQ Handler (void)

/* Save volatile registers. */

__asm volatile (
"STP x30, XZR
"STP x28, x29
"STP x26, x27
"STP x24, x25
"STP x22, x23
"STP x20, x21
"STP x18, x19
"STP x16, x17
"STP x14, x15
"STP  x12, x13
"STP x10, x11
"STP x8, x9,

, [SP, #-0x10]!
, [SP, #-0x10]!
, [SP, #-0x10]!
, [SP, #-ox10]!
, [SP, #-0x10]!
, [SP, #-0x10]!
, [SP, #-0x10]!
, [SP, #-0x10]!
, [SP, #-0x10]!
, [SP, #-0x10]!
, [SP, #-ox10]!

[SP, #-0x10]!

\n”
\n"
\n"
\n”
\n"
\n"
\n"
\n"
\n"
\n"
\n”
\n"
\n"
\n"
\n"
\n"
\n”
\n"
\n"

\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n"
\n”
\n”
\n”
\n”
\n”

\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”

\n”

\n”
\n”
\n”
\n”
\n”
\n"
\n”
\n”
\n”
\n”
\n”
\n"
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"STP
"STP
"STP
"STP

#if _ FPU_USED
"MRS
"MRS
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP
"STP

#endif

X6,
X4,
X2,
X0,

X0,
x1,
X0,
q30,
q28,
q26,
q24,
q22,
q20,
q18,
q16,
q14,
q12,
q10,
qs,
q6,
g4,
q2,
qe,

X7,
x5,
X3,
x1,

[sp,
[sp,
[sp,
[sP,

#-0x10]!
#-0x10]!
#-0x10]!
#-0x10]!

\n”
\n"
\n"
\n”

FPCR
FPSR

x1, [SP, #-0x10]!

31,
429,
427,
425,
423,
421,
q19,
q17,
q15,
q13,
q11,

[sP,
[sP,
[sP,
[sp,
[sp,
[sP,
[sP,
[sP,
[sP,
[sP,
[sP,

#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!

\n”
\n”
\n"
\n”
\n”
\n”
\n”
\n”
\n”
\n"
\n”
\n”
\n”
\n”

q9,
q7,
a5,
a3,
q1,

[sp,
[spP,
[SP,
[SP,
[sP,

#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!
#-0x20]!

/* Save the SPSR and ELR. */

"DSB
"ISB

#if _ FPU_USED
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"MSR
"MSR

#endif

"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP

Sy
SY

qe,
q2,
g4,
q6,
g8,
qle,
q12,
ql4,
q1e,
q18,
q2e,
q22,
q24,
q26,
q28,
q3e,
X0,

qi,
a3,
g5,
q7,
a9,

[spl,
[spl,
[spl,
[spl,
[spl,

#0x20
#0x20
#0x20
#0x20
#0x20

ql1,
q13,
q15,
q17,
q19,
q21,
423,
425,
427,
429,
431,

[sp], #6x20

\n”
\n"
\n”
\n”
\n"

\n"
\n”
\n"
\n"
\n”
\n"

\n”
\n”

[spl,
[spl,
[spl,
[spl,
[sp],
[sp],
[spl,
[spl,
[spl,
[spl,

#0x20
#0x20
#0x20
#0x20
#0x20
#0x20
#0x20
#0x20
#0x20
#0x20

x1, [sp], #0x10

FPCR, x@
FPSR, x1

\n"
\n"
\n”
\n"
\n”
\n”
\n"
\n"
\n"
\n"
\n"

X0,
X2,
X4,
X6,
X8,
x10,
x12,
x14,
x16,
x18,
X209,
Xx22,
x24,
X26,
Xx28,
X309,

x1,
X3,
X5,
X7,
X9,

[spl,
[spl,
[sp],
[sp],
[spl,

#0x10
#0x10
#0x10
#0x10
#0x10

\n"
\n"

\n"
\n"
\n”
\n”
\n"

x11,
x13,
x15,
i/
x19,
x21,
x23,
X225
x27,
x29.,
XZR,

: "memory");

/* Save the context

SY

}
BSP_ATTRIBUTE_STACKLESS
{

"DSB

"ISB

#if _ FPU_USED

Sy

[spl,
[spl,
[spl,
[spl,
[sp],
[sp],
[spl,
[spl,
[spl,
[spl,
[spl,

of the current task and select a new task to run.

#ox10
#0x10
#0x10
#0x10
#0x10
#0x10
#ox10
#0x10
#0x10
#0x10
#0x10

\n"
\n"
\n"
\n"
\n”
\n”
\n"
\n"
\n”
\n"
\n"

void Exit_IRQ_No_Context_Switch (void)

"LDP @, ql, [sp], #0x20
"LDP g2, g3, [sp], #0x20

\n”
\n”

\n"
\n"

*/
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#endif

"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"MSR
"MSR

"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"LDP
"ERET

g4, g5, [sp], #6x20
a6, q7, [sp], #6x20
a8, q9, [sp], #6x20
qle, ql1, [sp], #0x20
q12, qi13, [sp], #0x20
ql4, qi15, [sp], #0x20
qlé6, ql17, [sp], #0x2e0
ql8, q19, [sp], #0x2e0
q20, q21, [sp], #0x20
q22, qg23, [sp], #0x20
q24, 925, [sp], #0x20
a26, q27, [sp], #0x20
q28, q29, [sp], #0x2e
q30, q31, [sp], #0x2e
x0, x1, [sp], #0x10
FPCR, X0

FPSR, x1

x0, x1, [sp], #0x1e0
x2, x3, [sp], #ox1e
x4, x5, [sp], #0x10
x6, x7, [sp], #0x10
x8, x9, [sp], #0x10
x10, x11, [sp], #0x10
x12, x13, [sp], #0x10
x14, x15, [sp], #0x1e
x16, x17, [sp], #0x1e
x18, x19, [sp], #0x1e
x20, x21, [sp], #0x10
x22, x23, [sp], #0x10
x24, x25, [sp], #0x10
x26, x27, [sp], #0x1e
x28, x29, [sp], #0ox1le
x30, XZR, [sp], #0x10

:: "memory");

\n”
\n"
\n"
\n”
\n"
\n"
\n"
\n”
\n"
\n”
\n”
\n"
\n"
\n"
\n"
\n"
\n"

\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n”
\n

\n”
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No. 42
Issue MTU3 callback does not occur as expectation.
Target RZ/T2H, RZ/N2H
Category FSP Modules, MTU3
Description Callback does not always occur just like when you specify NULL in the configurator settings of
MTUS3.
i ,gm I ,;i:;;:l:« .‘M:’li:—::e:hn Timer Pulse Unit 3 (r;-neu:) i
T e o e
e e
e
o
Workaround | Please use the Callback Set API from:
R_MTU3_CallbackSet()
For reference on how to use the API, please refer to MTU3 Examples below:
Step1: Define the Callback Function
void mtu3_callback_set_test(timer_callback_args_t * p_args)
{
//Callback function to be implemented by the user
}
Step2: Sequence call the API
/* Open the timer module */
R_MTU3_Open(&g_timere_ctrl, &g_timero_cfg);
/* Use R_MTU3_CallbackSet */
R_MTU3_CallbackSet (timer_ctrl_t * const p_ctrl,
void ( * p_callback)(timer_callback_args_t *),
void const * const p_context,
timer_callback_args_t * const p_callback_memory)
Example:
R_MTU3_CallbackSet (
&g_timere_ctrl, // Timer control instance
mtu3_callback_set_test, // User define Callback function
(void )&mtu3_callback_context // User Defined context
(void )&mtu3_callback_test_args // User define Callback memory
)
/* Start timer */
R_MTU3_Start(&g_timero_ctrl);
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No. 43
Issue An undefined error of r_gpt module occurs when building a project.
Target RZ/T2H, RZ/N2H
Category FSP Modules, GPT
Description Undefined error of "gpt counter underflow_isr" occurs when "Pin Output Support" is set to

anything other than "Enabled with Extra Features" regardless of whether Pin Output is used or not.

Workaround | Please always set the “Pin Output Support” to "Enabled with Extra Features" when configuring
r_gpt module.

Timer, General PWM (r gpt)

Property Value
v Common
Parameter Checking Default (BSP)
Pin Output Support Enabled with Extra Features
Write Protect Enable Disabled
Multiplex Intermupt Disabled
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Appendix. Tool Software Limitations

This section describes the limitations regarding the tool software (e? studio, FSP SC) to create and debug FSP projects.

Table 16 List of Tool Software Limitations

No. | Title Target Device Category
T2M | T2L | T2ME | T2H | N2L | N2H

1 When installing, please install into the default v v v v SC, FSP
installation folder specified by installer. SC

2 Before pressing the reset button on the board, v v v e? studio
disconnect the e? studio connection first.

3 An error has occurred because the program v v ¢’ studio
download to the NOR flash area has failed. The
download is successful on the second connection.

4 The user program cannot be stopped immediately | v v v v v v e? studio
after the device boot process.

5 When using e? studio installer, if checking the v v v e? studio
multiple check boxes such as “View Release
Notes” and so on to show information on
browser, the ONLY head item of checked items
is shown.

6 The Memory Region Usage of ATCM displayed v e* studio
in the Memory Usage window of e? studio is
smaller than the actual size by memory region
usage of DUMMY.

7 When debugging RAM execution without flash v/ v v v v v e* studio
memory project with program written to flash
memory, erase flash memory before debugging.

8 Applying RZ/T2 FSP v.1.2.0 pack to a project v IAR
that is already working with RZ/T2M FSP v.1.1.0 EWARM
causes an error when connecting the debugger.

9 The Device Memory Usage of CPU1 in the v/ v/ v v/ e’ studio
Memory Usage window does not work properly.

10 | When adding the CallbackSet function using the v v v v v v e? studio,
Developer Assistance feature, the second SC
argument needs to be changed.

11 | InTAR EWARM 9.60.1, an error occurs when v v IAR
starting to debug multiprocessing projects of EWARM
RAM execution without flash memory.

12 | Build is failed when executed with different v v v v v v FSP SC
install path.

13 | Unable to debug CAS55 flash boot project with ¢? v v e? studio
studio.

14 | Unable to restart debugging immediately after v v e* studio
debugging ends of CAS5 RAM execution without
flash memory project in €? studio.

15 | Unable to re-download CA5S binary file. v v IAR

EWARM

RO1AN6434EJ0113 Rev.1.13

Dec.23.24

RENESAS

Page 118 of 160




RZ/T2, RZIN2 Getting Started with Flexible Software Package

No. | Title Target Device Category
T2M | T2L | T2ME | T2H | N2L | N2H

16 | Unable to access the upper 32-bit address area in v v e’ studio
memory view.

17 | Unable to create a CMake project using FSP SC. | v v v v v FSP SC

18 | The secondary project aborts when debugging v v v v IAR
multicore with flash boot mode. EWARM

19 | Build errors occur in CASS5 projects when install v v e? studio
e? studio as the Current user.

20 | Wrong core name when create a project CAS5 v FSP SC
with FSP SC.

21 | Build is failed when adding the OpenAMP. v v FSP SC

No. 1 Resolved

Limitation When installing, please install into the default installation folder specified by installer.

Target Device | RZ/T2M, RZ/T2L, RZ/T2ME, RZ/N2L

Category SC, FSP SC

Description When sharing a project between different PCs, build errors will occur if the installation folders are
different.

No.2 Resolved

Limitation Before pressing the reset button on the board, disconnect the e? studio connection first.
Target RZ/T2M, RZ/T2L, RZ/N2L

Category ¢’ studio

Description If the reset button is pressed on the board while connected with e? studio, debugging will not be

able to continue.
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No.3 Resolved

Limitation An error has occurred because the program download to the NOR flash area has failed. The
download is successful on the second connection.

Target RZ/T2M, RZ/N2L

Category ¢? studio

Description If the following error is displayed when connecting the debugger or when downloading the

program, click the [OK] button to close the dialog and try connecting again.

& error O *

'-6.' Exception occurred during launch

Reason:
Error in final launch sequence:

Failed to execute MI command:
load

Error message from debugger back end:
Could not write register "pc”; remote failure reply 'E..FFFFFFFF '

(Continued on next page)
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No. 4

Limitation The user program cannot be stopped immediately after the device boot process.

Target RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H, RZ/N2L, RZ/N2H

Category ¢? studio

Description Immediately after the device boot process (boot code), the program cannot be stopped at the
beginning of the user program (loader program).
When debugging, please follows the guide in
Appendix. How to Debug FSP Project with Flash Boot Mode.

No.5 Invalid

Limitation When using e studio installer, if checking the multiple check boxes such as “View Release
Notes” and so on to show information on browser, the ONLY head item of checked items is
shown.

Target RZ/T2M, RZ/T2L, RZ/N2L

Category ¢? studio

Description For example, if checking “View Release Notes” check box and other check boxes on the following

window, the ONLY “Release Notes” is shown, and the other contents are NOT shown.

A Renesas RZ/T Flexible Software Package (FSP) v1.1.0 with & studio 2022-10 Setup

[} X
R RZ/T Flexible Software Package (FSP) v1.1.0 with e’ studio 2022-10 Setup R
RZ

Welcome Installation of Renesas RZ/T Flexible Software Package (FSP) v1.1.0 with e” studio 2022-10 is
complete.

Extra Features
Please click OK to close.

Customise
Features
[JLaunch e2 studio?
Additional - " Y i
Sofbaare [ View Release Notes? -> “Release Notes” page is shown on browser
View What's New? -> Other pages are NOT shown
Licenses
View Renesas FSP User Manual?
Shortcuts
Summary
Installing... Useful Links:
Renesas FSP: C:\Renesas\rzt\e2studio v2022-10 fsp v1.1.0
@ Results Renesas FSP User Manual: C:\Renesas\rzt\e2studio -10 fsp v1.1.0
GCC ARM Embedded: C:\Renesas\rzt\e2studio v2022-10 fsp v1.1.0\toolchains\gcc arm)
9 2019q4

GCC ARM Embedded: C:\Renesas\rzt\e2studio v2022-10 fsp v1.1.0\toolchains\gcc arm)

0 NN~

User: All Users < Back Next > @ Cance

(Continued on next page)
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No.6 Resolved

Limitation The Memory Region Usage of ATCM displayed in the Memory Usage window of e? studio is
smaller than the actual size by Memory Region Usage of DUMMY.

Target RZ/N2L

Category ¢? studio

Description The Memory Region Usage of DUMMY shown in the Memory Usage window is the region used
by the system. The DUMMY is placed in ATCM, however Memory Region Usage of ATCM does
NOT include its size.

Therefore, please note that the Memory Region Usage of ATCM displayed is smaller than the
actual size by the Memory Region Usage of DUMMY.

Virtual Console | 4 Search | [ Memory Usage X =] 5] |‘ i o=l S g

Memory Region Usage | Device Memory Usage

Memory Region Usage:

ATCM 6% 512KB
33KB used
BTCM 44 % 64KB
28KB used
8B used
SYSTEM_RAM 0% 2048KB
0B used
< >
No. 7
Limitation When debugging RAM execution without flash memory project with program written to
flash memory, erase flash memory before debugging.
Target RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H, RZ/N2L, RZ/N2H
Category e’ studio
Description If you run an RAM execution without flash memory project with a program written in flash

memory, it may be impossible to debug the project.
When erasing flash memory, please follow the guide in

Appendix. How to Erase Flash Memory

(Continued on next page)

RO1AN6434EJ0113 Rev.1.13 Page 122 of 160
Dec.23.24 RENESAS



RZ/T2, RZIN2

Getting Started with Flexible Software Package

No. 8
Limitation Applying RZ/T2 FSP v.1.2.0 pack to a project that is already working with RZ/T2M FSP
v.1.1.0 causes an error when connecting the debugger.
Target RZ/T2M
Category IAR EWARM
Description An error occurs when connecting to the debugger because the function name of vector table was

changed in RZ/T2 FSP v.1.2.0.

Change the following command in the “command line options (one per line)” to

e  (Before change) —drv_vector_table base=vector_table

e  (After change) —drv_vector_table _base=__Vector

Category:

| Runtime Checking
C/C++ Compiler
Assembler
QOutput Converter
Custom Build
Build Actions
Linker
Debugger
Simulator
CADI
CMSIS DAP
GDB Server
et
JLinkf3-Trace
T1 Stellaris
Nu-Link
PE micro
ST-LINK
Third-Party Driver
TIMSPFET
TIXDS

Options for node "Blinky"

~

Setup Download Images Multlcore Plugins

A Use command line options

Command line options: (one per line)

Factory Settings

--drv_vector_table_base=_ Vector] I

Cancel

(Continued on next page)
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No. 9
Limitation The Device Memory Usage of CPU1 in the Memory Usage window does not work properly.
Target RZ/T2M, RZ/T2ME, RZ/T2H, RZ/N2H
Category ¢? studio

Description The Device Memory Usage in the Memory Usage window, it cannot distinguish between CPUO
and CPU1.

When debugging CPU1, the memory area available for CPU1 should be displayed, but the memory
area available for CPUO is incorrectly displayed.

i

iger Console | Memory Usage X | [ Memory. AR

Memory Region Usage ‘ Device Memory Usage‘

P 0x00000000

IernaIRam

0x0007FFFF 34040/524288 byte(s) (6.49% )

o _
0x000FFFFF

P 0x00100000
0x0010FFFF byte(s) (44.02% )

o _
OxOFFFFFFF o

No. 10
Limitation When adding the CallbackSet function using the Developer Assistance feature, the second
argument needs to be changed.
Target RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H, RZ/N2L, RZ/N2H
Category ¢? studio, SC
Description When adding the R_xxx_CallbackSet() function (xxx means any module name) using the

Developer Assistance feature, the second argument does not have the correct value. Please replace
the second argument with "p_callback".

An example of SCI_SPI module, adding CallbackSet() using the Developer Assistance results in
the following.

status = R_SCI_SPI_CallbackSet(&g spi@_ctrl, spi_callback_args_t, p_context, p_callback_memory);

It needs to replace the second argument with “p_callback”.

status = R_SCI_SPI_CallbackSet(&g_spi@_ctrl, p_callback, p_context, p_callback_memory);

(Continued on next page)
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No. 11 Moved to 5.3.3.2 Build for Multiprocessing No. 2-iii

Limitation In IAR EWARM 9.60.1, an error occurs when starting to debug multiprocessing projects of
RAM execution without flash memory.

Target RZ/T2M, RZ/T2ME

Category IAR EWARM

Description When IAR EWARM 9.60.1 is used, there is no defined value required for debugging CPU1 project,
and an error occurs when debugging begins.

In EWARM 9.60.1, when debugging projects of multiprocessing, it is necessary to add "--
macro_param cpul enable=1" in the “command line options (one per line)” of CPU1 project.

Options for node "Blinky_cpu1_secondary”

X

Celegon: Factory Settings
General Options ~
Static Analysis
Rz::':i i:::‘:? Setup Download Images Multicore Authentication Plugins
;Zs;.nnr:;nverter [ Use command line options
Custom Build Command line options: (one per lin)
Lm.ker --drv_vector table base=_\Vectors
Build Actions - =
Debugger
Simulator
CADI
(CMSIS DAP
E2[E2Lite
GDB Server
GHINK
Tjet
J4ink/)-Trace
T1 stellaris
Nu-Link
PE micro
P AR i
Cancel
No. 12
Limitation Build is failed when executed with different install path
Target RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H, RZ/N2L, RZ/N2H
Category FSP SC
Description If install path of FSP SC is different between creating project and executing project, build of a

project is failed.
Please reselect the execution path by following the steps below.
1. Launch FSP SC.
Close the window to create a new project.
Click on File -> Open and select configuration.xml in your project.
Click "Generate Project Content".
Save the project and close FSP SC.
Open the project with EWARM.

S kv
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No. 13
Limitation Unable to debug CAS5S5 flash boot project with e? studio.
Target Device | RZ/T2H(CASS), RZ/N2H(CASS)
Category ¢? studio
Description When debugging with e? studio, the CA55 Core0 system reset is not performed.
Therefore, the program in the external flash is not copied to the internal RAM, and it cannot be
operated correctly.
Please check the operation with the RAM execution without flash memory project.
No. 14
Limitation Unable to restart debugging immediately after debugging ends of CAS5 RAM execution

without flash memory project in e2 studio.

Target Device

RZ/T2H(CA55), RZ/N2H(CAS55)

Category ¢’ studio
Description When debugging with e? studio, the CA55 Core0 system reset is not performed.
Therefore, after debugging is complete, if you want to run the debug again, press the reset button
(red) on the board.
No. 15
Limitation Unable to re-download CASS binary file.

Target Device

RZ/T2H(CASS), RZ/N2H(CASS)

Category

IAR EWARM

Description

If you download the CA55 binary file, then download it again, the process never finishes.
To avoid this issue, you need to erase the flash from the CR52 flash boot project.

(Continued on next page)
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No. 16

Limitation Unable to access the upper 32-bit address area in memory view.

Target Device | RZ/T2H(CASS), RZ/N2H(CASS)

Category e’ studio

Description In the Memory view of €? studio, data in the upper 32-bit address area cannot be displayed.

When debugging the CAS5 project, please make the following settings when accessing the upper
32-bit address.

1. Open Debug Configurations of CA55 project.
2. Select Renesas GDB Hardware Debugging > [project name] Debug_Flat.

3. Select Startup and specify the command in Run Commands. Referring to the following
command, specify the address area you want to access, and you will be able to access the upper
32-bit address area.

"mem 0x200000000 0x300000000 rw"

8 Debug Configurations o x
Create, manage, and run configurations ﬁ\v
¥ X BT~ MNarme: [Blinky Debug_Flat |

1|/[ 5 Main | %5 Debugger O] Commen | 57 Source

[€] ©/C+~ Application
[€] C/C++ Remote Application
EASE Script
[] GDB Hardware Debt
[€¥) GDB Simulator Debugging (RHi
& Launch Group
% Renesas GDE Hardware Debuge [ Set program counter at (hex):
inky Debug_Flat Set breakpoint at: main

] Renesas Simulator Debugging (
€ Renesas Simulator Debugging Dl

Runtime Options

Run Commands

mem 0x200000000 0x300000000 rw I

< >
Filter matched 11 0f 13 items ievet Apply
Before adding the command
0 Memoy X | o omy oo & -ai ;g| uE g| B3 =0
Monitors & 3 % [0x200000000: 0x200000000 <Hex Integer> X | = New Renderings...
& 0x200000000 Address @-3 4-7 8 -8B €-F Lo
cooecec2eepeeose 22227222 NN nNRY nnIRd

0000000200000010 27222222 22222222
0000R00200000020 23732333 22232232
0000000200000030 22222322 22222222
00EEREE200000040 27722232 22222272
0000000200000050 22222222 22222222
0000000200000060 22222222 22232222
0000000200000070 22222222 22222222
0000000200000080 27222222 22232222

After adding the command

0 Memory X =) ‘ o mg e B .“ &‘ ZE - g =0
Monitors & 3 %% 0x200000000: 0x200000000 <Hex Integer> X | = New Renderings...
& 0x200000000 Address -3 4.7 s -s s .

0000000200000000 FFFFFFFF  FFFFFFFF  FFFFFFFF  FFFFFFFF
0000000200000018 FFFFFFFF  FFFFFEFF  FFFFFFFF  FFFFFFFF
0000000200000020 FFFFFFFF  FFFFFFFF  FFFFFFFF  FFFFFFFF
0000000200000030 FFFFFFFF  FFFFFFFE  FEFFFFFF  FEFFFFFF
0000000200000040 FFFFFFFF  FFFFFFFF  FFFFFFFF  FFFFFFFF
000000020000005@ FFFFFFFF  FFFFFFFF  FFFFFFFF  FFFFFFFF
0000EEE20000GBER  FFFFFFFF  FFFFFFFF  FFFFFFFF  FFFFFFFF
0000000200000070 FFFFFFFF  FFFFFFFF  FFFFFFFF  FFFFFFFF
0000000200000080 FFFFFFFF  FFFFFFFE  FFFFFFFF  FFFFFFFF

(Continued on next page)
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No. 17
Limitation Unable to create a CMake project using FSP SC.
Target Device | RZ/T2M, RZ/T2L, RZ/T2ME, RZ/T2H, RZ/N2L, RZ/N2H
Category FSP SC
Description Even if you specify CMake as IDE Project Type when creating a project, an error message "No
toolchain selected" is displayed, and you cannot proceed to the next screen for project creation.
ré New Renesas RZ/T Project [m} X
New Renesas RZ/T Project
@ No toolchain selected
Device Selection
FSP Version: Board Description
RZT Custom User Board (RAM execution without flash memory)
Board: HRZT Custom User Board (RAM execution v ~
Device: RIA09IGO77MABGBG Device Details
Core: CR52 CPUO ~ TrustZone No e
language: @ C (O C++ ?ns Zzi . -
IDE Project Type
|cMake ~|
Toolchains
< Back Next > Finish Cancel
There is no workaround.
No. 18
Limitation The secondary project aborts when debugging multicore with flash boot mode.

Target Device

RZ/T2M, RZ/T2ME, RZ/T2H, RZ/N2H

Category

IAR EWARM

Description

When performing multicore debugging of a flash boot project on IAR EWARM, after copying an
application program from the primary core memory to the secondary one, executing the secondary
project will abort.

For the multicore debugging with flash boot mode in IAR EWARM, follow the steps below:
1. Run the primary project up to main().
2. Software reset the secondary project.

Click on the downward triangle to the right of the reset icon and select Software.

A -@ _iEman il

Disabled [no reset}

Software '{

Hardware

Custom

3. Run the secondary project..

(Continued on next page)
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No. 19

Limitation

Build errors occur in CASS5 projects when install e? studio as the Current user.

Target Device

RZ/T2H(CASS), RZ/N2H(CASS)

Category ¢? studio
Description If you install e? studio as the Current user, an error will occur when building a CA55 project.
As a workaround, install e? studio as All Users.
No. 20
Limitation Wrong core name when create a project CASS with FSP SC.
Target Device | RZ/N2H(CASS)
Category FSP SC
Description When you create a project CAS5 with FSP SC the device name is shown as "CR52_0" in
buildinfo.ipcf even though you select CAS5 core.
Device Selection "1.0 N ———T 1 yes
rp version: R 1arF .: - e il 1on 1.8" Flex Software
Board | (AN ihout 1 5 o | <name R9A09G08 T4 [EREZ_O] /nam:
- — .ﬁmﬁ:!’fsp_:m_executian.lcf path
No. 21
Limitation Build is failed when adding the OpenAMP.
Target Device | RZ/T2H, RZ/N2H
Category FSP SC
Description When adding OpenAMP in Stacks tab, source browser occurs error and build is failed due to

conflict of same file name.

After clicking the Generate Project Content button in the FSP SC, please move the files listed

below from the "Component" group to another group in [project name]/buildinfo.ipcf.
<path>rzt/linaro/libmetal/lib/device.c</path>

<path>rzt/linaro/libmetal/lib/dma.c</path>

<path>rzt/linaro/libmetal/lib/init.c</path>

<path>rzt/linaro/libmetal/lib/io.c</path>

<path>rzt/linaro/libmetal/lib/log.c</path>

<path>rzt/linaro/libmetal/1lib/shmem.c</path>
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Appendix. How to Debug FSP Project with Flash Boot Mode

When debugging FSP project with flash boot mode (xSPI boot, NOR flash boot), the program cannot be stopped at the
beginning of the user program (loader program).

Please note the following point depending on your IDE (e? studio or IAR EWARM) to debug the user program from its
beginning.

1. (Both e?studio and IAR EWARM) Insert the loop part in startup_core.c.

When debugging is started, the debugger stops the user program (loader program) about 100ms after the device boot
process (boot code). If using €* studio 2022-10 or later, the PC (program counter) is replaced at the entry point (first line
in system_init() function) after the debugger stops, otherwise, the PC points the address of somewhere in the user
program.

When debugging the program immediately after the boot process (boot code), insert the loop part in
o /XXX/fsp/src/bsp/cmsis/Device/RENESAS/Source/Y Y/startup _core.c (XXX =rzt, rzn, YY = cr, ca)
The detailed position, at which the loop part should be inserted, depends on the IDE(Debugger) and Boot mode.

Note for multiprocessing projects:

Only the primary project requires the following step. No modification is required for the secondary or
subsequent projects.

IDE Core Boot Mode Position at which the loop part should be inserted.
¢? studio | CR52 xSPI boot Line after static_constructor_init in mpu_cache_init() function.
2022-04 #if BSP_CFG_C_RUNTIME_INIT
2022-07 /* Initialize static constructors */
__asm volatile (
"static_constructor_init: \n"
1dr re, =bsp_static_constructor_init \n"
blx re \n"
)s
#endif

#if 1 // Software loops are only needed when debugging.
__asm volatile (

mov ro, #o0 \n"
movw rl, #0xfo7f \n"
movt ril, #Ox2fa \n"
"software_loop: \n"
adds ro, #1 \n"
cmp ro, ri \n"
bne  software_loop \n"
: "memory");

#endif

NOR flash boot | First line in system_init() function.

5 A BSP_TARGET_ARM BSP_ATTRIBUTE_STACKLESS void system_init (void)
e’ studio | CR52 xSPI boot

{
2022-10 #if 1 // Software loops are only needed when debugging.
NOR flash boot __asm volatile (
or later " mov  re, #0 \n"
movw rl, #0xfo7f \n"
movt rl, #Ox2fa \n"
TIAR "software_loop: \n"
" adds ro, #1 \n"
EWARM " cmp re, ri \n"
bne  software_loop \n"
t:: "memory");
#endif
__asm volatile (
"set_hactlr: \n"
MOVW r@, %[bsp_hactlr_bit_1] \n" /* Set HACTLR bits(L) */
MOVT ro, #0 \n"
MCR pl5, #4, ro, cl, co, #1 \n" /* Write r@ to HACTLR */

::[bsp_hactlr_bit_1] "i" (BSP_HACTLR_BIT_L) : "memory");
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IDE Core Boot Mode Position at which the loop part should be inserted.
e’ studio | CAS5 | xSPI boot First line in system_init() function.
BSP_ATTRIBUTE_STACKLESS void system_init (void)
IAR #if 1 // Software loops are only needed when debugging.
__asm volatile (
EWARM " mov X0, #0 \n"
movz x1, #oxfo7f \n"
movk x1, #O0x2fa, LSL #16 \n"
"software_loop: \n"
adds x@, x0, #1 \n"
cmp  x0, x1 \n"
b.ne software_loop \n"
111 "memory");
#endif
/* Set Vector Base Address Register (VBAR) to point to initializer routine
*/
__asm volatile (
"LDR x@, =_ Vectors \n"
"MSR VBAR_EL3, x© \n"
"MSR VBAR_EL2, x© \n"
"MSR VBAR_EL1, x© \n"
::: "memory");

Note:

The required waiting time varies in proportion to the size of the executable file of the project using FSP. Therefore,
when the executable file size is large, the number of loop processes added above should be adjusted.

In this process, the loop count is expressed in hexadecimal, and the 32-bit loop count is divided into upper 16-bit
and lower 16-bit and set in a general-purpose register. The following shows the procedure for changing the loop
count of CR52 core from 50000000 to 100000000, which is twice the number of loops.

1. Convert the loop count from decimal to hexadecimal. 100000000d = 0x5f5 eOff
2. Replace the operand of movw* to the lower 16-bit value. movw rl, #0xeOff

3. Replace the operand of movt* to the upper 16-bit value. movt rl, #0x5f5

* In CASS core, opcodes are different.

2. (IAR EWARM) (RZ/N2H Only) Override the board files.

When RZ/N2H in xspi boot mode, it's required to override the .board files for RZ/T2H (FlashRZT2H _EVB_AS55.board,
FlashRZT2H EVB_R52.board) to flash the board.

Please reselect the execution path by following the steps bellow:
i. Click on Project and then click on Option... to open project option window.
ii. Select Debugger category and Download Tab.
ii. Enable “Override default .board file”
iv. Select path to override the .board files for RZ/T2H
e CR52 project: TOOLKIT DIRS$\config\flashloader\Renesas\FlashRZT2H _EVB_R52.board
e CASS project: TOOLKIT DIRS$\config\flashloader\Renesas\FlashRZT2H EVB_AS55.board
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Options for node

Category:
General Options
Static Analysis
Runtime Checking
C/C++ Compiler
Assembler
Output Converter
Custom Build
Linker
Build Actions
Simulator
CADI
CMSIS DAP
E2/E2 Lite
GDB Server
G+LINK
I-jet
J-Link/)-Trace
Tl Stellaris
Nu-Link
PE micro
ST-LINK
Third-Party Driver
TI MSP-FET

v

Factoty Settings

Setup D Images Mult Extra Options  Plugins

Verify download

|| Suppress download

[v] Use flash loader(s)
[Z0vemde defautt board fie ]

[lg\ﬁ.ashloador\Ranesas\FIashRZTZH EVE R52board |

(0] s

Figure 108 : Project Options — Debugger (RZ/N2H Only)
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Appendix. How to Erase Flash Memory
If you run RAM execution without flash memory project with a program written in flash memory, it may be impossible
to debug the project.

Please erase flash memory by following steps depending on your IDE (e? studio or IAR EWARM) before running the
project.

1. ¢&?studio
If you would like to erase the flash memory on the board using J-Link Commander, execute the following steps.

i) Set the switch for boot mode on RSK to correspond to the area to be erased.
ii) Open the J-Link Commander.

B J-Link Commander V7.88d - O X

=| irde | MaEn

» establ ish a 1z

Figure 109 : Launch J-Link Commander
iii) First, type “connect” to establish a target connection and press enter.
Next, specify the connection conditions as follows.

e Device> (Device type name)

Table 17 Device Type Name on Renesas Board

Board Device type name
RSK + RZT2M R9A07G075M24 CPUO
RSK + RZT2L R9A07G074M04
RSK + RZT2ME R9A07G0O75M29 CPUO
RZT2H Evaluation Board R9A09G077M44 R52 0
RSK + RZ/N2L R9A07G084M04
RZN2H Evaluation Board R9A09G087M44 R52 0
e TIF>S

. Speed> (Default: press enter without inputting any data)

(Continued on next page)
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EJ J-Link Commander V7.88d -

27 for help
CPUO

[kHz]. <Default>: 4000 kHz

selected.

Figure 110 : Initial Setup for Connecting to the Device

After that, confirm the message “Cortex-R52 identified.” is displayed.

ﬂ J-Link Commander W7.88d -

Figure 111 : Message of Device Core Identification

iv) Use the commands below to enable flash erase and erase the flash memory.
. J-Link>exec EnableEraseAllFlashBanks
e J-Link>erase (Start address), (Endaddress)

(Continued on next page)
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Table 18 External Address Space to Be Used in Each Boot Mode

Board Boot mode External address Start address End address
space to be used

RSK + RZT2M, xSPI0 x1 xSPI0 CSO 0x60000000 0x63FFFFFF
RSK + RZT2ME 16-bit bus CSO 0x70000000 0x71FFFFFF
RSK + RZT2L xSPI0 x1 xSPI0 CSO 0x60000000 0x63FFFFFF

xSPII x1 xSPI1 CSO 0x68000000 0x68FFFFFF
RZT2H Evaluation xSPI0 x1 xSPI0 CSO 0x40000000 0x47FFFFFF
Board

xSPI1 x1 xSPI1 CSO 0x50000000 0x57FFFFFF
RSK + RZN2L xSPI0 x1 xSPI0 CSO 0x60000000 0x63FFFFFF

16-bit bus CSO 0x70000000 0x71FFFFFF
RZN2H Evaluation | xSPIO x1 xSPI0 CSO 0x40000000 0x47FFFFFF
Board

xSPI1 x1 xSPI1 CSO 0x50000000 0x57FFFFFF

EJ J-Link Commander v7.88d - O >
Figure 112 : Specify Erase Range
After that, confirm the message “Erasing done.” is displayed.
KA J-Link Commander 7.88d - O *
Figure 113: Message of Flash Memory Erase Complete
V) Enter “q” to exit J-Link Commander.
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2. TAREWARM

If you want to erase the flash memory on the board using IAR EWARM, execute the following steps. If the
asymmetric multicore setting is enabled, the erase function cannot be used; it must be disabled.

Disable asymmetric multicore setting:
a. Click Project > Options....
b. Click Debugger > Multicore and select Disable in Asymmetric multicore.

i) Set the switch for boot mode on the board to correspond to the area to be erased.
i) Open the workspace of a project.
XXX.EWW
Blinky.ewd
Blinky.ewp
© Blinky.eww

Figure 114 : Open Workspace for IAR EWARM

iii) Select “Project” -> “Download” -> “Erase memory”.

Q) Blinky - 1AR Embedded Workbench IDE - Am 9.32.2

File Edit View | Project | let Tools Window Help

ih 0 | (8 AddFics. - G e a= L
Workspace | [® Add Group...
Debug 4] import File List...
-F1 1 Add Project Connection... Frosvaens
nes +
- Renesos Electromics
. Edit Configurations... pee-2023]
= @ Blinky - De =
|2 S Flax Sot x| Remove re and documentation are supplis
I I—E B Build h products of Renesas Electronii
| @ o Compt )| create Hew Project... Hucts are sold pursuant to Rene:
1 & Genenl 5 pr ond use of Renesas products «
m— & Add Exsting Project... property right is granted by |
| Los DQ'E pes. Renesos reserves the right
| o BEN & options... AR=FT E AND DOCUMENTATION IS DELIVEREL
|| — D buildinto EST EXTENT PERMISSIBLE UNDER API
| @ o Output Version Control System ¥ BRRANTIES OF MERCHANTABILITY, F.
| DOCUMENTATION. RENESAS SHALL |
| O make F1 M EXTENT PERMITTED BY LAW, IN
B compiie Ciri=F7 PV (OR ANY PERSON OR ENTITY CLA
NITHOUT LIMITATION, ANY DIRECT,
@ Rebuid &1 B, OTHER ECONOMIC DAMAGE, PROPEI
& Cesn OF SUCH LOSS, DAMAGES, CLAIMS {
@ EBaten build_. F8
ata_h”
Clean Browse Information
pStart(bsp_warm_start_svent_t e
C-STAT Static Analysis * - = = =
3 = P _t g bsp leds;
£} Stop Buiid tri- Break
brssasssasasasaassanasRRIns RS
Download and Debug QD Lyy svample applicarion
| * | Debug without Dewnloading
| eds ot o rote of 1 second usim
=} Attach to Running Target :
= X SUSP PP ———————
99
o | (woid)
Download K Download active application 11
k
file...
SFR Setup Dowmnioad file.
Erase memony ]
&y CMSS-Pack Manager B TrECIN T & 2% :
| Open Device Description File vl e
Save List of Registers... }z_t de. bsp_delay_‘units-f 1
a3
a4 * LED type structure *
a5 bso leds t leds = @ bsp leds:

Figure 115 : Select Erase memory Command
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iv) Select erase memory space.
Erase Memory X
Flash loader Range
C:¥Program Files¥IAR Systems¥Embedded Workbench 9,32, 2¥arm/config/flashloader fRenesas /FlashRSK_RZT... 0x60000000 - 0x6 3T
[ c:#¥program Files¥IAR Systems¥Embedded Workbench 9,32, 2¥arm/confia/fashloader Renesas/FlashRSK_RZT... 0x70000000 - 0x 7 LFFFFFF
Erase all Cancel
Figure 116 : Select Erase Memory Space
V) After the following dialog appears, erasing of the flash is complete if no error occurs.
Busy
Starting debugger session: Flashing
[
Frogramming flash memory
Cancel
Figure 117 : Screen During Erasing
Debug Log v x
Log

Wed Sep 06, 2023 09:40:04: Target reset

Wed Sep 06, 2023 09:46:23: Unloaded macro file: CAProgram Files\|AR Systems\Embedded Workbench 8.32.24
arm/config/flashloader/Renesas/FlashRSK_RZT2eM_SerialFlash.mac

‘ed Sep 06, 2023 09:46:23: Flash memory has heen erased.

|__\Wed Sep 06,2023 09.46:23 Flash memory has beeneraged |
Wed Sep 08, 2023 09:46:23: Unloaded macro file: CA\Program Filesy|AR Systems\Embedded Workbench 8,32 2\arm/config/debugger/Renesas/RZT2M.dmac

Wed Sep 06, 2023 09:46:24 IAR Embedded Workbench 9.32.2 (C\Program Files\IAR Systems\Embedded Warkbench 9.32. 2\arm\bin\armPROC dIl)
Wed Sep 08, 2023 09:46:24: Loading the et driver

Build  DebugLlog

Figure 118 : Message of Flash Memory Erase Complete
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Appendix. How to Change Boot Mode of FSP Project

When the boot mode of the project is changed, the Pin Configuration needs to be recreated.
It also needs to rename and save the pin configuration to retain the original one before changing the boot mode.

For example, one of specific cases in which re-configure is necessary is when a RAM execution without flash memory
project is changed to flash boot mode (xSPI0 x1 boot mode and others).

Please change the boot mode by following steps.

Note for FSP version earlier than v1.3.0:

If the FSP version of your project is earlier than FSP v1.3.0, change it to FSP v1.3.0 before doing the following
steps.

1. Rename and save the current Pin Configuration in the Pins tab.

e  How to rename Pin Configuration: Click “Manage Configurations..."

{3 [sample] FSP Configuration X |
Pin figuration
e Generate Project Content
Select Pin Configuration _5." Export to CSV file [5-| Configure Pin Driver Warnings
[Rsk+RzT2M
[ Generate data: g,\';: @
ple Pin Config g
Pin Selection H Modify pin configuration list or import/export external file ~J Cycle Pin Group
[fype fiterten 3
e —— ) +R7 T2\ (Current) Add...
v ¢ Ports ROA07GO75M24GBG.pincfg
v P00 Remove
v PO1
v P02
v po3 -] Configuration Name X
v P04
¢ Pos New name: |RSK+RZT2M_OLD| |
v P06
v PO7 >
v P0OB Y
o
<
[ —
i’ | Ak =
WTHE BTES Export... !
Summary | BSP Clmksﬂ
'

Figure 119: How to Rename Pin Configuration

(Continued on next page)
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2. Change the boot mode in the BSP tab. (The board must be the same as before the change.)

FSP version:
Board:

Device:

—

Core:

RTOS:

Device Selection

1.3.0

RSK+RZT2M (RAM execution without flash memory)

RSK+RZT2L (RAM execution without flash memory)
RSK+RZT2L (xSPI0 x1 boot mode)

RSk Az T A Pl aatmadel
R 6-bit b OR flash boot mode

RSK+RZT2M (RAM execution without flash memory)

RSK+RZT2M (xSPI0 x1 boot mode)

RSK+RZT2M for CPU1 (RAM execution without flash memory)

R T T O P T AN T X e UL IO WX TOUT TS T TIermoTy T
RZT Custom User Board (16-bit bus NOR flash boot mode)

RZT Custom User Board (32-bit bus NOR flash boot mode)

RZT Custom User Board (RAM execution without flash memory)
RZT Custom User Board (xSPI0 x 1 boot mode)

RZT Custom User Board (xSPI0 x8 boot mode)

RZT Custom User Board (xSPI1 x1 boot mode)

bmmary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

g

Figure 120: Change the Boot Mode in the BSP Tab

3. Reselect “FSP Version” from the drop-down list.
(This operation is necessary even if there is only one version in the list.)

Device Selection

FSP version:

Device: RACTGOTSMZ4GEG
Core: CR52_0
RTOS: No RTOS

Figure 121: Reselect “FSP Version” from the Drop-down List

(Continued on next page)
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4. Uncheck “Generate data” in the Pins tab.

5% *[sample] FSP Configuration X

Pin Configuration

Select Pin Configuration

RSK+RZT2M_OLD] v | Manage

[] Generate data: |! g_bsp_pin_cfg

l

Figure 122: Uncheck Generate data in

5. Select the regenerated configuration for the board.

the Pins Tab

‘lé,‘ﬂ *[sample] FSP Configuration X

Pin Configuration

Select Pin Configuration

RSK+RZT2M_OLD v

Manage

RSK+RZT2M_OLD

I— RSK+RZT2M

"

Figure 123: Select the Regenerated Configuration for the Board

6. Check "Generate data" again and enter "g_bsp_pin_cfg" as the name.

i§j "[sample] FSP Configuration X

Pin Configuration

Select Pin Configuration

| RSK+RZT2M

v| Mana

| [ Generate data: Iq_bsp_pin_cfg

Figure 124: Check Generate data

again
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Appendix. How to Create and Debug FSP Projects for Multiprocessing in All Cases
for e? studio

4 Tutorial: Your First RZ/T2, RZ/N2 MPU Project — Blinky describes how to create and debug a project in e* studio for
RAM execution of a single core process using CR52 0 and multiprocessing processes where CR52 0 is the primary
core. This chapter describes project creation and debugging methods in e? studio applicable to other boot modes and
core combinations.

If the procedure is preceded by (XXX)), it is executed only if the condition is met.
(RAM exec): The boot mode used in the project is RAM execution without flash memory.
(Flash boot): The boot mode used in the project is NOR flash boot mode or xSPI flash boot mode.
(CR52): The core used in the project is CR52.
(CA5S5): The core used in the project is CASS.
(Homogeneous system): In multiprocessing, only ONE type of core is used. (e.g., only CR52, only CAS5)
(Heterogeneous system): In multiprocessing, both CR52 and CAS55 cores are used in combination.

1. Create a primary project according to the procedures in 4.3 Create a New Project for Blinky.
. (CAS5) To blink the LED on the T2H CASS Corel, you need to change the pin configuration of the primary
project in the FSP Smart Configurator as follows.

L After creating the primary project in 4.3 Create a New Project for Blinky No. 11, set the pins before
clicking Generate Project Content.

il. In Pins tab of FSP configuration, click Pin Selection -> Peripherals -> Connectivity:SDHI ->
SDHI1

iii. Change the value of SDI_PWEN to None.

iv. In Pins tab of FSP configuration, click Pin Selection -> Ports -> P08 -> P08 _S.

v. Change the value of Symbolic Name to LED3.

vi. Change the value of Mode to Output mode (Low & Not Into Input)
2. (Flash boot) Insert the loop part in startup _core.c of the primary project with reference to Appendix. How to
Debug FSP Project with Flash Boot Mode.
Build the primary project according to the procedures in 4.4.1 Build.
4. Create a secondary project using the bundle file (.sbd) of the primary project according to the procedures in 4.3

Create a New Project for Blinky.

5. (RAM exec) Build the secondary project according to the procedures in 4.4.1 Build.

W

(Continued on next page)
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6. (Flash boot) (Homogeneous system) Build the secondary project according to the procedures in 4.4.2 Build for
Multiprocessing No. 2. The following additional properties must be set.
i In the Properties window, click C/C++ Build > Settings > Build Steps.
ii. Add Command(s) at Post-build steps.
e (CR52)
arm-none-eabi-objcopy -I elf32-littlearm -O binary $ {ProjName}.elf secondary.bin && arm-none-
eabi-objcopy -I binary -O elf32-littlearm -B arm --rename-
section .data=.secondary,alloc,data,readonly,load,contents secondary.bin secondary.o
e (CA55)
aarch64-none-elf-objcopy -1 elf64-littleaarch64 -O binary ${ProjName} elf secondary.bin &&
aarch64-none-elf-objcopy -1 binary -O elf64-littleaarch64 -B aarch64 --rename-
section .data=.secondary,alloc,data,readonly,load,contents secondary.bin secondary.o

{8 Properties for Blinky_cpu1_secondary o X
Settings oS- ~ 8
Resource
Builders
Configuration: | Debug [ Active] | | Manage Configurations...
Build Variables
Environment
Loggin: B Tool Settings | B Toolchain | & Dewce Build Artifact| [ax) Binary Parsers|
Tool Chain Editor Pre-build steps
C/C++ General Command(s):
Project Natures ‘ o
Project References -
Renesas QE DzzipiEs:
Rur/Debug Settings \ -
Task Tags
Validation Post-build steps
Command(s):
| arm --rename-section data=.secondaryalloc data readonly load,contents secondarybin secondary.d |
Description:
\ -
Restore Defaults Apply

Figure 125 ¢? studio Build Setting for the Secondary Project (Flash Boot) (Homogeneous System)

7.  (Flash boot) (Heterogeneous system) Create an object file and set it to the secondary project.
i Build the secondary project according to the procedures in 4.4.2 Build for Multiprocessing No. 2. The
following additional properties must be set.
a. In the Properties window of the secondary project, click C/C++ Build > Settings > Build Steps.
b. Add Command(s) at Post-build steps.
*  (The primary project uses CR52, and the secondary project uses CA55)
aarch64-none-elf-objcopy -I elf64-littleaarch64 -O binary $ {ProjName}.elf secondary.bin
. (The primary project uses CASS5, and the secondary project uses CR52)
arm-none-eabi-objcopy -1 elf32-littlearm -O binary $ {ProjName}.elf secondary.bin
ii. Since secondary.bin is output to the Debug folder of the secondary project, move it to the Debug folder of
the primary project.

(Continued on next page)
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iil. Build the primary project with the following additional properties.
a. In the Properties window of the primary project, click C/C++ Build > Settings > Build Steps.
b. Add Command(s) at Post-build steps.
*  (The primary project uses CR52, and the secondary project uses CA55)
arm-none-eabi-objcopy -1 binary -O elf32-littlearm -B arm --rename-
section .data=.secondary,alloc,data,readonly,load,contents secondary.bin secondary.o
. (The primary project uses CASS5, and the secondary project uses CR52)
aarch64-none-elf-objcopy -I binary -O elf64-littleaarch64 -B aarch64 --rename-
section .data=.secondary,alloc,data,readonly,load,contents secondary.bin secondary.o
iv. Since secondary.o is output to the Debug folder of the primary project, move it to the Debug folder of the
secondary project.
8.  (Flash boot) Set the following additional properties to the primary project.

i In the Properties window of the primary project, click C/C++ Build > Settings > Tool Settings > Cross
ARM C Linker > Miscellaneous.
il. Set a file pass of secondary.o in the secondary project to Other objects.

e.g. ${workspace loc:/Blinky secondary/Debug/secondary.o}

@) properties for Blinky_cpu0_primary [m] X
Settings v oo~ §
Resource
Builders
Configuration: | Debug [ Active] ~ | | Manage Configurations...
Build Variables.
Environment
Logging §3 Toolchain | 83 Device | # Build Steps Build Artifact| ) Binary Parsers | €3 Error Parsers
[Setngs |
Teol Chain Editor (2 Target Processor Linker flags (-Xlinker [option]) L3
€/C++ General (2 Optimization
Project Natures L}‘ Warnings
Project References (22 Debugging
Refactoring History v 1 Cross ARM GNU Assembler
Renesas QF (3 Preprocessor
Run/Debug Settings & Includes
Tack Tags ¢ Wamings
Validation (% Miscellaneous
~ i Cross ARM C Compiler
§ :flpu rocesser Other objects
(2 Optimization
(& Warmings
(2 Miscellaneous
| &5 Cross ARM C Linker |
X General
3 Libraries
2 Other
~ B Cross ARM GNU Create Flash Image
% General Generate map |"${BuildArtifactFileBaseName).map"
~ B Cross ARM GNU Print Size [ Cross reference (-Xlinker —cref)
& General [ Print link map (-Xlinker --print-map)
Use newlib-nano (--specs=nano.specs)
[ Use float with nano printf (-u _printf_float)
[ Use float with nana scanf (-u _scanf_float)
[ Do not use syscalls (--specs=nosys.specs)
[ Verbose (-v)
Use semihosting (--specs=rdimon.specs)
Restore Defaults Apply

Figure 126 ¢* studio Build Setting for the Primary Project (Part 1)

(Continued on next page)
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Add file path X

File:

Isiwmkspac e_loc:/Blinky_cpu1_secondary/Debug/secondary.o} I
oK Cancel File system...

Figure 127 €? studio Build Setting for the Primary Project (Part 2)

9.  Build the primary project.
10. Debug the projects according to the procedures in 4.7 Debug and Run for Multiprocessing.

e (CR52 CPUO) When using the CR52 CPUO core for the secondary or later project, set the additional debug
connection settings:

»  Debugger > Connection Settings > Connection

. Reset at the beginning of connection : No

Debug Configurationi o x
& 0ebug Config

Create, manage, and run eonfigurations

CRCEER AR=
F " |

Name: [Secondary Debug_Flat

) o [N & sire | &

Source| [T] Common
[€] C/C++ Application

[€] C/C++ Remote Application
EASE Script

[€] GD8 Hardware Debugging

[€] GD8 OpenOCD Debugging

€7 GD8 Simulator Debugging (1

9] Java Applet

[T) Java Application

Debug hardware: J-Link ARM v Target Device: ROA0SGOTTMA4_CRS | | ...

(GDB Settings [Connection Setings | Debug Tool Settings
Connection Method
Host Name/IP Address|:part number]
Identifier
Tunnel Server

1§ Launch Group Port Number
. Remote Java Application )
7] Renesas GDB Hardware Deb poRP Ty
[€7) Primary Debug_Flat Tpe SWD oy
7 Secondary Debug_Flat Speed (kHz) 4000 v
7 Renesas Simulator Debuggir ||| JTAG Scan Chain
Multiple Devices No v
IRPre
DRPre
v Connection
g Ne v
[Reset at the beginning of connection No ~]
Reset at the end of connection No v
Reset before download Ne v
[Reset after download No ~]
1D Code (Bytes) FFFFTT -
Hold reset during connect No v
[Set CPSR(sbit) after download Ves |
Prevent Releasing the Reset of the CM3 Core  Yes v
Secure Vector Address
Non-secure Vector Address
Hot Plug Ne
Disconnection Mode Continue v

< >
Reyert Appl
Filter matched 14 of 16 items e PRI

?) Debug

Close

Figure 128 e’ studio Debug Configuration for the Secondary or later Project (CR52 CPU0)

. (Flash boot) The flash boot mode differs from RAM execution without flash memory in two points.

»  Both the primary and secondary project binaries are downloaded to the device when connecting
debugger with the primary project.
»  Change Debug Configuration settings in the No. 3 procedure of 4.5.2 Debug Steps.

*  Debugger > Connection Settings > Connection
. (Primary project) Reset after download: Yes
. (Secondary project) Reset after download: No (default)
. Set CPSR(5bit) after download: No (default)
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11. When changing the project and debugging it again, follow these steps.
I Build the primary project (No. 2).
il. (RAM exec) Build the secondary project (No. 4).
1. (Flash boot) (Homogeneous system) Build the secondary project (No. 5).
iv. (Flash boot) (Heterogeneous system) Create an object file and set it to the secondary project (No. 6).
v. Build the primary project again (No. 8).
vi. Debug the projects (No. 9).
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Appendix. How to Create and Debug FSP Projects for Multiprocessing in All Cases
for IAR EWARM

5.3 Using Smart Configurator with IAR EWARM describes how to create in FSP SC and debug a project in IAR
EWARM for RAM execution of a single core process using CR52 0 and multiprocessing processes where CR52 0 is
the primary core. This chapter describes project creation in FSP SC and debugging methods in IAR EWARM
applicable to other boot modes and core combinations.

If the procedure is preceded by (XXX), it is executed only if the condition is met.
(RAM exec): The boot mode used in the project is RAM execution without flash memory.
(Flash boot): The boot mode used in the project is NOR flash boot mode or xSPI flash boot mode.
(CR52): The core used in the project is CR52.
(CA5S): The core used in the project is CASS.

1. Create projects according to the procedures in 5.3.2 Create a New Project.

. (CAS5S5) To blink the LED on the T2H CAS5 Corel, you need to change the pin configuration of the primary
project in the FSP Smart Configurator as follows.

i In 5.3.2 Create a New Project No. 14, set the pins before clicking Generate Project Content.
il. In Pins tab of FSP configuration, click Pin Selection -> Peripherals -> Connectivity:SDHI ->
SDHI1

1il. Change the value of SD1_PWEN to None.

iv. In Pins tab of FSP configuration, click Pin Selection -> Ports -> P08 -> P08 _5.
V. Change the value of Symbolic Name to LED3.

vi. Change the value of Mode to Output mode (Low & Not Into Input)

2. (Flash boot) Insert the loop part in startup_core.c of the primary project with reference to Appendix. How to
Debug FSP Project with Flash Boot Mode. For RZ/N2H, the board file override is also required.

3. Build the primary project according to the procedures in 5.3.3.2 Build for Multiprocessing No. 1.

4.  Create a secondary project using the bundle file (.sbd) of the primary project according to the procedures in 5.3.2
Create a New Project.

(RAM exec) Build the secondary project according to the procedures in 5.3.3.2 Build for Multiprocessing No. 2.

(Flash boot) Build the secondary project according to the procedures in 5.3.3.2 Build for Multiprocessing No. 2.
The following additional properties must be set.

. Click Project > Options....
il. Click Output Converter > Output and set Raw binary to Output format.
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Options for node "Blinky_nor_cpu1_secondary” X
Category: &
X Factary Settings
General Options ~
Static Analysis
Runtime Checking
C/C++ Compiler
Assembler
] |
Generate additional output
Custom Buid OQutput format:
Links
ooy
Build Actions
Debugger Qutput file
I y
itk [ Override default
CADI
QMSIS DAP Blinky_nor_cpu_se
E2/E2 Lite
GDB Server
GHINK
Ijet
JLink/)-Trace
T1 Stellaris
Nu-ink
PE micro o
Cancel

Figure 129 IAR EWARM project options for the secondary project in flash boot mode

7. (Flash boot) Set the following additional options to the primary project.
L. Click Project > Options....
il. Click Linker > Input and set it as follows:

. Keep symbols: (one per line)
e SECONDARY
Raw binary image

File: the path of binary file in the secondary project.

e.g. $PROJ_DIRS\..\Blinky secondary\Debug\Exe\Blinky secondary.bin
. Symbol: SECONDARY
. Section: SECONDARY
. Align: 8
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Options for node "Primary”

Category:

Factory Settings
General Options ~

Static Analysis
Runtime Chedking - -~ -
C/C++ Compier #define Diagnostics Checksum Encodings Extra Options
Assembler Config Library Optimizations =~ Advanced = Output  List
Output Converter Keep symbols: (cne per line)
Custom Build _
SECONDARY |
Build Actions
Debugger
Simulator
CADI
CMSIS DAP
E2/E2Lite
GDB Server
GHLINK
fet Raw binary image
#:tglja-:;ace Eile: %ymbal: Section: Align:
NuLink l spROJ_Dlex.#Secondary:;DebugaJ |.ONDARY ‘ ‘.ONDARY ‘
PE micro ~ File ymBo:

- Section: Align:

— | =

Cancel

Figure 130 IAR EWARM project options for the primary project in flash boot mode

8. Build the primary project according to the procedures in 5.3.3.2 Build for Multiprocessing No. 3.

(Continued on next page)
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9.  (Flash boot) In the primary project, click Project > Download > Download file... and select out file of the

primary project.

e.g. SPROJ DIRS\..\Blinky primary\Debug\Exe\Blinky primary.out

> Blinky_nor_cpud_primary - Master - IAR Embedded Warkbench IDE - Am 9.50.1

File Edit View [Projed] ljet Tools Window Help
1y A @@ | e AddFies..

Workspace | [& Add Group...
4| import File List...

Debug L imp

Add Project Connection...
Files
E @ Blinky_nor
| ol Flex Softy Add CMakelLists.but to Project

|H@ M Buildd | Force Reconfiguration

|
} l_l_g = gzrnnepr[ Add CMake Connector
\

L@ W Progig » | pemove
L— 3 buildinfo.i

Edit Configurations...

Create New Project...
Add Bxsting Project...

& aC

Version Control System

@ Make

B compile Ctrl~F7
@ Rebuilg Al

& Clean

& Batch build. 8

Clean Browse Information
C-STAT Static Analysis
@ stop Build Ctri=Break

© Download and Debug ctri+D

Options... Alt+FT

h products of Remesas Electronics
Hucts are sold pursuant to Renesa:
bn and use of Renesas products ant
| property right is granted by Ret
fws. Renesas reserves the right t(
E AND DOCUMENTATION IS DELIVERED |
» EST EXTENT PERMISSIBLE UNDER APPLI
ARRANTIES OF MERCHANTABILITY, FITI
DOCUMENTATION. RENESAS SHALL HA\
Jurr EXTENT PERMITTED BY LAW, IN M
DN (OR ANY PERSON OR ENTITY CLAIMI
MITHOUT LIMITATION, ANY DIRECT, Cl
B, OTHER ECONOMIC DAMAGE, PROPERT!
| OF SUCH LOSS, DAMAGES, CLAIMS OR

»

, [systen Includes> , "Project Incl

Bpi.h"

ftions

Enitions
T T T

bbal variables (to be accessed by
Frnsnvnumpnsnsavnnmrnsansnanarene

Debug without

bal variables and functions

*) Attach to Running Target
Make & Restart Debugger CtrieR

Restart Debugger Crl=Shift=R o i e |
| Download ) Download active application ed
ed

SFR Setup Download file...
Erase memory e
STACKLESS void r_bsp_software_del:

Figure 131 IAR EWARM Download File

10. (RAM exec) Debug the projects according to the procedures in 5.3.5 Debug for Multiprocessing.

11. (Flash boot) Enable settings for multicore debugging in 5.3.5 Debug for Multiprocessing No. 2.

(Continued on next page)
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12. (Flash boot) Click Project > Debug without Downloading of the primary project to debug. Debug the projects
according to the procedures in 5.3.5 Debug for Multiprocessing No. 4 and after.

> Blinky_nor_cpu0_primary - Master - IAR Embedded Workbench IDE - Arm 2.50.1
File Edit View | Project | Ijet Tools Window Help

NoR@ [& Add Files... S e
Workspace | L@ Add Group.. —— ]
(Detus [4] import File List..

Add Project Connection... b products of Renesas Elect
Huets are sold pursuant to
bn and use of Renesas produ
L property right is granted
pws. Renesas reserves the r

Edit Configurations...

Add CMakelists.bd to Project

Force Reconfiguration E AND DOCUMENTATION IS DELI
Add CMake Connector + ST EXTENT PERMISSIBLE UNDE
ARRANTIES OF MERCHANTABILIT
M Remove | DOCUMENTATION. RENESAS SH
B buildinfo. MUP1 EXTENT PERMITTED BY LAW
¥ Create New Project... ION (OR ANY PERSON OR ENTITY
WITHOUT LIMITATION, ANY DIR
B B ing B et 5, OTHER ECONOMIC DAMAGE, P
| OF SUCH LOSS, DAMAGES, CLA
£ options. AR+FT pasrrsrrsrrrrrrsssrastesaes
Version Control System I‘-»»qq—qnwnhw’-'ﬂ» .
kSystem Includes> ,
B Make FT Rassssssssssssssrssrrssstss
B compile Ciri=F7 ppi.h"
@ Rebuild Al Brrsrssrsrnrsanrasrararaars
& Clean ftions
PR R AR AR AR IRTRTFATETNS
@ Batch build... F8
basrassassnranreasrassnars
Clean Browse Information ;I‘Hl'f\‘.ﬂ"s
S ——
C-STAT Static Analysis »
BrxrrsrarrarsassararrareTey
Q| stop Build CrisBreak bhal variables (to be acces
PR R R RN RN ERRER Y
© Download and Debug Ctrl=D
[+ cebug without bewnisading Jrrrrrrrrrnrsrres s
= Pal variables and functions
%) Attach to Running Target [olnaithier e dmetion:
Make & Restart Debugger Ctri=R
| PO
Restart Debugger Ctrl+Shift+R

assembly Language routine
Download *r when the loop exits. The
baue/epilogue seauences agen

Figure 132 JAR EWARM Debug without Downloading

13.  When changing the project and debugging it again, follow these steps.
i. (Flash boot) Disable asymmetric multicore setting.
a. Click Project > Options....
b. Click Debugger > Multicore and select Disable in Asymmetric multicore.
il. Build the primary project (No. 2).
iil. (RAM exec) Build the secondary project (No. 5).
v. (Flash boot) Build the secondary project (No. 6).
v. Build the primary project again (No. 8).
vi. (Flash boot) Download the file (No. 9).
vii. (RAM exec) Debug the projects (No. 10).
viil. (Flash boot) Enable asymmetric multicore setting (No. 11).
iX. (Flash boot) Debug the projects (No. 12).
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p.75 Updated “Appendix. Tool Software Limitations” chapter.
e  Added “Smart Configurator” section.
e  Added new limitation of displaying memory region usage
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e  Change the number of items.
e  Removed limitation related to RZ/N2 FSP v1.2.0 and J-ink V7.80b only
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p.27 Updated “4.4 Build the Blinky Project” section.
e  Added description of a multiprocessing.
p.28 Updated “4.5.2 Debug Steps” section.

e  Added description of a multiprocessing.

p.31 Updated “4.6 Run the Blinky Project” section.
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P.105 Added “Appendix. How to Debug FSP multiprocessing projects with Flash
Boot Mode” chapter.

1.10 May.30.24 | All Updated documentation for RZ/N2L FSP v2.0.0.

. Removed contents for RZ/N2L FSP v1.3.0

p-9 Updated “2.3.1 SEGGER J-Link” section.
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p-44-46 Updated “5.3.3.2 Build for Multiprocessing” section.
. Changed the program execution start position setting.
. Corrected reset setting.
Added images for the settings screen.
P.73 Updated “Appendix. Known Issues” chapter.
e Resolved issue No. 12
e Added RZ/N2L as target device from No.13 and No.14
e Added new issues No. 16 and No. 17.
p.84 Updated “Appendix. Tool Software Limitations” chapter.
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p.97 Updated “Appendix. How to Change Boot Mode of FSP Project” chapter.
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p.99 Updated “Appendix. How to Debug FSP multiprocessing projects with Flash
Boot Mode” section.
*  Changed the program execution start position setting.
. Modified explanation of debugging sequence.
1.11 Jun.28.24 | All Updated documentation for RZ/T2 FSP v2.1.0.
. Removed contents for RZ/T2 FSP v2.0.0
All Added the RZ/T2ME device as target device.
p-1 Added video links of FSP Configuration.
p.6 Updated “1.3.2 FSP Documentation” section.
. Added explanation of notes when using FSP software modules.
p.10 Updated “2.4.1.1 Boot Mode” section.
*  Added note for board setting.
p.13 Updated “2.4.2.1 Boot Mode” section.
. Added note for board setting.
p.15 Added “2.4.3 RSK+RZT2ME” section.
p.16 Updated “2.5.1.1 Boot Mode” section.
. Added note for board setting.
p.38 Updated “5.3.2 Create a New Project” section.
*  Added IDE Project Type setting for newer versions of FSP SC.
p.43 Updated “5.3.3.2 Build for Multiprocessing” section.
. Removed Build Actions setting.
. Added Make before debugging setting.
p.54 Updated “6 FSP Configuration Users Guide” section.
e Updated figures with new tool screens.
P.74 Updated “Appendix. Known Issues” chapter.
. Resolved issues No. 16 and No. 17
. Added new issues No. 18 to No. 24.
p.85 Updated “Appendix. Tool Software Limitations” chapter.
e Removed RZ/T2M and RZ/T2L as target device from No. 6.
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p.102 Updated “Appendix. How to Change Boot Mode of FSP Project” section.
*  Added note on FSP version changes
1.12 Nov.26.24 | All Updated documentation for RZ/T2 FSP v2.2.0.
*  Removed contents for RZ/T2 FSP v2.1.0
All Added the RZ/T2H as target device and CAS5 core support.
p.6 Updated “1.3.2 FSP Documentation” section.
*  Removed Note for RZ/N2L about the documentation issue.
p.8 Updated “2 Set up Evaluation Board” chapter.
*  Changed the boards designations.
p.9 Updated “2.3.1 SEGGER J-Link” section.
. Added how to update J-Link firmware.
p.16 Added “2.4.4 RZ/T2H Evaluation Board” section.
p.24 Updated “4.3 Create a New Project for Blinky” section.

*  Modified to a generic description that does not specify which cores are
used in multiprocessing.

. Updated tool screen images.
*  Added tables describing the settings for each project.

p.31 Added “4.4.2 Build for Multiprocessing” section.

p.32 Updated “4.5.2 Debug Steps” section.
*  Added tables describing the settings for each project.
*  Added a note for debugging flash boot project.

p.37 Updated “4.7 Debug and Run for Multiprocessing” section.
*  C(Clarified explanation of step 2.

. Added supplemental information on behavior to step 5.

p.44 Updated “5.3.2 Create a New Project” section.

*  Modified to a generic description that does not specify which cores are
used in multiprocessing.

. Updated tool screen images.

*  Added tables describing the settings for each project.

p.51 Added “5.3.2.1 NOTE: Configure IAR EWARM Project [RZ/T2H]” section.

p.54 Updated “5.3.3 Build the Project” section.

. Swapped the order of ““5.3.3.1 NOTE: Build settings [Only
Multiprocessing]” and “5.3.3.2 Build” chapters.

*  Added how to build for multiprocessing in “5.3.3.1 Build” section.

. Renamed “5.3.3.2 Build for Multiprocessing” section.

p.55 Updated “5.3.3.2 Build for Multiprocessing” section.

*  Added the running setting to step 1.

*  Added the extra options to step 2.

. Removed the running setting and tools options from step 3.

. Moved multicore debugging setting from step 3 to ““5.3.5 Debug for
Multiprocessing” section.
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p.58 Updated “5.3.4 Download & Debug the Project” section.
*  Added a note for debugging flash boot project.

p.62 Updated “5.3.5 Debug for Multiprocessing” section.
*  Added multicore debugging setting as step 2.
. Added supplemental information on behavior to step 5.

*  Added how to debug when changing the project.

p.67 Updated “6.2 Create a Project” section.
. Updated tool screen images and menu names.

p.71 Added “6.2.4 Duplication of Resources” section.

p.82 Updated “Appendix. Known Issues” section.

. Added RZ/T2H as target device of No. 3, No. 14, No. 27 and No. 28.
. Added new issues No. 29 to No. 38.

. Resolved issues No. 4, No. 13, No. 18, No. 19 and No. 20.

p.106 Updated “Appendix. Tool Software Limitations” chapter.

. Added RZ/T2H as target device of No. 4, No. 7, No. 9 and No. 10.
. Added new issues No. 12 to No. 19.

. Resolved issues No. 1 and No. 11.

p-117 Updated “Appendix. How to Debug FSP Project with Flash Boot Mode”
section.

*  Add Note for multiprocessing projects.

. Corrected boot mode name from xSPIO to xSPI.
e  Updated path description.

. Add a column for cores to the table.

- Removed “Appendix. How to Debug FSP multiprocessing projects with Flash
Boot Mode” section.

p.127 Added “Appendix. How to Create and Debug FSP Projects for Multiprocessing
in All Cases for €’ studio” section.

p.132 Added “Appendix. How to Create and Debug FSP Projects for Multiprocessing
in All Cases for IAR EWARM” section.

1.13

Dec.23.24

All Updated documentation for RZ/N2 FSP v2.1.0.
*  Removed contents for RZ/N2 FSP v2.0.0.

All Added the RZ/N2H as target device.

p.22 Added “2.5.2 RZ/N2H Evaluation Board” section.

p.57 Renamed “NOTE: Configure IAR EWARM Project [RZ/T2H and RZ/N2H]”
section.

p.86 Updated “Appendix. Known Issues” section.

. Resolved issues No. 21, No. 22, No. 23, No. 24.

J Added RZ/N2H as target device of No. 3, No. 14, No. 27 to No. 36.
. Added RZ/N2L as target device of No. 27, No. 28.

. Added new issues No. 38 to No. 43.

. Replaced Smart Configuration with SC.
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RZ/T2, RZIN2 Getting Started with Flexible Software Package

Description
Rev. Date Page Summary
p.113 Updated “Appendix. Tool Software Limitations” chapter.
. Added RZ/N2H as target device of No. 4, No. 7, No. 9, No. 10 and No. 12

to No. 19.
. Added new issues No. 20, No. 21.
d Resolved issues No. 6.
. Updated the description of issues No. 12.
. Replaced Smart Configuration with SC.

p.125 Updated “Appendix. How to Debug FSP Project with Flash Boot Mode”
section.

. Moved Note for multiprocessing projects to No. 1 in the same chapter.
. Removed CA55 NOR flash boot from the table in No. 1.

. Added No. 2 for RZ/N2H.

*  Added note for debug FSP project.

p.127 Updated “Appendix. How to Erase Flash Memory”
*  Added Device Type Name for RZ/N2H.
. Added External Address Space for RZ/N2H.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by
this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi. (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

12.

13.
14.

(Note1)

(Note2)

Corporate Headquarters

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property of their

respective owners.

For further information on a product, technology, the most up-to-date version
of'a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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